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PREFACE

Thank you for choosing this JAVAD GNSS product. The materials available in this Software Manual (the
“Manual”) have been prepared by JAVAD GNSS for owners of JAVAD GNSS products. It is designed to
assist owners with the operating of the Justin Software and its use is subject to these terms and conditions
(the “Terms and Conditions™).

Note: Please read these Terms and Conditions carefully.

Terms and Gonditions

COPYRIGHT - All information contained in this Manual is the intellectual property of, and copyrighted
material of JAVAD GNSS. All rights are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any third party access to, any graphics,
content, information or data in this Manual without JAVAD GNSS’ express written consent and may only
use such information for the operation of your software. The information and data in this Manual are a
valuable asset of JAVAD GNSS and are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and arrangement by JAVAD GNSS.

TRADEMARKS - Justin™, JAVAD GNSS® are trademarks or registered trademarks of JAVAD GNSS.
Windows® is a registered trademark of Microsoft Corporation, Bluetooth® word mark is owned by the
Bluetooth SIG, Inc. Product and company names mentioned herein may be trademarks of their respective
OWners.

DISCLAIMER OF WARRANTY - EXCEPT FOR ANY WARRANTIES IN THIS MANUAL OR A
WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND SOFTWARE ARE
PROVIDED “AS-1S.” THERE ARE NO OTHER WARRANTIES. JAVAD GNSS DISCLAIMS ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR
PURPOSE. JAVAD GNSS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL
OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, PERFORMANCE OR
USE OF THIS MATERIAL. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED
TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT'S USE. IN ADDITION, JAVAD GNSS IS NOT
RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH
OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS,
INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, JAVAD GNSS SHALL HAVE NO
LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN
EXCESS OF THE PURCHASE PRICE FOR THE TRACY SOFTWARE.



Preface
Symbols and Typographic Conventions

LICENSE AGREEMENT - Use of any computer programs or software supplied by JAVAD GNSS or
downloaded from a JAVAD GNSS website (the “Software”) in connection with the JAVAD GNSS
receivers constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide
by these Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to
use such Software under the terms stated herein and in any case only with a single computer. You may not
assign or transfer the Software or this license without the express written consent of JAVAD GNSS. This
license is effective until terminated. You may terminate the license at any time by destroying the Software
and Manual. JAVAD GNSS may terminate the license if you fail to comply with any of the Terms or
Conditions. You agree to destroy the Software and manual upon termination of your use of software. All
ownership, copyright and other intellectual property rights in and to the Software belong to JAVAD
GNSS. If these license terms are not acceptable, return any unused software and manual.

CONFIDENTIALITY - This Manual, its contents and the Software (collectively, the “Confidential
Information”) are the confidential and proprietary information of JAVAD GNSS. You agree to treat
JAVAD GNSS' Confidential Information with a degree of care no less stringent that the degree of care you
would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict
you from disclosing Confidential Information to your employees as may be necessary or appropriate to
operate Justin Software. Such employees must also keep the Confidentiality Information confidential. In
the event you become legally compelled to disclose any of the Confidential Information, you shall give
JAVAD GNSS immediate notice so that it may seek a protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS - No statement contained at the JAVAD GNSS website (or any other
website) or in any other advertisements or JAVAD GNSS literature or made by an employee or
independent contractor of JAVAD GNSS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

MISCELLANEOUS - The above Terms and Conditions may be amended, modified, superseded, or
canceled, at any time by JAVAD GNSS. The above Terms and Conditions will be governed by, and
construed in accordance with, the laws of the State of California, without reference to conflict of laws.

Symbols and Typographic Conventions

This Manual uses the following text conventions:

Example Description.
About Titles of dialog windows/boxes, names of menu options.

Screen Captures

This Manual includes sample screen captures. Your actual screen can look slightly different from the
sample screen due to the receiver you have connected, operating system used and settings you have
specified. This is normal and not a cause for concern.



Technical Support

If you have a problem and cannot find the information you need in the product documentation, contact
your local dealer. Alternatively, request technical support using the JAVAD GNSS World Wide Web site
at: www.javad.com.

To contact JAVAD GNSS Customer Support use the QUESTIONS button available on the
www.javad.com.

OEM DEALERS CONTACT LOGIN
RECEIVERS UPDATE OPTIONS NEWS PROFILE
ANTENNAS PRICES WEB CART
SOFTWARE ADVANCED EVENTS ORDERS

ACCESSORIES PUBLICATIONS ARTS&SLIDES JNS QUESTIONS

[l Ask us questions and view our answers from over 20 highly qualified specialists
(including Javad himself). It is much better than e-mails, or phone calls




General Description
Technical Support

GENERAL DESCRIPTION

Justin is an office software for processing the GNSS data. Justin is designed for a wide range of geodetic
and topographic tasks. It combines a variety of post-processing tools, GIS interface, and cartographic
features. The Justin discloses all advantages of the JAVAD technology and has been optimized to deal the
highest precision with the least amount of operator invention.

Main Elements

Various post-processing modes. Precise ephemeris type.

Automatic project update in accordance with the Justin version

Interactive mode of GNSS data post-processing

Post-processing of static vectors up to 1000 km and kinematic data at up to 100 Hz
Post-processing of kinematic data with a mobile base

Post-processing of Stop&Go measurements

Geodetic network adjustment (up to 3000 points) with user defined constraints
Adjustment of the kinematic trajectories

Events coordinates computing

Mission planning

Export/import data in various GIS and CAD file formats

Vector maps, raster backgrounds, layer options (styles, labeling)

Raster georeferencing

Export of a project map to Google Earth, import Google Earth map to a project
Multilingual interface

Real time data processing using Internet connection

Coordinate system editor and coordinate calculator

Localization

System Requirements

Before installing Justin, ensure your computer satisfies the following system requirements:

10

PC with Microsoft Windows 7, 8
RAM 1 GB (minimal, 4 GB optimal).



1. Main window

General Description
Main window

Main window appears after program started. The program window elements are menu items, buttons,

map, project, and status pane:

F Justin - [1]

Project Map View Tools Application

Help

= _!Jl

16.02.2011
-f g Point_1

{ {1 source | g} Process

| Adjustment I & J Map | K Survey

Latitude: N 43°09'32, 541450 Longitude: W 10°02'32,227011"

40 60 a0 100 120

Active layer Al

1.1. Main Menu

Figure 1. Main window

The items of main menu are the following:

Project. Use this item to open and close a project, to import and export files, to edit project properties,
start export of cartographic layers to many popular exchange formats and Google Earth, load precise

ephemeris from Internet.

Project |Map View Tools App

| Mew
# Open

Close
v Properties

{se  Import files
Import folder

Import from project

#1

Import log

Export to... 4
Google Earth

Load 5P3 from net

iy

[ Bt Al X

L] DAGIS\ustin manual\l jpr

Clear history

Figure 2. Project
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General Description
Main window

Map. This item contents tools you need to work within cartographic window: panning, centering,
zooming, measuring distances, adding vector and raster layers, etc.

|Mi| View Tools Application
s Zoomin
1e2 Zoom out
! {m) Move
&' Show entire network
Set map position / size

" Distance
*: Add layer

Default layers style

Figure 3. Map

* Set map position/ size menu item to edit window size, cancels user defined style, zoom, and the center map
coordinates in the specified coordinate system can be set.

r ~
F Set map position / size @
Zoom {window width) 156932.455 meters
Scale lam = 9195.823 meters
Y2 BLH Grid
X.m 2834818, 7546 meters
Y.m 2173688.2671 meters
Zym 5237072.2777 meters
WGES 84
[ CK l | Cancel ]
h

Figure 4. Set map position

* Default layer styles menu item cancels the style entered by the operator, and restores the default style for
all layers except the dynamic and added layers.

12



General Description
Main window

View. This menu item offers to hide or show map and project panes. Many additional panes could be
opened as well. The full description of the functions of menu items see in appropriate sections below.

View |Tools Applicat
Project
| L] Map

Events
Edges
Receiver list
RTK++
Media
Vectors
Solutions
TVS

NMEA

Figure 5. View

Tools item is designed for raster images georeferencing, calculating of global datum, calculating
transformation parameters (localization) of plane coordinate systems, running the measurement
scheduler, time converter, visualization of NMEA data stream coming via TCP / IP protocol, displaying
precise ephemeris time schedule.

Tools | Application  Windows

&= Register raster image
|
3 Datum calculator

Localization
Missicn planning

Time converter
NMEA L4

Precise Ephemeris

Figure 6. Tools

Options. This menu item is designed to setup the various program parameters, manage coordinate
systems and datums with internal coordinate editor, manage program reference points database and
antennas. More detailed description see in “Application” on page 40.

Application | Windows  He

! N Options

Projection |
Datumn
Reference points

Antenna list

Figure 7. Application
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General Description
Main window

Windows. This item is invisible initially. It appears when additional windows involve by operations. To
make these windows visible, select the Windows menu item and point the window you want to see.

Windows | Help

] Localization I

Figure 8. Windows

Help. 1t opens the Justin About window with the software version.

Help [ & About =)

Program: Justin

Version: 2.115.1499.4

J Mail to: support@javad.com

TR

Figure 9. Help

1.2. Toolbar

The toolbar consists of many buttons, thru which the user can access the following program functions:
- Create new project.
- Open a project.
- Open the project properties dialog window.
Eé

*,

- Import files into a project.
- Add layer to cartographic window.

- Open the report dialog.

A

14

- Reference points manager.



General Description
Main window

+

@ - Open internal Coordinate System Manager module.
- Export layers into Google Earth.

_@} - Run external Coordinate System Editor.
E - Select on the map by pointer. Allows selecting an object.

T{% - Select on the map by rectangle. Allows multi-selecting objects in the specified rectangle area.

@ - Cancel selection.

7% | _ Zoom in the map.
#= | . Zoom out in the map.
&

- Show entire network. Display entire project content in the Map pane.

- Changes the cursor shape and allows moving the map views.

—— - Allows changing the cursor to a cross-hair and measuring a distance in a project units. The
distance displays in the Status bar.

+ - Opens Coordinates clipboard window.
= Legend.

— ¢ | - Classifier.

- Multilayer select (all layers became selectable).

15



General Description
Legend

_l Snapping mode.
- Undo. Restores last Map View

- Redo (is active after Undo was clicked).
l*, - project file compression (green means the project size is up to 1GB, yellow up to 1.5 GB, red

means the size is over 1.5 GB). Maximum project size is 2 GB. It could be extended by requirement.

1.3. Tab pane

Tab pane has the following tabs: Data, Map, Survey, Processing, and Adjustment. It displays accordingly
the information for these tabs.

1.4. Cartographic window

See the detailed description in “Map” on page 30.

2. Legend

For convenience work with various types of data many conditional symbol are assigned. To see the

symbol list (legend), click the button .

16



General Description
Legend

Legend \E\

Site -
©. Stand-alone

Plane and height znapped

(<}

Solution znapped

Met node snapped

t anual snapped
Rinex header snapped
Plane snapped

Height znapped

=S ST
L

W Stand-alone
@ Plane and height znapped
@ Solution gnapped
@ Met node gnapped
@ Manual snapped
@ Plane snapped
@ Height snapped
Reference points
.i_ Plane and vertical
O Plane
@ Vertical
Recordsets ;
4 Static
% Kinematic
3 Stop & Go
N Unknown
& Mo position
Pogition by epochs
Adjuztment ;
/ Metiibs
Trajecton
Solution ;
%, Kinematic
X Sratic
Wector
Kinematic
# Static
GMSS Stations
{3 Continuously Operating Fef -

Figure 10. Legend
Below is the description of all items of the Legend window:

» Site (a particular place on the earth’s surface, a point). Sites are defined according with
predetermined tolerance radius (plane coordinates tolerance) in the topocentric coordinate system.
It is necessary to distinguish between Sites and Recordsets. Recordset is a set of records in project
database table. Recordsets are created as a result of import of GNSS data. If standalone position
can be calculated, either the new Site is created or the Recordset is associated with the already
existing Site. Thus, multiple Recordsets (sometimes called occupations) can be associated with
one Site. To split Recordset and Site there is the option Move to a new Site. New Site will be
created.

17



General Description

Legend

18

¥ _ Standalone. The site which coordinates are not entered by the operator and are calculated as

standalone. The coordinates of such point are two opportunities: a) if the flag Compute coordi-
nates is unchecked, the receiver calculated epoch coordinates are averaged, and b) if the flag is
set, the post-processed coordinates are averaged. This operation is reversible, you can return the
Site to the position defined in the data file (point a), this may be important when a receiver was
operated in the RTK mode.

™ — Plane and height snapped. The Site with inherited from 3D reference point position.

™ — Plane snapped. The Site with the link to the plane reference point position. By the adjust-
ment such Site will be used as a reference when plane coordinates are calculating. The Site height
interpretation corresponds to the height of the stand-alone mode.

W _ Height snapped. The Site with the link to the height reference point position. By the adjust-
ment such Site will be used as a reference when heights are calculating. The Site plane coordi-
nates interpretation corresponds to the plane coordinates of the stand-alone mode.

& _ Solution snapped. Coordinates are determined in post-processing. Since for any Site can be
obtained many solution, the results of the latest solution are used.

— Net node snapped. Coordinates of the Site comes from adjustment. The adjusted Site posi-
tion can be only one. Rerun adjustment will update Site coordinates.

¢ _Manual snapped - a point with the manually entered coordinates. Such Sites are considered
as free by adjustment. The manual entry allows to correct the positioning error that depends on
error in standalone solution. The errors can appear by a erroneous files concatenation, due noisy
data, false ephemeris, etc. Error in the Site positioning which exceeds 30 meters, effects on the
post-processing results.

& _ RINEX header snapped - a point with the coordinates taken from the header of RINEX file.
Stop is a location on the earth's surface, point, survey point. It is created when you import GNSS
data based on markers in files, or entered using software tools. Coordinates and properties of
points vary depending on the type of their snapping.

“ _ Standalone. The point coordinates are defined on the basis autonomous processing of the
pseudorange data performed as follows: a) if unchecked Calculate the coordinates (Section Import
tab), then averaged satellite receiver, then averaged satellite receiver epoch position, otherwise
Justin calculated positions.

* — Solution snapped. Solution snapped Stop has post-processed position. Stop & Go is point,
whose position is defined during post-processing. For each point of Stop & Go can be obtained a
variety of solutions, this item has the coordinates of the last solution.

“ — Net node snapped. Adjusted Stop gets coordinates as a result of adjustment of kinematic
post-processed solutions (multiple bases). Stop & Go point, whose position is defined during
adjustment. The adjusted point position can be only one. By repeating the adjustment coordinates
are updated.



General Description
Legend

® _ Manual snapping. Manually entered coordinates of Stop&Go point.

Reference point (a point with the fixed coordinates in defined coordinate system for the purpose
of providing geodetic reference for other coordinates calculation).

4 _ Plane and height. 3D fixed point.
B _ Plane. 2D fixed point.

® _ Vertical. Height fixed point.
Recordsets (sets of raw GNSS data).

%# — Static. Recordset related to “Criterion for static”. Two recordsets with time overlap data gen-
erate “Vectors”.

“¥ _ Kinematic. Kinematic recordset is a not Static one.
% — Stop&Go. Kinematic recordset with event markers.

& — No position. Recordset has no ephemeris data or standalone solution is not accessible.
Solution. (Data post-processed solution for Vector)

¥ —Kinematic. Kinematic data post-processed solution.
Adjustment (Adjustment generated objects).

7 _An edge is an object generated with nodes which are a subject of adjustment.

— Trajectory. It is a result of kinematic data adjustment in multiple base mode.
Vector

—Kinematic. Kinematic trajectory is a track or epoch by epoch positions (Justin calculated or
coming with raw GNSS data).

— Static. Static Vector is an object created for two static recordsets with overlapped time.
GNSS Stations.

Permanent operating stations delivering GNSS data thru Internet.
& _ Continuously Operating Reference Station (CORS).

* _ Scripps Orbit and Permanent Array Center (SOPAC).

— Event or time marker is a point created for non epochs instant time.

19



General Description
Source

3. Source

The Source tab is used to display a list of data imported into the project named Recordset and Recordset
management: picking, thinning, jps and RINEX conversion. After tab activation it becomes accessible
object tree:

F Justin - [1]
Project Map Miew Tools Application
g v || B &R /1\
;:__'_:..._J 1
20.11.2013
Eos 4y New_Cone
13.01.2014
Ayr Base-1_01
-Z 15.01.2014
b @5 Grant

£ 4 Source 4} Process |
I Adjustment | \ ) Map | gy Survey

Figure 11. Source tab and objects tree

[

The general node is the name of the project. Its subnodes are groups that are created according to type of
item sorting. The items may be sorted by days or by receivers.

There are three types of Recordsets:
W _ Static
¥ _ Kinematic

% — Stop&Go
* - others recordsets

Recordsets for which it is impossible to calculate the position are marked &,

20



General Description
Source

By right-clicking on the project name, the following control will be accessible:

Project Map View Tools Application Windows Help

=i

E‘t Close project

|l Properties
=R
C |l Import files

5196 Deleteall

Import SNAP files
Export to SNAP files

= Antennas

Sort By ¥ Day

i Grid view mode T Receiver

w| Report

=5 Merge recordsets

Figure 12. Project properties

* Close the project.

* Open Project properties.

* Import GNSS files into the project.

* Delete all data from the project.

* Import SNAP-files into the project.

» Export to SNAP-files.

 Sort the Recordsets by date or by receiver.

» Show the object tree in a grid mode.

* Create a report.

* Merge recordsets (the same satellite receiver identifier GNSS data can be merged if time gap does
not exceed project limits (Scenario)).

By right-clicking on the name of the next level node, corresponding to the creation date of files, you can
get access to the following:

Project Map View Tools Application  Winc

Delete Del

Common time
Report

-4 Old_C Ephemeris diagram
£ 13.01.201+ T

Figure 13. Date option

* Removing data from the project (all data with the measurements started this day).

21
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General Description
Source

* View common observation time for all Recordsets started this day.

,

m ML

R B S T S e S e

e |-

Base-2

Recordset

Base-1 024 --

Mew_Cone

T T T T T T T T T T T T T
1110 11:200 1130 1140 11:50 1200 1210 1220 1230 1240 1250 1300 1310

T
1320
UTC time

Figure 14. Observation time

* Open Report dialog.

www.javad.com



General Description

Source

* Open ephemeris diagram.

«7 Ephemeris diagram

0:00}°

22:00

20:00

13:00

16:00

14:00

1200

UTC time

4:00 6:00 8:00 10000

2:00

GP5 1

GRS 3

GP5 5

GRS 7

GPS 9

GP5 11

GP5 17

GPS 19

GLOMASS 14§---""-"
GLOMNASS 17

0:00

Figure 15. Ephemeris diagram
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General Description
Source

Recordset node options:

Project  Map View Tools Application Help

) 8 ) || ER B8 A @

(=

Properties

Delete Del

Export to JPS
Export to RINEX

Zoom to..

=

Table view

Show track

- B

Calculate coordinates

=
)
e

Process recordset

Raw Data Chart
%y Sky plot

3D view

#]

Report 4

Load internet data

Figure 16. Recordset options

* Open the Recordset properties window:

'8 b |
7 Recordset properties : Base ﬁ
General Receiver | Antenna |
Coordinates | Cbservation time | Satellites |
File name D:\GISYustin manual\Data_Files for Ju
Alias Base
Site Base
Comment
Observer Unknown-
Agency -Unknown-
(@ Static () Kinematic () Stop & Go
[ OK l ’ Cancel ]
LS

Figure 17. General tab

* The General tab of this window provides an overview of the Recordset properties and allows
changing the type: Statics, Kinematic and Stop&Go. Here one is able to add comment and put
down an alias.

24



General Description
Source

¢ The Receiver tab contains information about the receiver and the minimum number of satellites
per one epoch during the session.

' |
7 PRecordset properties : Base @
General Receiver Antenna
Coordinates | Observation time | Satellites |

Type JAVAD TRILUMPH1
Board TRIUMPH_3

Serial number
jin} SVVZWHOQY SPK3S3VZ2RGTUTALQ!

Firmware version 3.2.5 Jan, 26,2011

Minimum number of satelites 13

Cx ] [ o]

Figure 18. Receiver tah

* The Antenna tab shows information about antenna type, height and offsets. Here you can change
the type of antenna or get additional information about antennas, clicking the button E], which
opens the window with antenna properties:

.- ~,
«F Recordset properties : Base @
General | Receiver | Antenna
Coordinates | Observation time | Satellites |
Serial number “Unknown-
Measured height, m m 0.0000
[vertical (are) -
Measured offsets from marker
Vertical, m 0.0000
North, m 0.0000
East, m 0.0000
Type
v o]
[ OK ] l Cancel ]
h
Figure 19. Antenna tab
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General Description
Source

* The Coordinates tab contains averaged coordinates, calculated for all epochs of the Recordset
(excluding the most unreliable, which are rejected). The coordinates are shown in one of
Coordinate Systems valid for the project: geocentric, ellipsoidal, grid or local. The choice
depends on the available set of coordinate systems (see “Selecting project coordinate system” on
page 117). RMS (root mean square) for kinematic samples could be very big.

r

«F Recordset properties : Base

E55)

General | Receiver |

Antenna

Observation time

Coordinates

Satellites

vz |[e eid |

Latitude
Longitude

Height

N 55°4730.2917227
E 37°31'35.014572°

173.8475

meters

WGS 34

RMS, m

2,183013

Justin, broadcast 100.0% used

o ) [ o ]

Figure 20. Coordinates tab

* The Observation time tab shows the start and final epoch time of the recordset, recording interval
and the number of epochs in the recordset. Use the buttons E], to update the epochs interval
(Interval) and to correct the begin and end time of the Recordset.

r =
7 Recordset properties : Base @
General | Receiver | Antenna |
Coordinates Observation time Satellites
Begin time 15,02,2011 %5 09:13:00 = D
Endtme 16022011 51 10:2405 =[]
Interval 1,000 B sec
Epochs 4266
[ OK ] [ Cancel ‘
h

Figure 21. Observation time tab
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e The Satellites tab contains information about satellites and GNSS data:

r ~
«F Recordset properties : Base @
General | Receiver | Antenna | Coordinates | Observation time | Satellites
Satellites Observations
GPS GPS

1(2@ (45 @E (7 @ Ma FLa DA Fsa
8 @9 012 13t [@P1 @I Dl @51
151617 15@19@2 2 | Fr L @D @sC

@2 n@U B B @B | g g2 @bz @S2
290 ) 20431 @32 )33 ) M35 :
s 05 [JL5 []ps []s5
GLONASS BLIRRES ) -
1@z 345 67 @ HCa ELs FDA [F54
89 igligizeiz 14 EP1 FUL o1 [@st
15 16 i7@ 1@ 19@20 21 @D FL @00 FSD
2023245228 | @er2 Lz @Dp2 [@s2
290 50 3 a2 S

S Mol FU @Dl @St

92020202940 5@%@| 1= s s st
2P0 33 e

34(_)35(_)36(_}37( 138

o J [ e |

Figure 22, Satellites tab

* Delete a Recordset from the project.

* Export a Recordset to the jps file.

* Export a Recordset to the RINEX file, specifying if necessary satellites and observations that
should be excluded (satellites should be mark in red, and for observations should be disabled
corresponding boxes). You can also set the recording interval between epochs and specify the
data. The start and end time for the file can be specified as well.

* Disable occupations - exclude Stop&Go objects export;
* Disable clock offset - exclude the receiver clock offset
» Use CA phase and Doppler - use CA,CP instead of L1, P1.
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Click OK to export.
F |
7 Export to RINEX e B )
Satelites Cbservations Parameters
GPS ~ GPS RINEX version 2.11
1 2 @3 (45 @6 (L7 | (] 01
8 @3 _0@Ni_ 12 N3g1d | Fr o [@L 51 [|pisable free events
15 16 1718190 21 c2 [“]Enable known free events
W2 23 3R 2T P2 L2 D2 52 [ pisable occupations
23 30332 33 34 3B [| Disable dock offset
C5 85 ik} 55
33 [ Add leading zeros to svn
GLOMASS GLONASS []Use CA phase and dopler
1@2 03 O @s s 7 (=] o o
8 (9 10glgi2gia 4l | BIFT ML [#]51
15(_ 16174 18419200121 & cz2 Start time  16.02.20119:13:15
22l _j23l_j2A_J25._i2Bl_ 27 i28 Pz Lz Dz 52 Final tme 16022011 10:24:20
29(_)300_331(_}32 WAS
WBAS Interval 1
[ L1 D1 51
200210 1220 12324 o5 L5 D5 5
27( )28 329 )30(_ 3
34(_)35(_»36( )37 38 =
Path  D:\GIS\Justin manuall IIF|
[ oK l ’ Cancel
b
Figure 23. Export to RINEX

* Zoom in the map with the center relating the coordinates of the Recordset.

* Open an additional pane to display Recordsets as a table and show the epochs coordinates vertical

* Show on the Map (Recordset layer) the points with coordinates calculated for each epoch or
remove points from the map by clicking on the same item after the epochs were shown.

profile.

F Justin - [1]

Project  Map

View Tools

Application

B BE® AdOE

7

16.02,2011
B

Help

Figure 24. Epochs on the map

* Recalculate epoch coordinates.
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* Show the raw data graphs.

“alue (Bound = 100007

T T i T T
10:45:44 11:06:24 11:23:04 11:39:44 11:56:24

UTC time

General Description

@ Raw data
() Interferometry

[71 B i nnacoa
SNR(C1)

SNR{C2)

SNR{P1)

SNR(PZ)

Iono correction

CP : C1lphase
L1:P1phase

L2 : P2 phase

L5: CSEase

C2: code
C5 : code
P1: code

Formula : ¢1

Figure 25. Raw data graphs

* Show the satellites track graph.

www.javad.com

Dh | m g
Begin tme [19.10.2012 [3)[10:08:54 2]
Endtime [10.10.2012 B [1us0:44 ]
e e
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LB L8 T 120 130 14egal

@ 151611741819 204g21

222324 5@ i1
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Figure 26. Satellite tracks graph

Source
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General Description
Map

* Create a report.

* Download to the project the data from the Continuously Operating Reference Stations (CORS) in
arange specified in Project properties ¥ Internet data tab. CORS stations or SOPAC layers should
opened thru Map tab in advance. The data will be uploaded if Internet connection is available.

4. Map

The Map tab has two general nodes. In the Project group there are eleven standard layers as well as
dynamics layers, created by user. The Added layers group includes all involved into the project layers thru
option “Add Layer”.

Project Map View Tools

B

- [W Position
p Site
-] Stop
W Reference
W Recordset
- [w Geoid
W Error ellipse
p Edge
- [w Trajectory
W Solution
p Vector
layer-1
=& § Added Layers
W Reference points
- W GNSS Stations(SOPAC)
W TileSet_2_a

Figure 27. Map
Permanent standard layers are the following (see description of the objects in “Legend ” on page 16):
* Site - point objects which contains Recordset. Several Recordsets can be assigned to one Site
according Tolerance criteria.
* Stop - point objects related to tagged time interval in kinematic data.
* Reference — Reference points.
* Recordset - epoch positions. Use show/remove track option in Recordset properties.
* Geoid - Geoid boundary.
» Error ellipse used to show adjustment error ellipses.
* Edge - line objects to show adjustment result.
* Trajectory - points for adjusted kinematic solution.
* Solution - static (lines) and kinematic (collection of points -tracks) post-processing results.
* Vector - candidate for post-processing: lines for static data and tracks for kinematic data.
* Position - real time positions which comes from receiver or based on Justin real time solutions.
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Dynamic layers are sets of the following objects: points, polylines, polygons, used for data import and
export. Added layers can be either raster (aerial/space images, scanned map copies) or vector maps.

Layers can be made visible or hidden, depending on status of check box next to the layer title. Option can
be activated with double clicking.

Layers, with - icon can be made visible/hidden by clicking on this icon. If the icon is white - -, the layer
is visible. If the icon is gray « :, the layer is hidden.

For the Added layers there is an order of drawing. The bottom layer in the list is drawn first. Next is
second from the bottom and consistently to the first layer in the list. To move a layer in the list up/down,
put the cursor on the layer item, and drag it with the mouse:

fi}"'_' Added Layers =& } Added Layers 24 Added Layers

- 1DDk--p50.-109_110.TAB |7 100k—p50-102_110,TAB =] ..... I
.- GNS'@“O”(SOPAC) - GNSS Stations(SOPAC) kj ¥ 100k—pS0-103_110.TAB
""" g R e - Reference points ... GNSS Stations(SOPAC)
Figure 28. Added layers

Both groups, Project and Added layers have functions for working with layers in the group. To access
these features, should put the cursor on the group name and press the right mouse button (and then, if
necessary, select any item in the dialog box.)

For Project group all layers can be made visible at once; empty and dynamic layers can be deleted
optionally:

«F Justin - [1]

Project Map View Tools Application Help

) || © 8 A et
rroecy .

¥ Po Show All Layers

Sit 3% Delete Empty Layers

II; Re W Delete All Dinamic Layers

Figure 29. Project options for the Map tab
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For Added layers group all layers can be removed, new layers can be added, and the layers with the
following information can be added:

i F Justin - [1]

Project Map View Tools Applic
S | & =
D W BSR

EI---L-_] Project

----- ¥ Position
..... p Site

..... p Stop

----- ¥ Reference
----- ¥ Recordset
----- V¥ Geoid

----- ¥ Error elipse
..... p Edge

----- ¥ Trajectory
----- W Solution
..... p Vector

Remaove all Del

Add layer

¥ .,"

Add Google layer
GMSS3 Stations 4

B30

Reference points

Figure 30. Added layers

1. Add Google layer - Space image of the area, related the size of Map Pane. Every time you are clicking
an item Google Map snapshot according Map Window size and a position appears. After panning or
zooming Map Window force Refresh option to get new image.

If an error occurred while downloading the image, it will not shown on the map. In this case, you need to
re-call function Add Google layer or right-click on the Google map layer name and clicking Refresh.

,

Project Map View Tools Application Windows Help

D BEB|ACH

(= LJ Project
----- ¥ Position
..... |7 Site
..... |7 Stop
----- ¥ Reference
----- ¥ Recordset
----- W Geoid
----- ¥ Error ellipse
..... |7 Edge
----- ¥ Trajectory
----- ¥ Solution
..... |7 Vector
=4 ) Added Layers

" v

. Adjustment L) Map h Survey

{ 1 Source | 45 Process

Latitude: N 40°3344.653116" | Longitude: W 100°01'02.2532117| [wes 84 || Active layer Al

Figure 31. Google Map
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General Description
Map

2. GNSS Stations - & - Continuously Operating Reference Station (CORS), L Scripps Orbit and

Permanent Array Center (SOPAC).

-
F Justin - [1]

Project Map View Tools Application Windows Help

D BERActcB

$ZBTHILL

=[] Project
Position
Site
Stop
Reference
Recordset
Geoid
Error elipse
Edge
Trajectory
Solution
Vector
-4 ) Added Layers
----- ¥ Google map

& pos5a

R R e e A i e e e

$supp b

& SuZliss

[ GNSS Stations(SOPAC P728
[ ons( ) & P28 &1y & WhCE - ‘(: - PIC
& AMCT " o & o & ecigpair
Pk » I_(_E‘!u_‘-_‘l__;fj\\zlll-'()élﬂ kilometer 200 400 E00 200
. Adjustment | ) Map | i Survey ¥ RUB2: it ]
[{sowce | £} Process Latitude: N 40°4246.785512" | Longitude: W 107°33'11.428648" | [ WGs 84 || Active layer Al
 — A

Figure 32. CORS

3. Reference points - all reference points available for using in the program (view of all program reference
points accessible via Reference Points Manager). This option can be used to copy some reference points

from program database to the project by selecting them on the map.

< E Y
Project Map View Tools Application Help
 wjaeR Aol wEau @0 +E iR
‘...].i‘]i]”ﬂr v GBI NN &7 @® Q|| ¥+ w 16
B | Project T e — | 6 | S
----- ¥ Position * e R T >
----- ¥ site : / 5
..... ¥ Stop b \ f J > |
----- ¥ Reference " / / - b
----- ¥ Recordset / W Site(d)
..... ¥ Geoid #| 4% Recordset (6) L4
----- ¥ Error ellipse 53/ Edge (10) »
----- ¥ Edge ]
..... ¥ Traiectory A Solution (11) »
----- [ Solution A Vector (11} >
i ek Reference points ‘y Zoomt
B4 ) Added Layers Q Leter points (3] % ~ Zoom o...-
\..[¥ Reference paints 132 I Add to Project
! . glﬂ,-l:'ll?z'- 0856,
0 kilomneter 2 4 B
. Adjustment ) Map W Survey [ 1
| Source | i Process Latitude: N 56%03'43,264534" | Longitude: E 40°25'53.9358987 | [ WGs 84 || Active layer |f|
=

Figure 33. Reference points

To get access to a list of options assigned to the layer, click it and inspect a list. Layers properties differ
depending on layer type. There three main types of layers in Justin - permanent, dynamic, and added.
Permanent layers are generated automatically for a new project. Dynamic layers are created for survey

www.javad.com
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General Description

Map

objects and vector maps which are imported from field software, TRIUMPH-VS/LS application and from

files.

Below is description of layer properties:

34

Style (available for all layers). Opens the Layer style for vector layers and Raster style window for
images.

Show entire layer (available for all layers except the error ellipses layer) scales and displays all
items within the selected layer of the map.

Hide all layers except... (for all layers) hides all layers except the selected layer.

Blunder style (for layer edge) displays the Layer style window for blunder.

Only fixed (for layer Solution). If selected, only fixed kinematic solutions will be displayed. If not
selected, all the solutions are shown.

Drop layer (for all layers except the permanent) removes the selected layer.
Rename (for dynamic layers). Used to change the layer's name. To call this function, double-click
on the layer name.

Export (for dynamic layers) activates export functions for the selected layer, opens dialog window
with exchange formats.

5@ addediqd & SV
. N Drop layer Del

Show entire layer

Hide all layers except...

Rename

i Export to TVS file

Volume Export to Tracy

Mowve ESRI Shape
Maplnfo TAB
MIF/MID
DXF
Kml
PNEZD
TXT

Figure 34. Export

Volume (for dynamic layers) displays a minimum volume covering all points in a layer (3D
convex) in cubic meters.



General Description
Map

* Move - (for dynamic layers). Opens the Move window, within you can set the offset parameters.

-

o Move @
+ +

Fram

XYZ BLH Grid

Latitude M 55°54'00.978734"

Longitude E 37°23'42.748731"

Height 12,4553 meters
WGS 84 =
Delta
Latitude M 0°00'01.000000"

Longitude E 0°00'00.000000"

Height 0.0000 meters
Length 30,9278 meters
To

b P BLH Grid

Latitude M 55°54'01.978734"

Longitude E 37°23'42.748731"

Height 12,4553 meters

[wess4 -

[ ok || cancel |

Figure 35. Move window

* Georeferencing (for the raster layers). Makes Georeferencing pane active for computing the raster
image position.

* Refresh (for the Google map layer). Refreshes the raster image. The Internet connection is
required.
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4.1. Vector Layer Style Settings

For vector layers, Layer style window view varies. In the Style tab, you can customize the style (font,
color, etc.) of the objects displayed on the map.
[ «F Layer style @1
Labels

Style Values

[¥]Enable labels

Along () None () Parallel @ Multisegment

Position () Top left () Top center @ Top right
~) Center left ~) Center ") Center right
() Bottom left () Bottom center () Bottom right

Offset 5 M=

Font Tahoma + 8 -

Text color -
Background

) None @) Halo () Box

Color

pellickbovntoG inpstotent=lazvoa|

C o J[ = ]

Figure 36. Layer style
Check Enable labels to show text data on the map.
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In Values tab can be defined a set of labels. Select on the left pane the parameter and click arrow button
| - | to move/remove an items. You can order items of the label with up and down arrows.

-
F Layer style

=5c=)

Labels
Style || Values

Available

MName

On map

X
¥
Comment

MName

19

Separator

o ]|

Cancel

)

Figure 37. Layer style

* In the Separator field the separator between shown on the map labels can be specified. Click OK
to accept new label style, or Cancel to return to the previous configuration.

* In the Objects tab color and other parameters of the shown on the map object are specified:

oF Layer style

N .
ﬂ 7 Layer style lﬂ
Chjects Objects
(@ PNG image Line visible
Line width 2]
‘ b ' ‘ ] Oraw arraw
‘ :

Figure 38. Gartographic layer style

The second tab level provides a selection of context object settings - Static, Kinematic, Point, Polyline,
Polygon, etc. If a single object is selected or for all selected objects common parameter should be applied,

use the Common tab.
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For raster layers, the style setting window is called Raster style:

I Raster style L: (= ﬁ
a {Ty
8|2 |O] +
Transparency 0 %

P b

3) Mone
Red
Green

Blue

O ] [ Cancel |

Figure 39. Raster style

In this window the map can be scaled, the image can be moved and the transparency level can be changed
(parameter Transparency, which is shown as a percentage relative to the original).

4.2. Ruler

To measure distances between objects on the map the Distance tool is purposed. To activate it, click on
the ruler icon x_:;f or select the items Map # Distance.

Map |[View Tools Applicatior
s Zoomin
| #= Zoom out
l{m} Mowve
; & Show entire network

Set map position / size

| 37 Distance

1% Addlayer

Default layers style

Figure 40. Distance T
When the cursor is upon the map it will be drawn as a cross-hair and ruler: / .

Using the ruler the length of the straight and broken lines can be measured. The measurement information
is displayed in the status bar.
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In the status bar will shown two distances: cumulate distance (black line) and second one between last
selected point and cursor (dotted line). After the first point was selected it is possible to switch distance
measuring styles by clicking on a coordinates bar:

1. - Horizontal distance in the map coordinate system.
2. - Slope distance in the map coordinate system.

3, - Arc length on the WGS84 ellipsoid.
4. - Slope distance.

Click the button with measuring type till desired type appears. To clear figures click right mouse button
on the map. To quit the distance measuring mode, click | | or click Map » Distance.

To measure the distance move the cursor to the start point and press the left mouse button, then move the
cursor to another point and then press the left mouse button again (if the length of the polyline is
measured, move the cursor to the third point, and so on).

There are two modes for distance measuring:
Free mode — the point is selected on the map without snapping it to the point object (the Snap button is

inactive: . ).

"3

. YelowStone 90 | 173:6168
3
/
/

\_Base | 175.6786,
]

Jitude: E 37°31'34.131549" WGS 84 | | Map horizontal : | 67.2210 meters + 21,

Figure 41. Free mode

39



General Description
Application

2. Snapping — the point can be snapped to the object (the Snap button on Main toolbar is active | ™ .)

iy %3 e =
AR S

__ . Yelow Stone 90 | 173:6168

e
Jei
' R ]
/ Y
%
2.
/ RN
Paink 3| 173.3622 e
N
i
\-.
N
\,, Bse [ 1756786
itude: E 37°31'34.727536" | wiGs 84 [Map horizontal ; | 80.3917 meters + 17,

Figure 42. Mode with snapping

4.3. Direction

Angle measurement tool provides geodetic azimuth information (an angle between North direction and a
direction to a point of interest in topocentric coordinate system). To do it more accurate way activate Snap
button on a main toolbar and click A .

Designate a direction on a map by clicking beginning and end points. Calculated value appears on a status
bar Map horizonksl ;| 136950'13,0177"

Note that the number is simultaneously copied in a clipboard. It is possible to paste it in any editable
document.

5. Application

The main program settings and configuration are enclosed in the file param.jdb, which is stored in Justin
folder. The structure of this file could be modified after running updated software version.
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5.1. Options

To open the options window click Application » Options.

Common

7 Options &Jﬁ

Common Import| Coordinate sysheml Geoid | Units | Report| Anhennas|

Language |English (United States)

[¥] open last project
[¥] Apply last coordinate systems

[T compact project database on exit

["| pecimal degrees in coordinates forms
[¥] show scale bar

Longitude range @ -180/180 ) 0380
[¥] Button panel in object tree
Ellipse scale 1phl =1

[¥] Snap objects range 2002 Pixels

[ oK l | Cancel |

Figure 43. Options

The Common tab allows setting the following:

* Language of program interface (from the list).

General Description
Application

» Automatically open last project. Please note, if the corrupted project will be opened, the program
can hang up every time after running. To avoid such hanging, move suspicious project to another

folder or rename it.

» Compact project database on exit - Maximum size of Justin project is limited, you should
compact project to avoid data lost if your project size is close to 2 GB. To reduce the database size
and project size as well, compact the database at time.

* Decimal degrees in coordinates forms - the degrees in the coordinate forms will be shown in
decimal values, otherwise in degrees, minutes, and seconds.

e Show scale bar - activates/hides scale bar.

* Longitude range - switches longitude format.
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* Panel button in object tree - activates new control for the selected item; this menu duplicates the
right button menu.

o Justin - [1]

Project Map View Tools Application Window

o V|| B8 AefC
=0 -

=R 16.02,2011 | i

L

Properties
: » Delete Del
\ Properties
% Delete Export to JPS
Export to RIMEX
Export to JPS
‘n Zoomto..
Export to RINEX
o Table view
‘v Zoom to...

W  Show track
L% Table view
Calculate coordinates
¥ show track
Process recordset
{;‘2 Calculate coording
Raw Data Chart
Process recordset %,

Sky plot
Raw Data Chart 30 view
. Sky plot 5 Report v
UL Load internet data
& Report

Load internet data

£ 1 source | o Process
| Adjustment I L) Map I s Survey
L
Figure 44. Menu

* Ellipse scale - the scale of the ellipses of error can be set.

* Snap objects range - supplies the function of the point Snap (switches on/off snapping to
point objects). When the mode of object is activated a red line joints cursor and object after
clicking on a map.
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Import

In this tab the parameters of GNSS file import can be specified:

7 Options &Jﬁ
Common || Import  Coordinate sysbem| Geoid | Units | Report| Anhennas|

|¥| Raise error on unknown tag

= Interrupt on error
[¥]Error message logging
[¥] Calculate coordinates

[ trwert dynamic/static

[ OK l | Cancel |

Figure 45. Import

* Raise error on unknown tag - adds warning to ImportLog.txt file.

Interrupt (import) on error - stops import on error.
* Error message logging - creates ImportLog.txt file in a project folder.

Calculate coordinates - recalculates receiver’s epoch coordinates

Invert dynamic/static - fix field operator fault in Stop&Go mode survey, when surveyor starts
Static observation with Dynamic mode marker.

Coordinate system

See detailed description in the “Coordinate systems” on page 116.
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Units

In the Units tab the metric units used in project can be selected. Select the units from the list.

[ 3 Options @1
Common| Import| Coordinate sysheml Geoid | Units Report| Anhennas|

Length meters I :

centimeters
feet
inches

kilometers
meters

miles
millmeters
nautical miles
survey feet
yards

Cx J[ o= |

Figure 46. Units
Report

In the Report tab format and type of report can be specified:

» Format - report format can be selected from the drop-down list box. The format can be standard or
country customized.

* File type (*.txt or * html).
» Separator - the separator is specified in the edit field.

( I Cptions &r

Common| Import| Coordinate sysbem| Geoid | Units | Report Anhennas|

Format Standard -

File Type * bt +  Separator n

Figure 47. Report
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Antennas

In the Antennas tab the type of antenna calibration is specified for post-processing engines. The antenna
data base can be updated from the file *.db3 by clicking on the appropriate button.

| 7 Options &11

Comm0n| Import| Coordinate system| Geoid | Units | Report| Antennas

[¥] Absolute calibration

| Update antenna database |

Figure 48. Antennas

6. Working with a project

The Justin software assumes the creation of the project. The only one project can be opened at one
session. All changes are saved automatically by the project closing or by the opening of another project.

6.1. Project properties

This dialog appears after clicking Project Property or New Project options.

-
J Project properties [ﬁ
General Scenario | Reference points | Coordinate systems | Time |
Satelites | Print | Report | Internet Data |
Name 1
Creator
Agency
Comment
Created 29.04.2014 16:00:24
Full path D:\GISJustin manuall,
| OK ‘ | Cancel ‘
L

Figure 49. Project properties

There are the following tabs in this window:
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The General tab contents the general information about the project.

Name - project name.

Creator and Agency — creator’s/agency name which will be used in reports (can be empty).
Comments — any comment to the project (can be empty).

Created — the date the project was created (filled automatically).

Full path — destination folder where the project is stored. All files created during the operation
with the project will be saved in that folder. To see path click the Browse button | | .

The Scenario tab is used to set the import parameters:

46

Specify the number of epochs in the Min recordset size field.

Specify the maximum number of epochs in the Max epochs gap field. If the max epoch gap
exceeds the set value, a stream of imported data will be splitted by two Recordsets.

Specify the value in the Criterion for static field, to distinguish Static and Kinematic recordsets
by position accuracy (epoch positions differ more than (epoch RMS)*(Criterium for static)) from
Site position.
Specify the cut off mask in the Cut off mask field. It determines the lower limit of the satellite
elevation to be used for navigational solution. By default, it is 12°.
Create auto stop;
Max.speed,m/c — max allowed receivers speed by the Stop object creation.

* Max.epoch — max allowed epochs quantity for the Stop object creation.

Specify the value of Tolerance for static. This criterion is used to set relation between recordsets
and sites. If a distance from navigational solution to an existing site exceeds the criterion*RMS, a
new site will be created. If the new site is nearer as specified to an existing site the new site will
not be created.

O-file tolerance — the same as above but for O-files import (Ashtech solution format data).
RINEX coordinates — use the RINEX header coordinates as Recordset coordinates.
Vectors range set metric limits for Vector creation;

Min — min tolerance for Vector creation;

Max — max tolerance for Vector creation;

Moving Base — create Vector between two kinematic recordsets;

Autostart

Processing — starts processing automatically after import of data;

Adjustment — starts adjustment automatically after processing;

Datum — not used in the standard version;

Scenario — saves settings or allows selecting the saved settings;

Raw data interpolation to integer millisecond number (valuable for old Trimble receiver data);

Merge recordsets — merging import data stream according receiver ID and Maximum epoch gap
number;

By default - restores all changed settings to initial.



General Description
Working with a project

Reference points tab is designed to copy reference points to the project.
Coordinate Systems tab is designed to copy coordinate systems to the project.
Time tab allows selecting time format for the project. The following formats are:

* GPS, Global Positioning System time, is the atomic time scale implemented by the atomic clocks
in the GPS ground control stations and the GPS satellites themselves. GPS time was zero at Oh 6-
Jan-1980 and since it is not perturbed by leap seconds GPS is now ahead of UTC by 15 seconds.
- GPS time in format dd/mm/yyyy hh:mm:ss.sss, e.g: 04/05/2012 11:06:24.567
- GPS time in week’s format www/ssssss.ss (number of the GPS week/seconds from the week
beginning), e.g.: 1686/471984.234
- GPS time in seconds: 1020 164 784.567

¢ UTC, Coordinated Universal Time.

* Local time in the format dd/mm/yyyy hh:mm:ss.ss, e.g.: 04/05/2012 11:06:24.567. The local time zone is
selected from the list. Local time differs from UTC by time zone offset.

.
«F Project properties ﬁ
General | Scenario | Reference paints | Coordinate systems | Time
Satelites | Print | Report | Internet Data |
_ GPS time (date time)
GPS time

| GPS time (sec)

@ UTC time

_ Local time

| oK ‘ | Cancel ‘

Figure 50. Timing settings
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The Satellites tab allows selecting the satellites of various satellite system;

4 B
«F Project properties @
General | Scenario | Reference paints | Coordinate systems | Time |
Print | Report | Internet Data |

O 9995 ete’ @@ @ilgliglzgal
W1 1ig 15 1cee 1710 19ge 20w 21 @ 224 23w 21 Al
WS 2EW 2720 2930 31 @ 32 33 3l 35 36
w7

GLOMASS

O 99995t e’ @@ @ilglliglzgal
W@ 1ig 151t 7@ 10 19@ 20 21 @ 22 23 21 Al
L Jeisl el Benl Rl Rl RNT RN R

COMPASS

U AN EN RN OEN LN N RN RN OEN  ROL ARY  RRlRA]
P19 141@15@1t@17@1t@ 199 20@ 21 @22 22 2Ll
L Qe Rl Benl el Rl K]

o [ o]

Figure 51. Satellites tab

In the Print tab the printer and print settings can be specified.

Report tab is used to specify a set of information that is included to the report generated when automatic

processing (Autostart) is used;

Internet Data tab is used to determine the maximum distance from the selected Site to the permanent
stations that provide access to GNSS data via the Internet, and to determine the epoch of the project (the
date on which the coordinates of the reference points are calculated, if their speeds are known).

6.2. New project

To create new project perform the following:

1. Click | orclick Project » New:

2. Enter the name and specify the full path to the project file. Other entries are not mandatory.

F Justin - [1]

Project | Map View Tools Applicz

[ew |

#| Open

Close

Figure 52. New project

3. To close the project without quitting the program click Project » Close.
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6.3. Import files to the project

To import files:
1. Click i L button or click Project » Import files:

«F Justin - [1]

| MNew

| Open

Close

v Properties

Project | Map View Tools Applic

|
\

|i¢|". Import files

Import folder

General Description
Working with a project

Figure 53. Import
2. In the Import files dialog window select the file type and file(s) from the list. Click Open:
[ F Import files @1
Look in: ) Net-1 - O 5 A
[ MName : Date modified Type
e [ Base.jps 16.02.2011 13:54 JAVAD da
Recent Places S 1 4117 ra L1 !
L Ku.rkmo Type: JAVAD data format for raw satellite navigation system data pD da
= B Point 1] iz 5,00 1B 1D da
ﬁ Point_2| Date modified: 16.02.2011 13:54 A0 da
Desktop & Point_3_jps 16.02.2011 13:51 JAVAD da
w=a
Libraries
Computer
“
L 4 nr 3
Network
File name: Basze jps -
Files of type: [Receiver log files (*jps) v] [ Cancel ]

Figure 54. Select the file
The following file formats can be imported into Justin:
* jps — authorized JAVAD GNSS data
* 770, *. 7N, *.77G — files in RINEX format
* txt, *.csv — text files
*.sp3 — precise orbit files
O*.* — solution files (Ashtech O-file)
* jst — files with the coordinate systems description
*.apr — files with the SOPAC coordinates

* arx — files with the information about satellites antennas
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*.bias — file of delays of satellites between the codes CA and P1
* tvs — files TVS

* kml , *.kmz — Google Earth format

*.dwg, *.dxf — AutoCad format

*.db — TVS card format

* tracyjob — Tracy format.

Import of *.jps files

To import *,jps format files, select from the list this type & (it can be associated with such icon), then
click Open. The window with progress status appears. Authorized .jps files only could be imported into
Justin Lite. To cancel import, click Cancel.

Point_3_

5:29:49 PM: Recordset: Base (Epochs: 4268) -
5:29:49 PM: Import file "Kurkino.jps”

5:29:50 PM: Kurkino: 981888689.00: Bad CRC on tag TC on 1
5:29:55 PM: Kurkino: 981888689.00: Bad CRC on tag TC on 1
5:29:55 PM: Kurkino: Loaded: 5.60 sec

5:29:55 PM: Kurkino: Crcerrors: 2 0,00

5:29:56 PM: Recordset: Kurkino (Epochs: 9218)

5:29:56 PM: Import file "Point_1_.jps"

5:29:57 PM: Point_1_: Loaded: 1.12 sec

5

5

5

o

5

m

129:57 PM: Recordset: Point_1 (Epochs: 2313)

129:57 PM: Import file "Point_2.jps"

:29:58 PM: Point_2: Loaded: 1.22 sec

:129:58 PM: Recordset: Yellow Stone 90 (Epochs: 2515)
129:58 PM: Import file "Point_3_.jps”

4 1 b

Cancel

Figure 55. Import status

The imported files can be seen in the Source tab, as Recordsets and can be sorted by date or by receivers.
Depending on standalone solution and epoch by epoch position tolerance recordsets fall into static and
kinematic. Static Recordsets are linked to Points on the Map pane according default point tolerance
criterion. Kinematic recordsets with special marker inside are treated as Stop&Go.

If recordset has no standalone position (no ephemeris, bad raw data) than it is marked with a red circle.
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W _static, ¥ - kinematic, ¥ Stop and Go, and ¥ - no position.

"

«F Justin - [1]
Project Map View Tools Applicati
B ® s A
!E:...HJl
E-f 16.02.2011

-4 Base

5 Kurkino

-4 Point_1

-4 Point_3

i 20 Yellow Stone 90

=
{1 Source I 0 Process

| Adjustment | & I_Map | M Survey

e

Figure 56. GNSS data import result

Import of *.tvs files

To import *.tvs format files, select from the list this type. It can be associated with [ test. tvs icon, then
click Open. The window with progress status appears. To cancel import, click Cancel.

TVS file format- it is special xml-structured exchange format designed for data transfer between
TRIUMPH-VS/LS application and Justin/Justin Link. It describes objects geometry, attributes, structure
of the coordinate system. After the retyping *.tvs extension as *.kml, it can be viewed with Google Earth.

The imported survey objects can be seen in the Survey tab; on the right will be points, polylines and
parcels on the map displayed.

F Justin - [1]

Project  Map View Tools  Application Windows Help

) || R ERASOB| RIS 2

—JI:I TRIUMPH-VS
[= Map

\GISJustin Link manuall2 Dal

D: L
1 3
* 3 : 2 3
s 5
. 7 . .
.9 15 13
e 11
« 13

...... s 15 5 7

11

] I k

Adjustment | & 4 Map | W Survey
{ 1 Source | i% Process | Latitude: N 55°53'59.020709" Longitude: E

Figure 57. Imported data

Import of *.kml files

To import files in Google Earth (*. kml) format, select the file(s) from the list: this type is displayed like
& testkml then click Open. The window with progress status appears. To cancel import, click Cancel.
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Google Earth format — is *.kml file, which contents information about geometric objects and their
attributes. Files properties can be seen in the Survey tab, in the folder; on the right will be points on the

map displayed:

( oF Justin - [1]

Project Map View Tools Application Windows Help

D W|EREFASOB | RNRB [ ® O ¢ + 2 Z}

=[] wark
-4 Osechenki.kml —=7
E!---"\t} Layer ;
Lo Untitled Path g
R T — . - —)
,/J //

_/.. ™ -

' p

g

i
.//
/.'
y
rd
= Okiometer 1 2 3
Adjustment | & 4 Map | h Survey L I
i | source | i} Process | Latitude: N 55°39'56,926805™ Longitude: E 33°06'29.591158™ WG5S 84 Active layer Al
M
Figure 58. Import of kml files
*.dxf fil
Import of *. iles

To import files in AutoCad format R12 (*.dxf) select the file(s) from the list: this type is displayed like
aetest.dxf , then click Open. The window with progress status appears. To cancel import, click Cancel.

Exchange Format DXF-files (Autodesk company’s format for AutoCad) - a file format with the extension
* dxf, which contents geometry information. Before import the coordinate system should be selected in

the window Select the coordinate system.

If you need to swap the axes (YX to XY), activate Import XY (lower left corner of the window). If you
need to invert the coordinates system (i.e., X axe goes to the South, Y axes goes to the West), activate

checkbox Inverse, then click OK.
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«F Select a coordinate system [ =R é]
XYZ BLH Grid
WG5S 84
mlmport XY Inverse [ QK l ’ Cancel ]

Figure 59. Coordinate system selecting
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The imported files can be seen in the Map tab; on the right will be points on the map displayed:

-
«F Justin - [1]

)

Project  Map View Tools  Application Windows Help

7

BRIt
Position
Site

Stop
Reference
Recordset
Geoid

Error ellipse
Edge
Trajectory
Solution

S
L] v

¥ vector

X
 NEEVIDOVENO
Added Layers

—

Y

T,

2000

3000

Adjustment | ) Map | i Survey

i ] Source I {;} Process

Latitude: N 6°31'07.609683" Longitude: W 48°39'10.824178" | | WGS 84

| Active layer Al

Figure 60. dxf layers

Import of *.db files

To import NS3-files (TRIUMPH-VS/LS application database) select the file(s) from the list: this type is
displayed like |%ldata.db ), then click Open. The window with progress status appears. To cancel import,

click Cancel.

The NS3-files - it is special exchange format between external device and NS3 software. It contains
geometric objects, their attributes, structure and description of the coordinate system. The imported files

can be seen in the Survey tab; on the right will be points on the map displayed:

-
«F Justin - [1]

Project Map View Tools Windows Help

9 0| BEE A8 |NN

Application

=01 PO4_X0022
-4 Map.20

B
BC‘\

13-11-13 10.28.20

B4 3 Layer 0

Kontr bard
» Object23
s Object24
.
» Object2s
» Object27
Kontr Dorg
» Object2s
» Object29
» Object30
Shape

-

m

Adjustment |

% ) Map

i ] Source

Process

| ©

M Survey

Latitude: N 55°48'06.323817"

Colod3

jhttEL
OHET26
Rigici29

RigRCt28

Om

10

20 a0

40

Longitude: W 143°04'04,3527227| | WGS 84

| Active layer

All

Figure 61. NS3 files import
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Import of *.tracyjob files

To import files in the Tracy software format (*.tracyjob), select the file(s) from the list: this type is
displayed like [ test.tracyiab ), then click Open. The window with progress status appears. To cancel
import, click Cancel.

Tracyjob-files it is special exchange format of the project created using JAVAD GNSS Tracy software.

The imported files can be seen in the Survey tab; on the right will be points on the map displayed:

F Justin - [1]

Project  Map View Tools  Application Windows Help

..... .0 @

..... s« 108 -

..... s« 109 3
..... . 11

..... s« 110 -

0 kilorneter 1 2

Adjustment I & J Map | W Survey
{ 1 Source | i0% Process | Latitude: 5 5%01'48.525133" Longitude: W 37°00'44.715351" | | WGS 84 Active layer Al

Figure 62. Imported Tracy project

Import of text files (coordinates and comments)

Text data (coordinates and comments) can be imported to the project. To import text files perform the
following:

Click the button | i\- or click Project » File import. Select the file from the list (Coordinates) and click
Open. The window with progress status appears.
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To cancel import, click Cancel:

F il
7 Import files g
Lookin: || Data_Files for Justin - G ? ¥ [
L= MName : Date modified Type
e L Met-1 28.04.2014 14:35 File folder
RecentPlaces || pacter Map 28.04.2014 14:35 File folder
!- E25) Coordinates.csv 07.04.2011 13:36 Microsoft
L | layer design points.bd 29,08.201217:51 Text Docu
Desktop  layer-1.b 31.10.2013 16:22 Text Docu
| layer-2.tet 1012.2013 14:30 Text Docu
!_-":Ti»J | layer-3.tet 26.04.2012 18:22 Text Docu
Libraries | layer-d.tet 26.04.2012 18:20 Text Docu
| layer-point_r.bd 23.09.2013 16:50 Text Docu
L:& || Primer PNEZD txt 20.03.201217:20 Text Docu
Computer . T_Palace.txt 03.05.2011 12:46 Text Docu
@
4 [ | »
Network -
File name: layer-1td -
Files of type: [l -oordinates ("bd, ".csv, Al Files) v] [ Cancel ]
L _ Receiver log files ("jps) 5

1 Rinex Obs files (. 770)
Rinex Mav files (*. 77N, =.7%3)
Rinex Meteo files (*.77M)
Hatanaka files {*.770)
Compressed files (.2}
Compressed files (*.GZ)
RTCM3 from JPS {*jps)
RTCM3 stream (., * jps)
SP3files (*sp3)

Odiles (0°7)

JST files (*jst)

CORS stations {*bd)
SOPAL stations ".apr)
ANTEX files (*.atx)

P1C1 biases ii.biasi
Coordinates (*bt. *.csv. All Files]

TVS File (“tvs)

« Kl Kmziles {"kml, *kmz)
DWG, DXFiles (*.dwa, *.cd)
NS 3Hiles (.db)

| TracyJob iles (" tracyjob)

Figure 63. Import
Select the coordinate system:
r 7 Select a coordinate system @Elg1

wz [ Grid | Local |

C o ][ o ]

Figure 64. Select a coordinate system

XYZ — Cartesian

BLH - ellipsoidal

Grid — a Cartesian coordinate system based on map projection and 7th parameters global to
WGS84.

Local - a Cartesian coordinate system based on map projection and two datums - global and local
(4+3 parameters).
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Select the coordinate system from the list and click OK. #xt data format template window will appear:

r Bl
7 txt data format template I&J
Template Fields
PN | | column Value -
1 Point name
2 |Morthing
3 |Easting
4 Height
4 5 Empty| =]
Empty - |
Foint name i
Morthing =|( =l
Easting !
Height
Mumber Line
Comment T
o= Add | | $¢ Delete || e Add | | $¢ Delete
Decimal Separator . [ 1gnor blank
Separator z [ space [ Tab
[ O ] | Cancel | | Visual Import |

Figure 65. ixt data format template

The data format template is formed depending on the type of the input coordinates and text file content.
Below an example of import PNEZD format file: Point, Northing, Easting, Z-elevation, Description. The
text is separated by commas, dot is used as the decimal separator.

& layer-Lixt - SciTE

File Edit Search View Tools Options Language Buffers Help
D@ ER| S| 2 x| |Q a?

IL,6198810.1647,7399743. 2720,0.0000,Pointl comment
3,6198802.1176,7399825. 6952, 0. 0000, Point3 comment

1

2

3 5,6198735.2402,7399734.5446,0.0000,Point5 comment

4 7,6198737.3541,7399829.9020,0.0000,Point? comment

5 9,6198806.1582,7399790.0614,0.0000,Pointd comment

6 11,6198724.5501,7399789.7985,0.0000,Pointll comment
7 13,6198769.4412,7399822.0028,0.0000,Pointl3 comment
& 15,6198769.7198,7399739.6891,0.0000,Pointls comment

Figure 66. Text file in PNEZD format

Click left Add and enter template name, click Add button on the right (in the Fields pane) five times, then
by clicking on each separate field choose appropriate from the drop down list. Click OK to save the
template, select it and click Delete on a left panel. If import was completed successfully the point objects
will be shown on a new map layer.

In the case of more complicated text files extended template could be useful. Click Visual Import button
(Figure 65). Visual Import window appears (Figure 71 on page 59). This template consists of three work
zones: toolbar, left pane for source text file and a target regular table

If numeric values has been well recognized by Justin, and the points, which coordinates were imported,
will appear on the screen; in the Map tab will be displayed initial file path and name.

56



General Description
Working with a project

Click OK, to save the template. To delete a template, select it and click Delete.

r 5
7 txt data format template @
Template Fields
| column Value -
1 |Point name
2 |Morthing
3 [Easting
4 Height
» 5 Empty| =
Point name 1 3
Morthing ==l
Easting .
Height
Mumber Line
Comment e
g Add ] [ $¢ Delete ” g Add ] [ $¢ Delete ]
Decimal Separator . [ 1gnor blank
Separator ,' [ space [l tab
[ OK l ’ Cancel ] ’ Visual Import ]

Figure 67. txt data formate template

After import is complete, the points will be shown on the screen, new layer will appear in the Map tab
with the name of imported file.

| «F Visual Import
File | Temlate
Identify
Import
Export

Figure 68. Visual import

To ignore the data from any column in the file, mark it as Empty. Comments and attributes will be merged
is some columns are marked as Comments and Attributes.

Below is the example how to import text file different from PNEZD format.
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Define parameters for each field using drop-down menu and the button [=] , close each Value.

r ]
«F txt data format template &J
Template Fields
Column Value -
_| 1 |Point name
il 2 Latitude,®
_| 3 Latitude,’
| 4 Latitude,”
| 5 |Longitude, *
_ 6 Longitude,' ‘
| 7 |Longitude,” El
1 8 Height| [=] ‘
g Add ] [ $¢ Delete ” g Add ] [ $¢ Delete ]
Decimal Separator - [ 1gnor blank
Separator Space [Fltab
[ OK l ’ Cancel ] ’ Visual Import ]
h

Figure 69. ixt data format template

By the import the following formats are used:

Reference points Local points Classifiers
= Empty Y
Faint name B E':"ntl nan;ﬁ_ Murmber Line
Morthing fcalnarthing Scale
Easting Local easting Code
Height Local height Description
M A
SE ¥
sU £
Type b Type o’
BLH Coordinates XYZ Coordinates Plane coordinates
Er I - |
E;Etug:nle Paink narne Paink narne
Latitude,’ — " Northing
Latituds,” ¥ Easting
Longitude, # Z ) He|g|;t _
Longitude,’ Mumber Line Murnber Line
Longitude,” Carnrment Comrment
Hai ght ! Recoqnized audia Recognized audia
Nober Line Attributes Attributes
Comment Tirne bt Time hd
Recognized audio
Attributes
Tirne b

Figure 70. Parameters

To delete the template than focus on it and click the Delete button on the left. To delete the field, select it
and click Delete button on the right.
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If you suspect that imported file structure can be irregular, the visual import can be performed, the Visual
Import window appears:

r - bl
«F Visual Import E@g
File Temlate
| 0 ﬂ v ’ Template |1 - h * Separator [[1Tab [¥]Space Decimal Separator . Amountline |1 -
; 23—%'312' ﬁg 39974-;3:2 %m Point name iNorﬂning, meters ]Easﬁng, meters ]Height, meters .]Ernpty i ’ -
5 6198735.2407 399734, 5446 00000 Laft 6198810.1652 3997432720  :0.0000 | Empty |
7 6198737.3546 399829.9020 0.0000 3 51988021181  |399825.6952  0.0000 Pl Pointname ‘ |
9 6198806, 1587 399790.0614 0.0000 B | : |
116198724, 5506 399789, 7985 0, _5 6198735.2407 399734.5446 0,0000 '@ Northing, meters
13 6198759.4417 399822.0028 0.0000 7 6198737.3546 399829.9020 0.0000 il Easti %
P o 4
15 6198769, 7203 399739.6891 0.0000 | g _6198806. 1587 | 399790.0614 0.0000 | SR
_| i1 _6198?24.5506 399789.7985 0.0000 | 112 Height, meters
| 13 6198769, 4417 399822.0025 0.0000 | Comment
s 6198769.7203  399739.6891  0.0000 Recognized audio
Attributes
D:\GISYJustin manualiData_Files for Justin'L-1.tet & - Amount Lines  Selected Line-1 I
= Fl
Figure 71. Visual import

This window consist of three work zones: tool bar (above), source text data on the left pane, and a table
with recognized items on the right.

Tool bar has the following items (left to right): Open file, Close file, Exit, Recognize (data), Import,
Template (list), Save Template, Delete, Separator, etc. These buttons are duplicated with the menu items:

"
3 Visual Import 1 Visual Import
File | Temlate File [Temlate |
Open .............. | dentity
§ Import
Close
Export

Figure 72. File and Template menu items

By opening the visual import window, on the left there is coordinates text file. It is possible to select the
strings for import (All lines: press and hold Alt+Shift, or right-click and select the menu item Select all,
select the strings by pressing Ctrl). The name of a template can be specified (in the Template window). If
the template is not specified, set the separators, define the number of merged strings, and click the button

- .
The selected lines will be duplicated on the right pane. If the template was specified, the columns will be

arranged accordingly, otherwise every column will be marked as Empty, and you will be able to change
the heading to any parameter from the drop-down list.

Use the right-click menu to operate with the objects:

»N Clear
== Delete Row Del

‘T Alignment Alt+Mouseleft

Figure 73. Right-click menu

* To delete the whole list of the data, right-click to call the menu and click Clear.
¢ To delete the row, click Delete Row.
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* To align the columns click Alignment.

Click the import button 4 |, after all values are defined in the table. The coordinates will be imported
into a project, the points will appear on the map.

To save the template click 4.

To define the decimal digits and recalculate column value according a formula specified by customer,
click on the column header and select Format or Formula:

Empty
Point name
MNaorthing, meters

Easting, meters

CURCUC I |

Height, meters
Comment
Recognized audic

Attributes

0

0.0

0.00

0.000
0.0000
0.00000
0.000000
0.0000000
0.00000000
0.000000000

| Format

Jfx Formula

[ [ A i R (i I A |

Figure 74. Format

If the Formula item was selected, the window Enter the formula appears. Enter the formula to the edit
field. V - itis a value of a field in the selected column.

= Enter the formula §|

Example ;

"+ ARCTAMTAN4S-ARCSIMNGSINGS )+
ARCCOSICOS{45+SORTISORI4S I+
ROUMD(45, 1111 TMT{45,1111)-
FRAC(45, 1111 TRUNC(45, 11113+
AESE-451+LN{EXP{ 1 H-LOGE10)~2

o J[ o= ]

Figure 75. Enter the formula
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If a template could not be applied to some strings, the next warnings will appear:

.
':l LoglmportTxt - Notepad [ == ihI

File Edit Format View Help

Btring = 1 »»> 7?7772, 72277 : "1" —» NO correct .
string = 2 >» 272727, 77777 : "3" -» No correct
string = 3 »>» 7?7777, 77777 : "5" -> No correct
string = 4 == 7272?77, 7?2?77 : "7" -» NO correct
string = 5 »» 7?7777, 77777 : "9" _» No correct
String =-6 »» 2277722, 22772 5 "117 % Nocorrect
string = 7 »» 7YT?TT?, PTPYT @ "13" -» No correct
string = 8 =»> 777777, 777?77 @ "15" -= No correct

e ¥

Figure 76. Incorrect data inserted

To ignore the data of some column in the file, it is necessary to mark is as Empty. Comment and Attributes
types can be assigned to multiple columns, the contents of these columns will be merged.

You can switch between windows during visual import and perform other actions in the program. To
display the previously hidden window of visual import, click Windows » Visual import.

1. Post-processing

Post-processing is a Vector processing. Recordsets which have time overlapped GNSS observation
sessions yield a Vector. A goal of post-processing is a Solution. Depending on a type of Recordsets we
distinguish static or kinematic modes of post-processing. Type of Recordset is figured out just after
importing GNSS data relative to Criterium for static in a project Scenario. So not static Recordset is a
kinematic one. In the case of special markers - STATIC/DYNAMIC, were found in kinematic Recordset,
we are treating it as Stop&Go type. We offer manual type editing thru Recordset properties dialog.

Post-processing could be run as a batch mode via Vectors item in a Process tab of project pane. Otherwise
use Selection or Selection by rectangle tool in a main toolbar.

Static data post-processing yields Solution object which represents increment of coordinates from base to
rover Sites in geocentric coordinate system and statistics. Static Solution is shown on a map on Solution
layer as a line object. Kinematic data post-processing yields a set of solution vectors so-called fan.
Kinematic Solution is shown on a map as a collection of point objects (track). Point positions are the end
of solution vectors. Below we use a base and rover terms for Vector.

Static engine as well as kinematic one use so-called single differences of GNSS data.
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7.1. Process

To get access to post-processing click Process tab on a project pane. The Vectors tree is structured by date
of the beginning time of data span.

«F Justin - [1]

Project Map View Tools Applicatic

) o || B B 8| A

{%  Process all...

Process properties

Delete solutions De

Report

Show all
Hide all

Figure 77. Processing

The next level of Vectors tree corresponds to base object. Sublevels are rovers. Base site FRED and rover
site MHCB are indicated by ' static Recordset icons.

The last level of Vectors tree is intended for Solutions that appear under rover node after post-processing.
Initially the rover node is empty. Reprocessing adds new Solution to an item.
Options:

* Process all - run post-processing for all not processed vectors in a batch mode;

* Process properties - static and kinematic post-processing settings;

¢ Delete solutions - deletion of all solutions;

* Report - publishing standard report. The report could be zxt or html format according general
settings specified in Application, Options item.

* Show all - show Vectors and Solutions objects on the map window.
Hide all - hide Vectors and Solutions objects on the map window.
Double click node . to expand or close it.

Select somehow obsolete Vectors to hide them on a map and disable in post-processing and press Del.
Double click in a check box p-4p [~ EEEFEENIEES  to recover Vector.
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There are practically unlimited number Solutions associated with a Vector.

Project  Map  iew  Tools

Application  Hel

Do W &S Ae

Bm Wectors
E-E 01.02,2014
FRED | Site: FRED
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Figure 78. Menu
By clicking Solution item inspect a menu:

* Properties - opens Solution form;
* Enabled - validation for adjustment;

Zoom to - shows Solution entire;

Style - style customizing;

I Objects
I Static

Line visible

Line width 23

Draw atrow

* Rename - opens a dialog

Mew solubion name:

|My solution

| QK

* Residuals - opens Residuals chart;
* Report - print a report;

www.javad.com
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7.2. Static post-processing settings

Process properties option are available thru Vectors menu.

64

A static - engine specification. One engine only is available in a regular package.

Use precise ephemeris - apply or ignore precise ephemeris in post-processing. While processing
with precise ephemeris broadcasted ones are also required for Run-time settings dialog window
(Figure 86 on page 70) Precise ephemeris have no action in a kinematic data processing;

Cut off angle - minimum satellites elevation angle threshold; We do not recommend values less
than 10°;

Engine mode - preset GNSS data combination in post-processing. Detail explanation of code and
phase combinations is widespread. Auto mode runs one of listed below modes. L1&L2 dual
frequencies data mode designed for baselines shorter than 60 km. Wide Lane combination is first
iteration step for longest baselines. We use so-called Ionofree combination for final dual
frequencies carrier phase solution.

Engine mode

By clicking ) aue < — field one may customize Solution style on a map window;

(L1 anly
2 ~
«F Process properties [iz-,l
Static  Kinematic
Static A static hd
[ Use precise ephemeris Cut off mask 15 |©
Engine mode Weather
9 Auto = Pressure, hPa 930
“IL1only =
Temperature, *C 20
L2 only o |-
Slial2 . |7 Humidiy, % 50
Marrow Lane -
1 Wide lane . /
Code o L
Float =
Troposphere model |Justin - |
Max distance, km 500 Default
| Save residuals
| Interpolate base
Lift and Tilt [ OK l | Cancel |

Figure 79. Process properties

Weather - meteo parameters settings. Humidity value very affects to computed altitude.

Troposphere model - one of the listed below: Justin, Zero, Simple, GCAT, MOPS,
Goad&Goodman, NB(New Brunswik), Saastamoinen, Niell, Bernese. We recommend Justin
model for sites with height difference less than 500 meters. Otherwise MOPS or NB models are
preferable. Note that MOPS ignores external meteo parameters and operates with independent
settings. Some models do not offer mapping function for precise computing of troposphere
corrections;
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* Max distance - maximum baselines length (in km). Focus on this very important item for batch
processing. Over range Vectors are skipped without warning;

* Default - restore program settings;

 Save residuals - store residuals in a project database. Residuals are results of subtraction measured
pseudoranges or carrier phases and theoretical distance from receiver to satellite. Keeping
residuals make post-processing slower and can overload a project (maximum size 2 GB). In the
meantime residuals chart is main tools to control post-processing result in a bad environment.

* Interpolate base - interpolate epoch GNSS data on base to reach solutions for every rover epoch
position. We assume base and rover data sampling are different.

* Lift and Tilt - force processing of [RM] (Rotation Matrix) message. It makes sense for Triumph
VS/LS receivers data.

Ambiguity validation procedure have been based on so-called LAMBDA method which yields contrast of
Fisher-distribution. Contrast is ratio of the two minimum quadratic forms of the least square residuals -
second minimum sum divided by first one.

We compute cumulative distribution function (CDF) for the Fisher distribution (value varies from O to 1)
with numerator equals 2, denominator equals quantity of ambiguities and upper limit of integration
equals contrast. F-ratio statistic given in percents. 100% value is for the best ambiguities resolving.

F-distribution refers to normal distribution of carrier phase residuals. Chi-squared test for normal
distribution of residuals is significant when it based on enough long observation sessions for averaging
noisy data.

Despite the differences of various GNSS post-processing software engines, assured integer ambiguity
resolving procedure claims thirty minutes time span observation for short baselines (<10 km) with more
than five satellites locked, dual frequencies measurements and a good environment. In the meantime
above mentioned requirements are often enough to reach good single epoch carrier phase solution. In the
last case F-ratio solution statistic expected to be equal 100% but it is not significantly estimated. We
recommend to practice two bases - one rover network configuration and evaluate loop misclosure to
check correct fixing of ambiguities.
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When short baseline has been processed any values of F-ratio in a range 75% -100% could be acceptable
if a quantity of discarded measurement is low (<5%). In fact, it is not a problem to increase F-ratio by
dropping a satellite which deals biggest residuals (refer to Residuals Chart).

7 Residuals: 302_0715a_01 - 634_0715a (1) = = “
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GP3 time:

Figure 80. Residuals
Other major way to improve F-ratio is increasing of cut-off angle.

The addition of GLONASS and particularly BeiDou and QZSS data improves and significantly enhances
LAMBDA searching procedure. To make any GNSS data enable/disable in post-processing use settings
in a Project properties.

Evaluation of carrier phase data post-processing for baselines longer than 30 km dramatically differs
from measurement taken over short baselines. Statistics evaluation works quite well over these baselines
due to continuous observation sessions which deal enough measurements for resolving ambiguity. The
problem is handling tropospheric and ionospheric delays which cannot be completely canceled in single
differenced residuals which contains the signature of many unmodeled systematic biases. Loop
misclosure test does not deal reliable accuracy estimation because loop vectors are so-called trivial. Next
problem is in time correlation of carrier phase measurements. The ability to resolve ambiguity could be
checked by splitting observation session, processing data independently and a comparison of positions
and statistics. Full session result position must be approximately in a center of partial solutions.
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7.3. Batch processing

Batch processing is continuously Vector by Vector post- processing. We offer to run batch processing
from project pane as well from map pane. Upper level objects in Vectors tree suggests batch option.

Site (2) T
Reference (&)
Recordset (23
Edge (16)
Wector (16)

RIAER| 125
JESUE

»
»
»
»

AR =

piig] 31267

o

£ Process all..

“w  ZDOm to..
It

» Delete solutions

Figure 81. Process all

Use Selection by rectangle tool to accept multiple Vectors in batch processing.

Select several Vectors in a rectangle area on a cartographic window;

Right click map to view batch processing menu (Figure 81). A quantity of selected object is
indicated;

Click Process All in submenu.

Others submenu items:

Zoom to - view selected object entirely.

Invert - switching Vectors direction. It drops all old Solutions assigned to Vector.

7 Justin “

All solutions of this weckor will be deleted. Continue?

es Mo

Figure 82. Warning

Delete Solutions - it completely removes all Solutions from a project. Special warning (Figure 82)
will be displayed.
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Batch process window shows workflow status - completed solutions number, Vector in progress, time left.
To interrupt batch process click Cancel. Just processed solutions will be saved. Processing is running in a
modal mode to avoid conflicts in a project database.

MIMS - FRED
MINS - POO7
MINS - TXPE
MINS - POOL
MIMNS - PUEG
P172 - POOL
P17z - POOT
P172 - PUEE
P172 - FRED
P172 - THPE
172 - MHCE

v
v
v
v
v
v
v
v
v
v

"»-.

Weckar 13 from 28 Time left 00:02:36

Cancel

Figure 83. Batch process

As batch processing have been completed ProcessLog.txt file opens (Figure 84).

Eile

Edit Format  Wiew

11.
11.

11.
11.
11.
11.

<

84.26814 16:21:
84,2814 1&6:21:
84,2014 16:22:
84.26814 16:22:
84,2014 16:22:
84,2814 16:22:

: Process started

: P172 - FRED: Fix
: P172 - PaBl: Fix
: P172 - PBB7: Fix
: P172 - MINS: Fix
: Process finished

ratio
ratio
ratio
ratio

188, 860%, Measurement used:
166,660%, Measurement used:

83914 of 42162 -{99% discardec
83748 of 42885 -({99% discarde:

99,96%, Measurement used: 84496 of 42578 -(98% discarded’

188, 860%, Measurement used:

Figure 84. txt file

7.4. Single vector processing

Single vector post-processing is used for purposes:
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customizing settings for batch processing;

processing in Auto mode does not deal good result;

reprocessing Vector to get more Solutions;

picking time intervals from session;

88178 of 44433 -(98% discardec

www.javad.com
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skipping unwanted Vectors (rover - rover time overlap).

- 01.02.2014
-4 FRED | Site: FRED

H _‘,p -

e # [ Salution i2F Process.,
- MINS | Site: MINS
-4 POO0L | Site: PO
-4 POO7 [ Site: POO7 | Zoom o,
-Ap P172 | Site: P172
-4y PUBS | Site: PUBG Invert

Ay TAPE [ Site: TAPE | 9¢ Delete salutions Del

b Properties

I Oy O O e R

Cormron satellites
Differences

Runtime settings

% Sky plot
4y FRED 4
v MHCE 4

Figure 85. Single vector post-processing

The menu is available by clicking Vector item on project pane as well on map.

Process - runs post-processing;

Properties - opens Vector properties window;

Invert - switch Vector direction

Delete Solutions - drops all Solutions;

Common satellites - opens a chart;

Differences - opens a single and double GNSS data differences charts;
Runtime settings - opens interactive dialog pane;

Sky plot - opens a chart.

Recordset item - provide access to base and rover standard properties dialog;

Interactive mode

Interactive Vector processing could be useful when more accurate positioning is to be carried out.
Runtime settings control can be quite labor intensive if automated processing mode produces erroneous

results.

To process single Vector as interactive right click it in a project or map panes and select Runtime settings

option.

Control pane will be opened in the bottom of program window. The purposes of the control are:

omitting suspicious satellites;

time interval figuring out;

picking time intervals;

forbidden some GNSS data;

keeping residuals;

make interpolation base data on the rover epoch;

applying Lift&Tilt option (GREIS [RM] message processing);
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In order to evaluate a Solution refer to Residuals chart and Solution statistics.

G

Common  Engine settings

Mame

P172Z - TXPE

Begin ime 01.02.2014 | 00:00:00

Endtime |01.02.2014 3 |21:33:00
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WO @0 W10 @12 10 1 4igal

@156 1669 17 154 1949 2049 21
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OO EEEECEECErn B

Save residuals
[J1nterpolate base

o 0 01:5640 03:20:00 04:43:20 060640 07:30:00 08:53:20 10:16:40 11:40:00 130320 14:26:40 15:50:00 171320 16:36:40 20:00:00 21:23:20 224640
GRS time:

Figure 86. Observations

As regards Figure 86, all observations are presented with green, gray, yellow, blue and red strips. Green
strip marks periods satellite location above cut-off elevation angle. Gray strip indicates periods when
locked satellite was under cut-off angle. Yellows are unhealthy satellites. Blue strips indicates lost
ephemeris data. Right and left mouse clicking on green part of strip causes to switching colors to red
which means picking time intervals. To exclude internal interval press and hold Crrl button. After that
click right-left or left-right scopes. Take into account that second clicking will be on a red part of strip.

Engine settings tab switcher opens process properties windows shown on Figure 79 on page 64.

Click |¢

sy

button to run Vector processing with run-time settings.

TN

71.5. Statistics

The validity of solution could be verified by using statistics. If the quantity of discarded measurements
which equals total quantity of measurements minus quantity of used ones (Num meas - Num used)
exceeds 20% then it make sense to reprocess Vector in manual mode.

Coardinates || Statistics nntenna| Satellites| Settings|

Mum meas 47 316 RMS residual 0,022z
Mur used 44 625 Fix ratio 907,54
Turmn ambig 25 Satellites used 11
Turm Fixed 24 Epochs 2337

Processed at 11.02.2014 55| |[1:52:35 =

Eegin kime 1487 21| 473 603,000 2
End tirme 1487 =1/ 475 939,0002
Figure 87. Statistics

Fix ratio 1s F-ratio statistic which was described above. Values in a range of 95-100% are considered as
well ambiguities resolved.
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RMS residuals value for L1&L2 carrier phase fixed solution never exceed 0.05-0.06 meters. Otherwise
ambiguities couldn't be resolved. Comparison of Num ambig and Num fixed values does not evaluate
solution accuracy. It reflects multipath behavior and blinding GNSS signals obstacles. Therefore, no
matter how much ambiguities were dropped. Investigate the correspondence of used satellites quantity
and a number of fixed ambiguities. If this ratio in L/ &L2 mode is less 2 then either L1 or L2 data is
corrupted.

7.6. Kinematic vector post-processing

Kinematic vectors processing as well as static ones could be run thru project pane or thru map window.
Right click on selected Vector and hit Process. Batch vectors processing is available also. Use selection in
rectangle tool for multiple data processing.

O 1L, LTS,
-
f Y al g,

% Process.. N\
b

N Properties

—w Zoomto..

»  Delete solutions

Commmon satellites

Differences

Rurtirne settings

SUMLEZ O 634 0629 8
i ) 1108_0620b [

i Y| 11,2275
e oA

Figure 88. Kinematic vectors processing

Kinematic Vector option menu has no difference with static Vector one (Figure 85 on page 69), which
was described in 7.3. We draw kinematic Vector on map as track without showing fan of rays coming
from base to rover so it could hide map objects situation and hung redrawing. Base is specified in the
bottom of drop-down window (634_0629a on Figure 88). To focus map on base Site select it and hit
Zoom to.
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If Process properties dialog window was involve via Vectors item in a project pane then process settings
affects how not processed Vectors will run. Runtime settings affect how single Vector processing will run
if one click |+ button.

Static ,M

Kinematic C kinematic

Processing  Advanced

Processing mode

ode Diff Smoothed

arrier Floating

(®) Carrier Fixed

Figure 89. Kinematic

C kinematic - is name of kinematic engine in regular Justin assembly.

Code Diff - pseudorange data processing mode;

Code Diff Smoothed - carrier-smoothed pseudorange data processing mode;

b

Carrier Floating - carrier phase data processing mode without resolving ambiguities;
* Carrier Fixed - carrier phase data processing mode with resolving ambiguities;

Additional settings are available with Advanced tab.

4 Process properties n
Static || Kinematic
Kinematic | C kinematic v
Processing || Advanced
aPS GLONASS
Elew mask WMemary Factar Azimuth shading
10,0 10,9957 Begin 0,0 L
Iona Factar 4,000
End 0,0
Iono corr, a,0
Fix level CfA SNR threshold Observables
Medium v 31,0 ) :3L1 [|Re-Check
@iz [ mismatched Time Interpolation
[ cia only positioning
RMS
Code, m 5,000 | Cartierphase | 0,0500 Default
Save residuals
[ interpolate base
[ Lift and Tile Ok

Figure 90. Process properties
Specification:

* GPS, GLONASS check boxes - enable/disable GPS or GLONASS measurements in processing;
Elev mask - satellites elevation cutoff angle;

* Memory factor - priority item for high dynamic application that affects how fast left epochs will
be dropped from computation;

Fix level - contrast value. Low level corresponds to 4.
C/A SNR threshold - limits data by C/A code energy value. Reasonable minimum equals 28.
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* It is important to note that RINEX data may have L1 carrier phase measurements instead of C/A
carrier phase. L1 signal energy is much low;

* Jono - ICD (Interface Control Document) ionospheric correction;

* Jonofactor - threshold parameters used for outliers rejection (Ionofactor * RMS), where RMS is
rout mean square of residuals;

* Jonocorr - preset for ionospheric correction;

* Re-Check - autorun ambiguity resolving procedure every 7 epochs;

* Mismatched Time Interpolation - spline interpolation of skipped epoch position;
* C/A only positioning - ignores carrier phase data;

* RMS Code/ Carrier phase - accuracy preset for pseudoranges and carrier phase measurements;
RMSs code/phase ratio is the most important parameters in ambiguity resolving procedure;
Getting maximum fixed solution investigate optimal code and phase RMS values. Modify
Memory factor parameters to eliminate unexpected rover dynamic effects. Decrease this value if
jerks happened. Next step is customizing of Ionofactor parameter. Values from 2 to 4 make sense
and acceptable. At last we recommend to softly increase cut-off elevation angle up to 15 degrees.

8. Adjustment

Geodetic network adjustment uses weighted least squares method for solving over-determined linear
system.

AX =L [8.1]

Depend on 3D/2D adjustment mode the design matrix A has 3*n or 2*n rows (n - number of solutions)
and a structure comprising +1 and -1. X is a matrix of unknown Node coordinates. The number of
unknowns m equals the number of network nodes multiplied by 3 or 2 also. L is an array of Solution
components dX, dY, dZ.

In the case of adjustment in geocentric linear equations system is:[8.2]
Xy — Xy = dX;
Yy — Yy =dY
Zy — Zy =dZ

where X,Y,Z are unknown coordinates of M and N network points.

The redundancy of the network adjustment problem is a number of rows minus the number of columns.
Subject to a weight matrix W solution of [8.1] is given by solving:

ATWAX = ATWL [33]

Weight matrix W is a block diagonal matrix formed using Solution covariance matrices.

Network adjustment solves two main problem:

1. Post-processing solution accuracy estimation, outlier and blunder detection.

2. Calculation of final Site coordinates and statistics.
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As much as coordinates are not a goal of the first problem it runs first in inner constrained mode. To
overpass the singularity of normal matrix 4TW A we use singular value decomposition (SVD) method.
The research of network adjusted in inner constraints mode is intended for detection and making odd
from final adjustment results blunders and estimation of systematic errors impact.

The detgction of blunder is treated using Pope's 1-test. This method computes standardized residuals

L
U = Jtu [8.4],
Ll
detect blunders in iterations and remove suspicious data from design matrix. The iterations continue until

all blunders have been disable and X’ test passed depend upon the significance level and the degree
freedom. q;; are diagonal elements of the cofactor matrix

Quy = Qn — AQxxAT [8.5], where

T
Cu is a block diagonal matrix of 3x3 dimension solution covariance matrices, Qxx is inverse of 4 WA
matrix.

T-test treats solution as a blunder if a residual exceeds t-value.

T%n—m is determined in - distribution. &, = 1 — (1—) /™.

ot is user defined significance level (68%, 95%,99%).
Level 99% corresponds to the most soft restriction and 68% level is the most strong.

Note that t-test uses standardized residuals for blunder detection instead of its absolute value so small
residuals could be treated as blunders also.

Least Squares method deals optimal results in geodetic adjustment if GNSS data post-processing solution
errors are normally distributed. x?- test checks if solutions errors are normally distributed. It compares
so-called unit weight error £ and x? statistics.

1
Xt < u? = —XVTPV < xj, [8.6]

2
In fact X test estimates consistency of solution covariance matrix Qu relative to a posteriori statistic.

2
In the case of geodetic adjustment failed X test it indicates that some observation sessions were too short.
Due to time correlation of GNSS data solution accuracy is overrated. In the meantime loop misclosure are
often big and # is out of limits.

Inner constraints adjustment runs in relative coordinate systems. To show inner adjustment result in a
cartographic window we snap relative coordinated network to first listed reference point (if it exists) or to
first listed site.

Second goal of adjustment are coordinates of measured ground points. To reach it the network must be
snapped to ground reference points and final adjustment should be running under external constraints.
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8.1. Network

To run adjustment switch to Adjustment tab in a Project pane. As well as adjusted subjects are Solutions
than complete Process procedure in advance. Objective are Nodes which form Edges and Loops. In fact,
Edge is adjusted Solutions which correspond to a Vector. There is a special layer to represent Edges in a
map pane. Nodes category 1s intended to manage one of the main result of processing data - coordinates
of target points. Roughly say Node is unknown value. Depending on adjustment mode the quantity of
Nodes could be equal Site quantity (inner constraints mode, no data rejected), or could be less if some
Sites were snapped to reference points.

Loop category deals simple additional estimation of post-processing data accuracy. The sum of Solution
components along a loop is a misclosure. Loops detection and generation is running simultaneously with
network adjustment procedure.

Project  Map  Wiew Tools  Appl
-
g8

== | Metwork

_iJ{ﬂ Sites

+{3 Reference points
¢ @ Edges

+{3 Loops

..... [\ Kinematic
o i Positions

Adjustment
& ) Map M Survey

i |1 Source it Process

Figure 91. Adjustment
There are four upper items in Adjustment tab:

¢ Network - static solution network;

* Stop - survey points;

* Kinematic - trajectory;

* Positions - real time point coordinates.
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Introduce a terminology:
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Figure 92. Network

1. Site — point objects shown on the map with cartographic sign relative to Legend. Initially Sites are
generated for raw data Recordsets upon standalone solution. Cartographic sign of Site reflects it origin -
standalone, manual input (do not considered as constraints in adjustment), snapped to Reference point or
Solution or Node.

Par example, Site OXMT is on a standalone position, MHCB is on post-processing Solution, LNCI
snapped to reference point (Figure 92 on page 76).

2. Reference points — list of control ground points with postulated coordinates.

3. Node - point object which has no cartographic sign. As it was mentioned above a quantity of Nodes
could be less that Sites quantity. Covariance matrix for Sites and Nodes could differ also.

4. Edge — linear object created thru adjustment. Edge connects two Nodes and forms a network. Node can
share Edges. Edges are shown on a special map layer. There is Edge table is in adjustment report. It is
used for residuals and relative error publishing.

Edge types:

* Single ended - edge that shares with a network one site only;

* Bridge - edge that connects loops. It does not form itself any loop;

* Blunder - edge that has not passed tau-test. By default blunders colored red;
* Common - others edges.

5. Loops - a list of independent loops generated under restriction of minimum edges quantity in a loop.
Loop misclosure is indicated depending on adjustment mode (XYZ/NEU).

To get access to options of Network item point on it and right-click mouse button.
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i Adjust

Delete

Report

LHC1 02

Adjustment parameters

Figure 93. Menu

* Adjust — run network adjustment. Last adjustment data will be drop automatically;

* Adjustment parameters — involves a dialog window of adjustment parameters settings below.

* Delete — drops last adjustment;

* Report — generates standard report.

8.2. Adjustment parameters

r

 Adjustment parameters

Mode
@ Automatic rejection
~) Automatic downweighting
Interactive

MNEU D
@ XYZ 3D
Confitence Level
Tau test 68%
chi2 7 68%
Transformation
@ MNone
_| Topocentric
Constraints
Inner
@) Fixed

Fixed and weighted
Weighted
Loops
E horz 1.000 m Ahorz

E vert 10,000 m  Awert

L

a5

Yo 99%

% (@) 99%

1.000  ppm

10,000  ppm

Lo J|

Cancel

)

Mode - scenario of blunders canceling:

Figure 94. Adjustment parameters

* Automatic rejection - adjustment is running in iteration. Blunders are excluded step by step until

they are canceled.

* Automatic down-weighting - adjustment is running in iteration. Blunders are down-weighted step
by step until they are canceled.

ﬂbj'l:i:l

* Reduction factor equals, where u is standardized residuals equals & to” | [8.4], is computed
depending on defined confidence level.
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* Interactive - adjustment in a dialog. The mode allows to down-weight or cancel a solution at each
iteration step instead of batch blunder processing in above mentioned automatic mode.

Mode - blunders qualification in inner constraints adjustment:

* NEU - residuals are calculated in topocentric coordinate system (Northing, Easting, Up).There is
additional specification 2D/3D to separate plane and vertical sources of errors. If an edge was
marked as blunder in NEU 3D mode than it make sense to readjust network as 2D to exclude error
in vertical components which happens due to wrong antenna height or type input.

* XYZ - residuals are calculated in geocentric coordinate system.

Confidence level:

Post-processed solutions that based on GNSS data obtained in short session of observation may have low
absolute accuracy and a good statistics - small standard deviation errors (sigma - square route of diagonal
elements of cofactor matrix). Thus its impact in adjustment is overvalued due to big values of weight
matrix. In the meantime edge residuals mustn't exceed sigma more than in 2-5 times in the case of normal
distribution of errors. Otherwise an edge should be detected as a blunder. Settings of confidence level
limit allows to control blunder detection procedure.

From the other hand value of unit weight error must correspond to Solution accuracy. Regular p value
vary from 0.4 to 1.6. Formula [8-6] computes more accurate these limits using network number degrees
of freedom and confidence level value. 99% level is the widest limit.

Blunder detection procedure affects to chi2 test. Control of confidence levels for both tests allows to pass
to chi2 test well.

Transformation

Fixed constraints adjustment is running as localization (“Getting LCS” on page 88) if “Topocentric”
option was selected. In this case unknowns values are not only Node coordinates but translation, rotation
and scale parameters also. Instead of localization an adjustment as “Topocentric” does not store these
parameters in program database.

Constraints

* Inner - adjustment of free network with no constraints. Residuals depend on network geometry
and solution quality. It is a very important preliminary network adjustment which is running
automatically for constrained network also. We recommend to accomplish it in advance
separately as a best way for post-processing outliers cancellation.

* Inner constraints adjustment computes site positions in a relative coordinate system. Meantime
results might be similar to those in a case of fixed constraints adjustment with one reference point.

» Fixed — adjustment which could be completed if a network was snapped minimum to one
reference point. Otherwise a warning appears. Snapped Sites position left steady. Reference points
accuracy statistic does not affect to residuals and computation;
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* Fixed and weighted — adjustment is running similar to Fixed but reference points covariance
matrix affects to residuals and positions computation;

» Weighted - sophisticated adjustment type which computes positions for reference points as well as
for unknown Sites.

Loops

Constant E (in meters) and linear parameter A (in ppm) define acceptable limit for loop misclosure.

An equation is:AL = E x+/N + A x L, [8-7], where: N — edges quantity in a loop, L - length of loop.

Overpassed misclosure are colored in red in left project pane.

8.3. Interactive

This dialog window appears if interactive mode is running.
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_| 2 |LUTZ -MONE_01 -0.0001 -0.0004 0.0004 1.3093 Chi high = 1.479
4 1 LUTZ - MHCB 0.0001 -0.0003 0.0001 1.2506 :
= Chi2 test : No
X 7 |MHCE - OHLN -0.0003 -0.0020 -0.0007 1.2166
_| 5 LUTZ - SACB 0.0003 -0.0003 -0.0013 1.1331 E
_| 20 | TIEE - OHLN 0.0001 0.0002 0,0000 0.8545
_| 12 MOME_01 - OHLN -0.0007 -0.0009 0.0003 0.7303
_| 21 TIBE - OXMT -0.0004 -0.0005 0.0003 0.7536
_| 3 |LUTZ - OHLN -0.0011 0.0002 0.0005 0.6724
_| 19 SACE - TIEB 0.0001 -0.0001 0.0018 0.6591
i 16 OXMT - OHLN 0.0008 0.0003 -0.0004 0.6514
I 11 MONE_01 - MHCB 0.0001 0.,0001 0.0002 0.6334
_| 18 SACE - QXMT 0.0004 -0.0004 0.0010 0.4833
_| 15 MONE_01 - TIBB -0.0001 0.0001 0.0004 0.3433
_| 17 SACE - OHLN -0.0003 -0.0001 0.0009 0.3259
_| 14 MONE_01 - SAOB -0.0004 0.0002 0.0005 0.3189

Figure 95. Interactive adjustment

There are a list network edges properties and statistics in a table. RX,RY,RZ are components of Edge
residuals. Tau column includes maximum components of standardized residuals (uX,uY,uZ). Right of the
table parameters of test are shown.

To exclude an Edge from adjustment select a row in a table and click Reject. Press and hold Ctrl or Shift
button to exclude more Edges at once. By clicking Reject, Restore, Downweight button run readjustment.
Dialog window (Figure 95) appears once more. Complete button is intended for final adjustment.

The main goal of interactive mode is a test achievement. To reach it we recommend to consequentially
reject edges with maximum value in a 7au column. It is not possible to reject Bridge edge as network will
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be splitted in two subnets. In this case a warning appears. A network could be adjusted in subnets by
disabling Solution in advance before adjustment.

Rejected Edge is kept in a table but corresponding row shown in gray. For restoring it select row and click
Restore.

After clicking Downweight button additional dialog window appears. Available value for correction
parameter is in a range from 0 to 65536. Solution covariance matrix will be updated relative to correction
value.

- T T
«F Interactive adjustment (=8 ¥ |
| o | Name | mx | re | rz | Tau | - Reject

4|LUTZ - OXMT 0.0001 0.0027 -0.0015 2.9261

> LTz TIE8 0.0026 [ restore |
9 |MHCE - SACB -0.0004 0.0000 0.0017 1.6610 Z

— z Downweight

_| 13 MOMB_01 - OXMT -0.0001 -0.0013 0.0004 1,5983

i & MHCE - OXMT 0.0020  0.0001  0.0001  1.5555 Mu = 0.026

l 10 MHCE - TIEB 0.0001 -0.0025 0.0012 1.4939 || chilow =0.554
2|LUTZ 0.0004 1,3093 T LA

=1 Downweight Iﬁ Chi high = 1.479
1 LUTZ 4 9 0.0001 1.2506 iy

— i2 test : No

| 5 | LUTZ - TIBB -0.0007 1.2166

l 3 -0.0013 1.1331

| 0.0000 0.8843

m T

_| 0.0003 0.7536

il ’ 0.0005 0.6724

| 19 SAOB - TIEB 0.0001 -0.0001 0.0018 0.6591

_| 16 OXMT - OHLN 0.0008 0.0003 -0.0004 0.6514

_| 11 MOMB_01 - MHCE 0.0001 0.0001 0.0002 0.6334

l 18 SAOB - OXMT 0.0004 -0.0004 0.0010 0.4838

| 15 MOMB_01 - TIBB -0.0001 0.0001 0.0004 0.3433

_| 17 SAOB - OHLN -0.0003 -0.0001 0.000% 0.3259

_| 14 MOMB_01 - SACE -0.0004 0.0002 0.0005 0.3169

< ]

Figure 96. Downweight

Press OK to readjust network. Correction parameter will stored while interactive window (Figure 95 on
page 79) is open.
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8.4. Survey points adjustment (Stops)

General Description
Adjustment

In fact, Stop objects are averaged along epochs rover solution coordinates. In the case of multiple bases

Stop positions could be adjusted.
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Figure 97. Stops
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Focus on Stop node of Network object. This node is for Recordsets which were detected as Stop&Go type
during import raw GNSS data (STATIC/DYNAMIC tags in JAVAD jps files or Static/Kinematic marker

in RINEX). Recordset property could be updated manually.

= Report 4
@ Antennas

|
Ay Ini_04

5,
B

Figu

98. Stop options
Stop options:
1. Adjust — multiple bases kinematic solutions adjustment.

2. Report — standard report publishing.
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3. Antennas — opening Stop antennas window for height and offsets editing. Antenna type editing denied
as Stop object is, in fact, a time interval beside Recordset or Solution. Editing antenna type drops a
Solution.

[Tstep | Longtude | Latiude | teight | stopaMs | MavMs | Begintme | Endtme |l AntennaType | A
E57°53'55,957264  NSE° 29 27,719384"  143,7952 0,007147487  2,124724 02.07.2007 09:245002,07. 2007 09:25:00  INSMARANT_GGD!
E57°59'53,363143" | N58°29'27,201388" 144,633 0006419405 2,146848 D2.07.2007 09:24,2102,07.2007 09:24:3L  INSMARANT_GGD
E57°53'89,877471" | NSE°29 26,831070° 1452811 0,006289914  2,097851 02.07.2007 09:23:5402,07. 2007 09:24:04  INSMARANT_GGD Moacired fight, i | 1,0000|
E57° 54'00,566591" | N 58729 26,254686"  144,9980  0,00614808 |  2,079914 D2.07.2007 09:23,2302,07.2007 09:23:34 | INSMARANT_GGD
E57°54'01,363322" | NSE°29 25,725108" 1456683 0,006146373  2,085731 02.07.2007 09:22:5102,07. 2007 09:23:01  INSMARANT_GGD i
E57°54'02,000760" | NS8° 2925362043 144,5996 0,00623367  2,138363 D2.07.2007 09,22:1902.07, 2007 09:22:23  INSMARANT_GED | Messured offsets From marker
E57°54'02,640265" | NSE° 29 24,883326"  144,4461 0,006521798 |  2,083379 02.07.2007 09:21:3702,07. 2007 09:2 147 | INSMARANT_GGD -

|ES57°54'02,7502239" | NSO° 29 24,704809" | 143,8529 0,006705456 | 2,092478 D2,07.2007 09:21:1002,07.2007 09:20:20  JNSMARANT_GGD
E57°54'03,084311" | N58°20' 24,384518" |  143,4906 0,006404458  2,0621 02.07.2007 09:20:4502,07. 2007 09:20:55  INSMARANT GGD North, m 0,0000|
E57°54'03,211508" | N58° 29 24,190229" 14,0715 0,006403787 | 2,090613 02.07.2007 09:20:1172,07.2007 09:20:21  JNSMARANT_GGD

Serial number |-Llnknnwn-

Vertical, m

‘ 0,0000
| E57° 54'03,291988" N 5&° 29' 24,126240" | 144,3876  0,008652354 | 2,229946 _DZ.DT.ZUDT 09:19:4802,07, 2007 09:19:55 _JNSMF\RANTiGGD East !
| E 57° 54' 03,543007" | M 58° 29' 23,902877" | 143,6149  0,00679716 | 2, 12$225 QZ.DT.ZDDT 09:19:1602,07, 2007 09:19:26 JNSMAR»\\NT__GGD Type
] E57° 54'03,73308" | N 58729 23,429605"  143,0704 (0,006500067  2,09259 D2,07.2007 09:18,:3902,07.2007 09:18:48  INSMARANT_GGD JAVTRILMPH LS NONE
| E 572 54' 04,594879" N 53° 29' 22,715604" 144,1065 0,006212721 | 2,082095 ;DZ.DT.ZDDT 09:17:5402.07, 2007 09:15:04 _JNSMAR»QNT_G_GD
I_ | E 57° 54' 05,058682" N 58 29' 22,253768" | 143,9082 0,006153339 | 2,153617 _DZ.DT.ZUDT 09:17:2602,07, 2007 091735 _JNSMF\RANTiGGD
| E 57°54'05,759267" N 53° 29'19,100256" 143,1795  0,006741726 2,15081 |02.07,2007 09:05:5602,07. 2007 09:06:06  JNSMARANT_GGD  w | - -
. . . oK | Cancel |

< > |

Figure 99. Stops
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8.5. Kinematic adjustment

Kinematic adjustment could be running if multiple base solutions exist and Kinematic node is not empty.
New trajectory object is intended for control adjustment workflow. Report option publish standard report.
- | Metwark,
+._J Stop
__J

all N Adjustment parameters i3

INi_|

H i 3
i | Positiony © Report

Figure 100. Menu

Settings

7 Kinematic adjustment properties “

[Tuse weight by distance to base Range 250 | km
Use: fixeed solution
[Juse Foat: solution

[IFixed priority

Figure 101. Adjustment properties
* Use weight - weighted adjustment with scaled covariance matrices by rout square of distance
between base and rover epoch position;
* Use fixed solution - only fixed solutions are taken in account;

* Use float solution - both float and fixed solutions will be adjusted using epoch solution covariance
matrices;

* Fixed priority - ignore float solution if fixed one exists.

Range parameter sets maximum acceptable for processing distance between base and rover epoch
positions.
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Report

Adjustment Kinematic

Trajectory

Multiple bases kinematic data processing generates new trajectory object in the Kinematic mode with

options:

1. Adjust — running kinematic solutions adjustment:

2. Delete — drop last adjustment from a project and redraw map;

3. Zoom to - show entire trajectory;

ratic
allgde

o
Ini| %5

L | Posttion ¢

Adjust
Delete Del

‘s Zoomto.,
Frofile

“ Report 4

Figure 103. Node options

4. Profile — open new pane with epoch table and vertical profile.

m B | Flulé

‘ Longitude ]

Latitude

5 "3l ' 16
57° 53 25,253326"

Record 6 763 from 11 075 (1)

57° 53 25,313985" N 58° 29' 16,499773"
57° 53 25,314212" N 58° 29' 16,493903"
57° 53 25,308857" N 58° 29' 16,480677"

N 58 29' 16,478542"
57° 53 25,264186" N 537 29' 16,489385"
57° 53 25,2633658" N 557 29' 16,489983"
57° 53 25,265046" N 553° 29' 16,492063"

e
| Height | Fixed | Residual Timne Sigma |Enabled A
175,0488 0,000 03.07.2007 11:02:45  7,8106-3% [
175,0360 0,000 03.07.2007 11:02:49  7,8136-3 [
175,1404 | 0,000 03.07.2007 11:02:50  7,8126-3 [#
175,1870| M | 03.07.2007 11:02:51 | 7,
1751636 0,000 03.07.2007 11:02:52 7,811E-3 &
175,0971 0,000 03.07.2007 11:02:53  7,8106-3 &
1751008 |7 0,000 03.07.2007 11:02:54 | 7,8116-3
175,0947 | | 0,000 | 03.07.2007 11:02:55 | 7,812E-3 [
>
Figure 104. Profile

Mo UTC time Latitude Longitude Height, m || Residual | Sigma || Fixed
1 03.07 2007 08:33:20 000 || M 58°29'11 639883 | E 57°54'07 472620" || 140,0066 |0,0000 |[0,0095 || Yes
2 03.07.2007 08:33:21.000 || M 58°29'11,701927" | E 57°54'07 500337" || 140,0235 10,0000 |[0,0096 || Yes
3 03.07 2007 08:33:22.000 || N 58°29'11,705458" | E 57°54'07 535014" || 140,1952 |0,0000 |[0,0130 | Yes

Figure 102. Report

180

150

R IR P i

Time: 14:31:50

Selection row in the table pane generates orange colored circle on graph.

84

- ; -
08:33:20 09:32:41 10:37:38 11:42:35
UTC time

Height: 140,859
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9. Localization

9.1. Introduction

The basic coordinate system which is used for data storing, post-processing and geodetic network
adjustment is geocentric WGS-84. To transform coordinates to a local grid coordinate system (LCS) we
need:

1. Reference ground points in a grid coordinate system.

2. Mathematical algorithms of conversion from WGS-84 into LCS.

Sequence of conversions is shown below.

XYZ, WGS 84 L :
geocentric

XY&H, local

coordinate
system

BLH XY&H,
geode’tic cartographic
projection

1. Geocentric coordinate systems conversions done using Helmert transformation formula (Amendment 2
to RTCM STANDARD 10403.1): =

X7 dX X
Y| = |dy| +MxRx |y (1)
ZT dZ ZS

X, Yg, ZS) - geocentric WGS 84, (X1,YT, ZT) - reference geocentric (S -Source, T - Target);
dX, dY, dZ - translations in X,Y,Z;

M - scale factor. M = (1 +dS *10°9).

Values dS in a datum list are in a ppm (1ppm = 1%#10°9.

Rotation matrix: R = R, xR xR where

cosR, sinR, 0 cosR, 0 —sinR, 1 0 0
R, = |-sinR, cosR, O3k, = 0 1 0 [|:R =10 cosRy sinR5|,(2)
0 0 1 sinR, 0 cosR, 0 —sinR; cosR;

Ry Rj, R3 - angles between axes of source and target coordinate systems. Angles are calculated
anticlockwise.
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Inverse transformation formula:

Xg R_l XT dX
Y = 37 1 ve] —|ay|[ 4
Z Z; |dZ

Helmert conversion is a similarity transformation so scale factor is the same for each axes. A set of seven
transformation parameters and an ellipsoid is geodetic datum. In a datum list parameter signs of
translation correspond to transformation from WGS-84 to reference. Example: dX = +10 meters. Xg,r=

Xwas 4 + 10.

Transformation from geocentric to geodetic coordinate system (B - latitude, L - longitude, H - Height)
could be done:

tanL = Y/X

2 .
tanB = Z +e ><N><smB’(4)

X2+Y2 A/X2+Y2
_ XY

cosB

N - radius of curvature of prime vertical, e - eccentricity of ellipsoid.
Inverse transformation from geodetic to geocentric could be done using:
X = (N+ H) x cosB x cosL
Y = (N+ H) x cosB x sinL, (5)

Z = (N+H-¢e"xN)xsinB

where e - major semi-axes of ellipsoid

In order to determinate geodetic to grid coordinate transformation, we must specify type and parameters

of cartographic projection.
The distance along the normal to ellipsoid named geodetic height - H,,,y.

Geodetic height can be calculated according to the formula:

Hgeod = Hortho T & [6]
here H - geoid height undulation above the ellipsoid.

Geoid undulations are provided by a digital geoid models which are incorporated into JAVAD general
data base of coordinate transformations - GeoData.

Final step of conversions (number 4 on a figure), is a localization (calibration) based on computing of 7-
th parameters of a plane and a vertical conversion by least-squares procedure.

Plane transformation is given by formula similar to (1):
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cos(a — sina.)
sin oLcos o

N N
T = 9Ny pxRx| S , (7)
E; dE Eg
where R = {
Formula (7) could be written as:

Ny = dN+M x(Ngx coso—Egx sina)
E; = dE+Mx (Ngxsina + Egx cosa), (8)

dN, dE - translations along northing and easting axes.

Ng, Eq, Ny, Ep- (Northing and Easting) are plane coordinates. a - clockwise rotation angle. M - scale

factor.
-1
X - R _JXy _|dX
vo My |av
Vertical coordinate can be computed as
HT:HS+dH+ aNXNS+aEXES

Inverse plane transformation is

Hg Hr - heights in a source/target coordinate system, dH - height shifts, - angles with Northing and
Easting axes.

Plane and vertical transformation parameters are computed separately thus local datum is so-called 4+3
datum emphasizing the difference with a global 7-th parameters datum given by formula [1]. To calculate
four plane transformation parameters we need 2 points with postulated coordinates. In the meantime we
need 3 points to determine 3 parameters of vertical transformation.
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9.2. Getting LCS

Run localization procedure by clicking Localization option in a Tools item of Main program menu.
Localization procedure uses project Sites coordinates for computing so we recommend to process GNSS
data and adjust a network. Reference points can be used in localization as well.

Accuracy of localization procedure depends on inner adjustment errors, reference points consistency,
cartographic projection type and parameters reliability.

~F Justin - [japan2]

Project  Map  View -'Z\pplicaticn Help

= Register rasterimage
v || B4 F
Datum calculator
=g japan2 —
-5 07.11.2011 | Localization |

o 08.11.2011 Mizszicn planning

Time converter
MMEA 3

Precise Ephemeriz

Figure 105. Tools » Localization
Initially localization window offers four area to control a computing of local datum (Figure 106).
¢ Main menu - M;
¢ Tool bar - T;
 Settings panel - S;
* Input table - [;

7 Localization = = n
A

File Viewr  Paoints  Options il

a 2 = == - g

B +=%XEE 3E el 0L T
Network coordinates |BLH | Transformation | Grid 5 v| [Jadiust cM  Geoid  |Mone w | Confidence level | 99%.

€5 |None v
Metwork Reference Residuals
En‘..|Ty...‘ Mame Latitude,* Longitude, @ Morthing, meters Easting, meters Morthing, ...|Easting, ... [V
iy
|

Figure 106. Localization window
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9.3. Main menu

Items I File  ‘Wiew Points Options  were designed for import/export data into the table, viewing of local
systems parameters, templates management, table view structure controls.

File

The menu offers next option list:

File |wiew Paoints
4] Open

B save

[ save as..

lrnport

Export
Local Datum
Repaort

B oExit

Figure 107. File item menu

Open - open a localization project from a database.

oy war 04
- varQ3
- var 02

Cancel |

Figure 108. Open localization

Save - save (save as) completed localization

Figure 109. Save template

Import - open localization project from jcs (Justin coordinate system) format file.
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Export - save completed localization into jcs format (Figure 110):

-
o I,
Save in: 1 JCS @‘ lj’ =4 '
= MNarne Date modified Type Size
e 7] 2013-04-11 11.04.2013 14:50 JCS File
RecentPlaces [ 2013.04-30 20.04.2013 11:54 JCS File
-| 7] GK39-1min 18.04.2013 14:11 JCS File
— 7] GK38-1min-R 18.04.2013 14:11 JCS File
Desktop 7] GK39-10min 18.04.2013 14:10 JCS File
— 3] New 23.04.2013 16:07 JCS File
dﬁg | 3] Test 19.04.2013 11:36 JCS File
Libraries
i
Computer
@' « | m | 3
MNetwork
File name: MEW_LOC] - Save
Save as type: ’.JCS files (" jcs) "] [ Cancel ]

Figure 110. Localization Export

It's possible to store multiple localizations into a file (close localization window, switch to Project
properties and Coordinate systems tab). According to this while importing from *.jcs file with multiple
coordinate systems user should select appropriate localization from a list (Figure 111).

Figure 111. Coordinate system selection

Local datum - table view of datum parameters (Figure 112). There are all completed localization projects
in the list. If Apply last coordinate system checked (Main menu » Application » Options » Common)

then last project localizations will be copied also.

| Name N0, meters EO, meters R 5D

/0, meters

Inch IncE

-G032473.26%6 1341409343 0°00'00 2267 0,0000
-B032473, 7088 -365865, 1656 0°00'00,2535" 0,0000

# vG VG
wo i Bl Y BLH-y

<

-106,6240
-103,7360

- 000°00,0725" 0°00'00,3006"
- 000°00,0061" 0°00'00,0411"

Figure 112. Local Datum
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Report - publishing a document related to localization with an abstract, table of coordinates and statistics.

Project: Alaska

Program: Justin Reference Coordinate system: G-K-329
Version: Internal Units: meters
J Creator: : Height type: Elipsoidal
Agency: - MNetwork Coordinate system: WGS 84
\m\m“ Project: Alaska Units: degrees
Processed: 21.01.2014 14:48:21 Height type: Ellipsoidal
- Metwork Reference Residuals
Enable || Type | Nams Latitude,® Longituds.® Height, MNorthing, Easting, Height, Maorthing, Easting, Height, y
meters meters meters meters meters meters meters
N E
Yes 0 1516 56°10'34 245730" || 40°29/56 458345" 1566018 || 196784, 7730 || 227246 9860 | 46,7420 -0,0114 0,0018 0,0031 0,0120
N E:
Yes 0 2168 56°07'09.979511"|| 40°2155 812445" 1838241 (11902954070 219080 6280 || 73,9624 00111 0,0061 0,0026 0,0129

Figure 113. Report

Close - drop localization window.

View

Drop down options of View menu compound localization window (Figure 114),

Wiewe | Points  Optiot

Table
Parameters
Chart

Figure 114. View item menu
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Check Table, Parameters, Chart option to view Table (T), Parameters(P), Chart(C) panes (Figure 115).

File  View Points  Options

B +=%EE | & v|wl| 0 O
Metwork coordinates |BLH v | Transformation | Grid+Height v [adjustcy  Geoid v | Confidence level |99% v
€5 |GK-39 (BLH-xy) v
Hetwork Reference Residuals A RETEEETCES
En... ‘Tym‘ Mame Latitude,* Longitude,® Height, meters Morthing, meters ‘East\ng, meters Height, meters Nurthingj.‘.‘Eastmg it eliket
¥ 4 1516 N5E°1034,246730"  E 40°29'56,458845"  156,6018 196784, 7730 227246,9660 46,7420 0,0114  0,0018 -6032473,7088
1= 4 2168 NS6°0709,979511"  E40°2155,812445 183,824 190295, 4070 219080,6250 73,9624 0,011l 0,061 Easting offset
W 4 2191 N 56%10'22,021424" E 40°24'44,560990" 131,3807 196293, 2460 221879,5550 21,5036 0,007z -0,0080
&4 2810 N SE°DE'14,380160"  E 40°26007,479308"  113,2061 183679, 6640 223463,8840 13,3402 00052 0,033 ~IE5EES, 1656
3 |l :_ 9308 I 56%07'25,818161" E 40°20'31,599308" 151,289 190756, 6690 217616,2070 41,4294 -0,0108 -0,0058 Rotation angle
1= _ 3274 N56°0702,600667"  E40°3027,611030° 1654656 T 1902512770 227927,4280 55,6004 0,003  0,002%6 o000, 255"
e & 3913 I 56°10'26,505627" E 40°2320,767671" 184,0758 196402, 4400 220425,9350 74,2039 -0,0008 0,0017
|F O 4316 N56°1101,602219"  E40°26'56,778068"  185,3311 197567, 3030 224129,5760 74,2570 0,003 -0,00% Scale
E ¥ 4 4741 NSE°1031,675102"  E 40°19'55,475746"  186,9963 196492, 4220 216880,3480 77,1284 00003 0,0003 1,00001 0909367
Vertical parameters
v Narthing inclination
< >

- 0°00'00,0061"
Easting inclination P
0°00'00,0411"

wertical offset

-109,7960

Adjusted CM
E 39°00f00,0000"

Dist netwark - Dist reference, m

[vel
0,14 : - - - - : - 0,0008
1516 2168 2191 2810 9305 3274 3913 4316 4741 B
‘* 1516 - 2168 2191 - 2810 9305 - 3274 - 3913 - 4316 4?41'
0,0100

Figure 115. Localization window view

Points

Menu offers next options:

Points | Options

= Add
== Delete
N Clear

| Change XY *
L+ Import »

|EL  Export »

Create reference points
Figure 116. Points menu item

* Add - append a row to the table
* Delete - drop selected row
* Clear - drop all rows
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* Change XY - swapping data between Northing/Easting columns in Network or Reference panes.

| Change XY MNetwork
EL Import ' Reference
Figure 117. Change XY

* Import - import external source coordinate data: text files, Pinnacle software localization file
format, program and project reference points.

|E L Import T
L Export » Pirnacle
Create reference points Sites
lame |Latitude, Reference points
Figure 118. Import
* Export - upload coordinates as a text file or Pinnacle format file
|i£_ Export T*T
Create reference points Pinnacle
Figure 119. Export

* Create reference points - copy point into Justin program or project reference points database. Item
is enable if localization has been successfully completed.

r ~

«F Select group reference points =SREN X

+-{5 Program Reference Point
=-f= Project Reference Point

Figure 120. Reference points

Options

An item offers table view properties settings

CQptions
T Alignment
T, Alignment all

Default table wiew properties
Figure 121. Options menu item

* Alignment - set column width according to maximum cell size
* Alignment - set all column according to maximum cell size
* Default table view properties - restore initial settings
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9.4. Tool har

Tool bar icons offer quick access to the most frequently repeated procedure.

- open localization project
- save localization

- append a row to the table

—
- delete a selected row

%

- delete all rows

!
¥ - import coordinates into the table from a text file and Pinnacle format files
E2
- export coordinates from the table to text files and Pinnacle format files

- set column width according maximum cell size

fre

|

=K
e

- restore table view and data format by default

D - show/hide table

e - show/hide Parameters pane
- show/hide a Chart
- show/hide Sigmas columns
'L”j - reserved to requests
so

‘-f..:.-"J .
- run calculation
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Coordinate data table
A table (Figure 122) is intended for input data by import and editing and residuals output. Table columns
are joint in three blocks: Network, Reference, Residuals.

Network columns show coordinates from one of the project coordinate systems. As a rule they are
coordinates of sites calculated with adjustment under inner constraints. Reference columns show
coordinates of local plane coordinate system. Residuals show statistics

hletwiork Reference Residuals

Enable |Type | Name Latitude,* |L0ngitude,° ‘Height, meters Morthing, meters |Easting, meters | Height, meters Northing,..“Easting, | Height, ... |V
7 ; 1516 I 56°10'34,246730" E 40°29'56,458845" 156,6015 196754,7730 227246,9860 46,7420 -0,0114 0,0018 0,0031 00120
17 D] 2165 I 56°07'09,979511" E 40°21'55,812445" 183,58241 190295,4070 219080,6250 73,9624 0,0111 0,0061 0,0026 00129
W 2] 2191 N56°10722,021424"  E 40°24'44,550990" 131,36807 196293, 2460 221679,8350 21,3038 0,007z -0,0050  0,0072 00,0130

Figure 122, Goordinate data table
Enable — enable/disable row data in calculation

Type — assign type of site. Sites marked as [ can be used for plane datum calculation only; sites e
can be used for vertical datum only; sites  can be used for both datums calculation.

To switch between reference points type left-click on a cell in Type column.

™l | @ Plane
M | | @ Height

|l

=TT

Figure 123. Switching between reference points

Network coordinates could be geodetic (Latitude, Longitude, Height), geocentric (XYZ) or grid
(Northing, Easting, Height) types. Reference block coordinates are plane ones.

We use colors for data separation. Justin calculated coordinates (Network block) are shown above green
background. Residual fields are shown in red initially. So localization is a kind of adjustment then we run
tau-test for blunders detection. tau-test procedure compares residuals with a priori site accuracies. If Tau-
test failed for some sites then corresponded fields shown in red.

Disabled rows are light Grey. In this case residuals equal to zero and appropriated fields are left blank.

For editing data in the input area do left double click on the field. To save input press Enter or pressing
and holding left mouse button move cursor away from the field.
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Empty fields in Network columns do not estimated in datum calculation. Residuals valued as a zeros.
Empty fields in Height column affect how vertical datum will be calculated.

hietwork Reference Residuals ol
Enable |Typ ‘ Marne Latitude,® |Lang\tude,° |He|ghtJ meters Morthing, meters ‘East\ng, meters ‘ Height, meters Marthin ight, ... [V
W~ _L 1518 M 56°10'34,246730" 60,6018 196764,7730 227246,9860 46,7420 ] 0,0000 0,0000 0,0000
TF 4 2168 N 56°07'09,979511" Wa,sm 190295,4070 219080,6280 73,9624 00110 0, 0,0016 0,0124
: F 4 2191 MS6°1022,021424"  E 40°24'44,880990"  131,3607 196293,2460 221979,8550 21,5036 0,0053  -0,0070 0,083 0,0121
| =2 _:_ 2810 M 56°06'14,880160" E 40°26'07,479308" 113,2061 188679,6640 223463,8840 3,3402 0,003% 0,0015 -0,0037 0,006
W~ _L 305 M 56°07'25,818161" E 40°20'31,599308" 151,289 190756,6690 217616,2070 41,4294 -0,0104 -0,0057 0,0031 0,0123
E 12 ._ 3274 M 56°07102,600667"  E 40°30'27,611030" $190251,2770 2279274280 55,6004 0,0073  0,0007 0,0073
_ = & 3913 M 56°10'26,505627" E 40°23'20,767671" 184,0/58 196402,4400 220425,9350 74,2039 -0,0023 0,0030 -0,0085 0,0075
| =2 [a] 4316 M56°1101,692219" E 40°26'56, 778066" 185,331 197567,3030 224129,5760 74,2570 0,0003 -0,0011 0,0000 0,0011
w
£ >

Figure 124. Adjustment

9.5. Information pane

By clicking ¥/ make new information pane to appear right of the table view. It shows transformation
parameters as well as statistics of calculation. An example on the Figure 125 relates to localization of
coordinate system based on Transverse Mercator projection.

Plane parameters:

Northing offset - translation along Northing direction

Easting offset - translation along Easting direction

Rotation angle - clockwise rotation around plane perpendicular axe.

Scale - scale factor
Vertical parameters:

* Northing inclination - angle measured from Northing direction;
 Easting inclination - angle measured from Easting direction;
» Vertical offset - height translation

Projection parameters:

* Adjusted CM - Central Meridian of Transverse Mercator projection which deals lowest rout mean
square value.
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e Statistics: [V2] - sum of square residuals; RMS - rout mean square value

Plane parameters
Morthing offset

6032506, 0557

Easting offset

-359518,3365

Rotation angle
- 0°02'04,3224"
Scale

1,00001641 1421

Wertical parameters

Morthing inclination

- 0°00'00,0062"

Easting inclination

0°00'00,0411"

Wertical offset

-109,7947

Adjusted CM
E 39°02'30,0000"

[vz]

0,0006

RMS

10,0088

Figure 125. Plane parameters

Residual Chart

By clicking ' make to open a chart of residuals.

+ u u
1516 2168 2191 281 93 3719 Ho8

- 1516- 2166 2191- 281 93 - 3719- 4468'

Figure 126. Chart of residuals

Residual chart may be useful for removing blunders in input. We calculate distances between
corresponding points in a Network and Reference blocks and make a comparison. As a rule distances
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which are in same row of the table must be close each other. All blunders could be easily detected and
corrected with a chart.

9.6. Setting panel (pop-down menus)

A panel is intended for a table arrangement and for setup of a localization.f

Metwork coordinates |BLH  w | Transformation | Grid+Height w | [[Jadjustcm  Geoid w | Confidence level |99% w

T3 G-K-39 (BLH-xy) v

Figure 127. Panel

Network coordinates

Coordinates view setting affects how will be treated data imported into Network block of the table.

Metwork, coordinates |BLH =~ »

wNE
ELH
GRID

Figure 128. Network coordinates

Depending on the choice (XYZ - geocentric, BLH - geodetic, GRID - plane) it arranges table view and
patterns of input data (refer to item Import into the table).

Anyway Network coordinates setting affects how data will be represented in table only. As it was
mentioned above project database repository stores coordinates as WGS-84 coordinate systems. To deal
data in any others coordinate systems we use fully determined straightforward conversions from WGS-84
with known datum and cartographic projection. Instead of a Network data block data in Reference
coordinates columns of a table cannot be anyhow recalculated without localization as a local datum is
primarily unknown.

To specify input reference data type select from a list user defined coordinate system with a special datum
type - None.

5 a2 W
More L
T

Morthing, meters |Easting, meters

Figure 129. User defines coordinate system

None item is an unique special coordinate system intended for first time localization in the case of
unknown cartographic projection.
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Follow Application in main program menu, then click Projection option. Coordinate system category is a
Projection properties dialog window must be user defined. Datum is specified as None.

4 Projection properties n
Coordinate system category | UserDefined | Wisible A Mame airz2
_|Universal Polar Stereographic - I~
_|US State Plane Coardinate Systems (1927 r Il Projection | Transwerse Mercatar ar Gauss-kruger ]
1US State Plane Coordinate Systems (1953, feet) - I~
" |us state Plane Coordinate Systems (1983, meters) Il I~ Catinn HIRIE ¥l
k|Uiser defined v I~ Units milks >
_|UTH (Corrego Alegre) - I~
umEpsg [ M Original latitude 02" 0% 0000000 3
D) et 0L b L) O o hd Original longitude ozl" 0% 0000000 2
Coordinate system | UserDefined | Wisible | =
Yarz i = Scale Fackor 1,0000000
o False easting 500000 | m
Figure 130. Projection properties
Transformation

This is a control for localization parameters calculation:
Grid - 4 plane parameters;

Height - 3 vertical parameters;

Grid+Height - full set of 7 (4+3) parameters.

Shifts only - 2 plane and 1 vertical translations. All rotations equal zero, scale equals 1.

Transformation | Grid W
Height
Grid+Heighk
Shifts only

Figure 131. Transformation

Adjust CM
The check box runs iteration process for projection central meridian fitting (if central meridian exists).
[ ] Adjust Cm
Figure 132. Adjust CM

We are searching for central meridian value that minimizes sum of squares of residuals. Searching range
is 6 degrees zone around network middle point. Step of iteration along longitude equals 10".

Sum of squares of residuals is shown in column [V2] Figure 123 on page 95.

Geoid menu offers a choice from a list of geoids from a folder c:\ProgramData\JAVAD GNSS\GeoData.
To add a geoid to a list follow: Application » Options » Geoid.
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If one of geoids was selected than all heights in Network block will be corrected for geoid undulations
according to [6] on page 86.

Geoid | Mone b

gz01Zau_south.bin
ne g201Zau_south.grd
Add geoid

Figure 133. Geoid selection

There is a warning for points which are outside of selected geoid boundary (Figure 134).

o Justin Iﬁ

Insufficient data to calculate vertical parameters

Figure 134. Warning

Confidence level
Confidence value used for calculation threshold in blunders detection procedure during t-test.

Confidence level

Figure 135. Confidence level

Value equals 95% corresponds to more narrow interval. It is more strict criterium than 99%

CS Reference

CS (Coordinate Systems) option offers a choice from a list of user defined coordinate systems

oid v | Confider eIz ¥

Mare

(3K-39 (WiE554 ko Local
G a2 v
Gk3e

Reference

Marthing, meters |Easting, mekers

Figure 136. User defined coordinate system

An accuracy of calculation depends on network and reference coordinates as well as on reliable type of
cartographic projection. Localization module does not calculate projection parameters except fitting of
central meridian for Transverse Mercator projection.

If reference cartographic projection is unknown than select None. In this case Oblique stereographic
projection will be applied. Scale factor equals 1, central points is center of minimum boundary rectangle
unclosed network.
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GS Network

As a rule Network data are results of network adjustment. (all Sites are in WGS-84 in Justin project
database). Main localization goal is a snapping of free network to control ground points (reference).

Meantime, cartographic projection have to be specified if data were imported from external sources as a
grid (LCS) from text format file.

Metwork coordinates |GRID W | Transformation | Grid

S

GK Zone 7 (5K 42)
Gk Zone 7 (
Mercatar

-\Lambert Azimuthal Equal-Are:
Enable |Tv|:e | Hame MarkhiLambert Azimuthal Equal-Are: |5

(WG58 b v
554 LFs

Figure 137. Network coordinates
otherwise a warning appears

Network coordinates | GRID v | Transformation | Grid v

c5 v c3

Metwork

Enable |Type | Mame Morthing, meters Easting, meters Mo
1516
2168
2191
2810
Q305
3274
3913

1<1/<1 =&l = =R
“‘EEEEEEE

Figure 138. Warning

A sequence of coordinate transformations for network data in grid is:

S BLH, WGS XYZ,WGS XYZ, ref BLH, ref Grid,
Grid : : ; i
geodetic geocentric geocentric geodetic reference

Figure 139. A sequence of coordinate transformations for network data in grid

We check reliability of conversion (step 1 on Figure 139) doing inverse calculation from geodetic to grid.
If parameters of cartographic projection are not convenient for imported data (not correct zone, scale,
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central meridian) vice versa calculations get too big residuals (>0.01 meters) in initial Grid data and a
warning appears.

Metwark, Reference
arthing, meters Easting, meters Morthing, meters Easting, meters
126609,6075 S93060,5920 196764.7730 227246,9860
20212.87 v Justin
12620825
18597.801  yice versa coordinate transformation can not be calculated correctly
120673.96
120168, 78
12631741
127481.75

Figure 140. Warning

9.7. Import coordinates

Use Points » Import options in a main Localization window to load data into the table.

File Wiew | Points | Options

) || A 2 v] ml O
== Delete =
»N  Clear
Network coordif Change X¥ p d v [
|E + lrmport TXT |
Pl Export 4 Pinnacle |
Create reference points Sites
Enable |Type | Mame [Marthing, meters Reference paints thir
Il __f_ 1516 BZ226699, 6075 SEEUE0SHA0 196 75
Figure 141. Loading data

Sites and Reference points items load data from running project. Otherwise click on a toolbar i ,!,
button intended for import external text data.

Import external free format data

Free format text data could be loaded separately in Network and Reference blocks with a templates. A
template appears automatically since text file has been opened. Items in a Value column have predefined
style settings accessible via pop-down menu.
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Below, there are examples for network data input as well as for reference ones.

Template Fields

Fields

Column I Walue
_| 1 Paoint name
_| 2 Local northing
_| 3 Local easting
_| 4 Local height
1d 5 Empty]|

Paint narne
Morkhing

Local northing
Local easting

Figure 142. Import external free format data

Template Fields

General Description
Localization

z

Column

Yalue

]

Colurnn

Yalue

1 |Paint name
2 Morthing
3 Easting

4 Height

3

1 |Paint name
2 Local northing
3 Local easting
4 Local height

g Add | | $¢ Delete ||

o Add

$¢ Delete |

| g Add | | $¢ Delete ||

o Add

| | $¢ Delete |

Decimal Separatar

I:I []1gnor blank

Decimal Separator

l:l [1gnor blank

Separatar

I:I Space

[71ab

Separator

l:l Space

[71ab

| | Cancel

|| Wisual Import |

www.javad.com

| | Cancel

|| Wisual Import |

Figure 143. txt data template
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Import Pinnacle format data

Select Pinnacle item (see Figure 144). Files of type are Pinnacle format (*.text). Click file name to load.

Laok in: | . Localization

(I= [ 1_MCK-33 - geo - netutat
b [ 1_MCK-32 - grid - netb
Recent places @‘I_MCK—BE - grid - refitxt

Desktop

Libraries

Computer

File harme: |

Files of type: | Pinnacle Format [*.kst)

Figure 144. Loading data in Pinnacle format

Import sites from a project

Click Sites item. Check Sites to import as Network data in a dialog Select Sites (Figure 145).

=V sites

Figure 145. Import of sites
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Import reference points

Click Reference points item (see Figure 146). It offers to check items from program data base as well as
from a project. Check items which should be imported as Network data.

== Program Referance Point

- =L brin

& !

- =L il

E|-- Project Reference Point
BEB California

EL;_ rnins Minarek_Surnrit

Figure 146. Import of reference points

Examples

One of most frequent asked question about a localization is related to dimension of area where accuracy
of local datum “4+3” coordinates transformations will be compatible with calculations using global
datums. Below we figured out two examples of localization.

We consider Transverse Mercator projection case (Figure 147). In first example (I) localization band
overlaps 6 degrees zone and comes out of zone boundary 1° more. In second case (II) 3° band comes from
centers of zone to a boundary under direction 45°. In both cases zone width equals 2'.
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We use four points at the corner of the band as a reference in grid. Coordinates were calculated with a
global datum.

N
(.
L3
n
1
r
a
1
M
. 53°02'
: 53°00'
/ d
/ i
a
/ n
f \
rf ' L 50002
f T 50°00"

1

.“ u

| |

|I ||

Equator 2
30° 36° E
33

Figure 147. Transverse Mercator projection
In localization we ignored global datum parameters and got WGS-84 zero datum.

Assume that cartographic projection type and zone were known. Central meridian value was one of a goal
of localization.

Tables at Figure 148 show residuals of localization for both cases. Resume that we could neglect very
small residuals in a surveying and in a lot of geodetic applications.

So to reach a high accuracy we should know only type of cartographic projection of LCS.

MNetwork Reference Residuals
Enable |T\,f|3 | Mame |Latitude,® |Longi1J.|u:Ie,° Maorthing, meters |Easﬁng, meters Marthing. .. |Easting...|1a'
v 4:__ 1 M 50°02'00,000000" E 30°00'00.000000° 5543931.8946 285195,0738 0.0004 0.0003 0.0005
F :_ 2 M 50%02'00.000000% E 37°00'00.000000% 5552337.0813 786062.0578 0.0001 0.0003 0.0003
v :__ 3 M 50°00'00,000000% E 37°00'00.000000°  5548630,9930 786860,6143 -0,0001 -0.0003  0.0003
4 F ;L_ 4 M 50%00'00,.000000% E 30°00°00.000000% 5545275,1214 285045,2101 -0.0004 -0.0003  0,0005
Metwaork Reference Residuals
Enable |Ty'|:| | Mame |Latitude,® Longitude, ® Morthing, meters Easting, meters Morthing... |Easﬁng...|'u'
F 4:_ 1 M 50°02'00.000000% E 33°00'00.000000°  5544666.7306 500117.1110 0.0001 -0.0001 | 0.0001
v i 2 N 53°02'00.000000° E 36°00'00.000000% 5882652,9202 701350.3735 -0,0003 -0,0003  0.0004
F :_ 3 M 53°00'00.000000% E 36°00'00.000000°  5373944.7537 701505.5947 0.0003 0.0003 0.0004
LA i 4 N 50%00'00,000000% E 33%00'00.000000°  5540953,0735 : 0.0001 0.0001

Figure 148. Residuals of localization
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In the case when the type and parameters of projection are known and a global datum was not determined
a localization may be applied to create new coordinate system based on reference points. A discrepancies
of reference point positions will overpass in localization by least square procedure in adjustment with
fixed constraints and similar transformation.

We put tables on Figure for comparison results of coordinates transformations with Justin coordinate
calculator based on 7 parameters global datum and two local datum (according case shown on
Figure 147).

Central points of above mentioned zone was used as example. Maximum variance does not exceed 0.005
meters in the second case (slant zone).

Finally we pay attention how localization can value unknown central meridian of projection. We ran a
procedure to calculate it in iteration. Reliable estimation of searching is RMS (root mean square) of
residuals (Figure 149).

Flane parameters

Network Reference Residuals -
Enable |Type | Name |Latitude,® Longitude,* Morthing, meters Easting, meters Morthing... |Easting...|\-' e
M | A 1 NS50°02'00.000000° E 33°00°00.000000° 55457426627 392643, 4344 0.0000  0.0000  0.0000 0.0000
1= __ 2 N50°0200.000000° E 36°00'00.000000° 55457416708 607583.2928 0.0000  0.0000  0.0000 Easting offset
| ¥ | 4 | 3 NS0%DU0D.0000007 E 36°0000.000000° 5542034.2347 6076576636 0.0000  0.0000 | 0.0000 || e
A 4 NS50°00'00.000000° E 33°00'00.000000° 5542035.2271 392574,0794 0.0000  0.0000 0.0000 |F :

Rotation angle
0°00'00.0000"

Scale

e
i 0]
= 1.000000000000
[T
E
o 0
% g Adjusted CM
(=1
Ak E 34°30'00,0000"
o
£ : [v2]
Sig] ,
g H 0.0000
- :
1 2 3 4 ErE
-1-2 3-4
EEEEEEED 01500

Figure 149. Reliable estimation of searching is RMS of residuals

We defined in Justin coordinate transformation on a some non zero global datum and Transverse
Mercator projection with central meridian equals 34°30'05". Localization data were calculated on the
base of the transformation for an area corresponded case II.

In a localization procedure we set WGS-84 datum and Transverse Mercator projection. We make central
meridian calculation.
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Results are on Figure 150. Iteration step equals 10" so estimated value has 5 mm difference with
postulated value. In the meantime coordinates calculation yields accuracy above 0.0001 m.

BLH Grid
Latitude N 50°01'00.000000% Northing 5542810,0673 o
¥
Longitude E 34°30'00,0000007 Easting 500115.8762 meters
Height 0.0000| meters * Height -16.0032 meters
WGS 84 - sk 42 (n(krasS) /3 -
: [ 52 |
+F Coordinate calculator - |
BLH Local
Latitude N 50°01'00.000000" Northing 5542810.0673 T
|
Longitude E 34°30'00.0000007 Easting 500115.8762 meters
Height 0.0000 meters « Height -16.0032 meters
WGS 84 - E =
Figure 150. Results

Recommendations for applying:

* Adjustment with fixed constraints corrupts good results of GNSS network inner adjustment due to
dependency from reference points. Localization may to scatter initial points irregularity and bring
a results which meet project accuracy requirements.

¢ If adjustment in 2D/3D mode detects discrepancy in plane and vertical components of solutions it
might has sense to switch from Helmert 7 parameters datum to local (4+3) one.

* Global datum of local coordinate system is unknown and cartographic projection determined.

* Reference points are determined as unknown grid. We can try Transverse Mercator with central
meridian fitting or Oblique Stereographic projection for data approximation

* No quite good geoid model.

Above mentioned recommendations are valuable in combination with network adjustment under fixed
constraints. In the meantime datum parameters could be used in other applications if coordinate
transformations are required.
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10. Datum calculator

To calculate the datum in Justin perform the following:

Click Tools » Datum calculator.

«F Justin - [1]
Project Map View |[Tools | Application Windows

i &= Register raster image

£ \l ..-\l * v(_l L i .

Datumn calculator |

B‘_,_] 1
-5 16.02.2011

Localization

Figure 151. Datum calculator

In the Datum calculator window enter the calculated points coordinates to the Network columns, and
reference points coordinates. See the full description of the toolbar icons in the “Localization” on page
85.
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FTE T
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4000004052

Figure 152. Data table
Define the geoid model if you use the orthometric heights. Check Shift, Rotate, and Scale boxes
to set unknown parameters to compute.

To start calculations click {:; . In the Residuals columns will appear the point residual components and
rms value. In the Datum parameters pane, will be shown the calculated parameters.
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11. Reference points

Without reference points the coordinate transformations have formal sense. Adding reference points in
the project is performed in two steps. The reference point have to be entered in a program database first.
Then using the Project properties dialog the reference points are copied to a project. In fact, the reference
point defines the coordinate system itself.

11.1. Adding reference points to the program database

To add the reference points to the program database, perform the following:

1. Left click the reference points button A\ or click Options » Reference points:

Options | Help

:\ Application

. Projection \
Datumn

_‘l Reference points '

Antenna list

Figure 153. Reference points

2. In the Reference points window activate the Reference List tab and highlight Reference points,
then right-click and call the menu. Select Add group.

[ Reference points i ) S
Reference List Coordinate systems Point name
BEH] R =ference ppie] |
“y* Add group | 3 Add group [éj
L Import
Enter group name:
L4 Export

I oK | [ Cancel

Sigma E 0.0000
Sigma M 0.0000  Type -

Sigma U 0.0000

Tpomt| Add point Delete point

| oK ‘ I Cancel |

Figure 154. Add group
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3. Enter the group name.

Groups are used to simplify the search and copy of the reference points according any criterion:
area, coordinate system, etc.

3 Reference points

E Reference List  Coordinate systems

Reference points

Figure 155. Group name

4. Select the group name and right-click to highlight it, them activate Coordinate System tab and
select the needed coordinate system for the point. On the right pane appears the dialog box for the
selected coordinate system:

'n Reference points l":' |E| g‘

Reference List 1 Coordinate systems Point name

Grid

Harthing 12 423 187.2366 meters

Easting 500 000,0000  meters

2 Height 78137.0000 meters
WGS 84/ UTM zone 1M

:WGS 34(WGS84) / Oblique stereographic

Sigma E 0.0000
Sigma N 0.0000  Type -
Sigma U 0.0000

Delete po

Figure 156. Select coordinate system
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5. Click Edit point and enter point name, coordinates. Select the point type: plane, height, plane and

height, enter coordinates sigmas if needed and click Add point. The point will be added to the
group, and its coordinates will be added to the program database.

1 Reference points

Reference List 1 Coordinate systems Pointname  T1

e

| Grid

Northing 12 423 187.2366 meters
Russia PZ90{PZ90)

=t WGS 84(WGS84) / Oblique steree| | F35tN9 H0000,0000. REb
i 'I._: e oa Height 78137.0000 meters
“-ams WGS 84 (UTM zone 1N

:WGS 34(WGS84) / Oblique stereographic

Sigma E 0.0000
Sigma M 0.0000  Type
Sigma U 0.0000 Plane
Height
TG e I = Apply changes | Add point ] I Cancel
[ oK ‘ I Cancel l

Figure 157. Edit coordinate system of the point
6. Repeat steps above to add more points. The list of these points will be displayed in the group:

3 Reference points

Reference List  Coordinate systems

Figure 158. Group of the reference points
You can sort data in a list by right clicking upper item.

Depending on the type of referencing, all points will be marked with the following symbols:

-u- - plane and height fixed;
B- plane fixed;
® _ height fixed.
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To manage the group of points use the right-click menu. The group can be renamed, deletes, the new
points (*.jst,*.csv, *.txt (see “Import files to the project” on page 49 for the detailed format description)
can be imported to the group; one or more points can be exported to the *.jst file.

i B
3 Reference points E@ﬁ
-
3 Reference points
(- Reference paints
Reference List  Coordinate systems =5 IREf_PDiniE

[ El-4.,] Reference paints |

T1 Rename
-~ T2 & Delete group
...... e i ; Import

[EL Export

o ][ o=

Figure 159. Right-click menu

The menu can be called by right-click on the point in the list. All operations will be applied to the selected
point.

To rename the point and edit its coordinates and type, select the point in the group and on the right-click
the Edit point button. Refresh the information by clicking appropriate button.

To delete the point, select it and click Delete point.
To save all changes click OK button in the Reference points window, otherwise all changes will be lost.

To move point into another group (if there are two and more groups), select the point and drag it:

-

3 Reference paints [0 Reference points [ Reference points

Reference List Coordinate systems Reference List Coordinate systems Reference List Coordinate systems

[El-y,| Reference paints

{f} 123

[El-y,| Reference paints

& 123

- @ Rass
&) Ref_Paints

Lk T1
T2
T3

Figure 160. Drag and drop the point

The point will be removed from the initial group.
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11.2. Copying the reference points to project database

To copy reference points to the project database, perform the following:

1. Click the | to create new project, or « | to work with current project. Alternatively click Proj-

ect » Properties:

3 Justin Link - [1]

Open

Close

Project | Map VWiew Tools Options  Winc
| Mew

' Properties

Figure 161. Project » Properties

ta= Importfiles

2. Click Reference points button, select the group name and click i-r , to copy it from the program
to the project. The selected object will be copied to the project and 1ts name appears in on the right

in the Project folder.

3 Project properties

(o

General || Reference points  Coordinate systems| Time |

=l | Available

43

=\, | Project
=) Ref_Points
-4 T1

~E T2
9 T3

Figure 162. Adding referents

This operation is available for copying the reference points from program database, and vise versa from a

project to the program database.

The reference points from the project can be copied to the program data base (Available), by clicking

Alternatively, drag the object on the left and drop it on the right. The object will be copied.
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For the objects in the left part of the window the following menu items are available: Add group, Import
(of the point(s) in .jst, *.csv, *.txt formats or of the group), Rename, Delete group:

-
1 Project properties

-

=

I Project properties

1 Project properties

General | Reference points  Coordinate sys

General | Reference points  Coordinate sy

General || Reference points  Coordinate sys

= || [T amiae | | [&- Availabl
o3| T Add group I—_J%BEJE | Ja\'a';:
1 .
ar [ Import Rename a E‘
RaEs Q *  Delete group : a’&fRas * Delete
- R [I Ref_Poir 1
]a..e [L Import L Import

Figure 163. Right-click menu

For the objects on the right are available: Import (of the point(s) in .jst , *.csv, *.txt formats or of the

group), Delete group, Delete (point):

(- == S
5= ="
J [_:|.--:1J Project | =- J Project
R Jrct oo B Ref Points
- P& Delete group - F'
...... il mport 'El T Delete
e T @ TEL Import

Figure 164. Right-click menu

To save all changes click OK button in the Project properties window, otherwise all changes will be lost.

11.3. Snapping Site to reference point

To snap a Site to a reference point (or to enter coordinates manually) select the needed Site in
cartographic window and click right button. Click Snap fo... menu item

., ety S | TREE

|@‘ Yellow Stone 90 \ Properties
A Yellow Stone 90 - Point_1 (1) 4 Rename
A Yellow Stone 90 - Point_3 (1) 4 |@ S
A Yellow Stone 90 - Base (1) 4 B8 7oom to...
I #  Yellow Stone 90 - Base 4 BN Mk rderence
#  Vellow Stone 90 - Point_3 4 i
#  Yellow Stone 90 - Point 1 »|®l Report ’
C, 4) VYellowStoned0  *

T

Figure 165. Snapping point to a reference point

In the Reference points window select the reference point the point will be snapped to and click Snap to...
(Figure 166).
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To correct the Site position on the map the manual entering of coordinates may be useful. The Sites
snapped such way won’t be considered as reference.

By choosing RINEX coordinates option the Site gets the coordinates from the RINEX-file header, if there
is associated recordset, created by the import file in the RINEX format.

-

F [Yellow Stone 90] snaped to [None] =nay X

=S| Rleference points

P 4, MOBN(SOPAC) (36 653.83 m)

L ZWE2(SOPAC) (49 284.06 m)
4 MDVI(SOPAC) (32 115.21m)

y

i & Manual input coordinates

‘. & RIMEX coordinates (1.71m)

XYz BLH Grid

X, m 2850417.5491 meters
¥,m 2189233.9920 meters
Zm 5251604.9703 meters

WGS 84

Free | Snap to... H Cancel ‘

Figure 166. Point snapping information

12. Goordinate systems

Starting Justin version up 2.x.X.x, free application Coordinate System Editor data base GeoData should
be used to create new coordinate systems. The application was designed to provide maximal
compatibility of office and filed JAVAD GNSS softwares.

12.1. Creating new coordinate system

Justin internal coordinate module is mostly intended to keep the compatibility with version 1.x. It may be
useful to users who are accustomed to a previous interface. Created with this module coordinate system
can not be added to the GeoData, but they can be exported to the exchange format * .jcs, compatible with
other office and field JAVAD software.

To add new coordinate system to the data base, first click Options » Projection.

In the Projection properties window select the User defined row in top left part. When the Add button is
active than the new system can be added.
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Specify the name of coordinate system, projection type, datum, units, and projection parameters. Click
Add. The new created coordinate system will appear in Coordinate system list.

-

5
«7 Projection properties Lﬁ
Coordinate system category ] UserDefined ] Visible + | Mame GK-39
|User defined 4 I |
_|GaussKruger (5K 42) | ol Projection |Transverse Mercator or Gauss-Kruger - |
| Helenic Coordinate Systems | ol
| Hong Kong Coordinate Systems | ol et IWGS i X ] EI
_|Hungarian systems O [ Units [kometers -
] Icelandic Coordinate Systems | ol
_|India - Polyconic systems [ ol Original latitude @ : Dﬂn Dii I D.DDDDDDQH
American Polyconic Systems | 4 - : ; w
Original longitude ©E 33" 0% 0.000000 3]
1 Coordinate system | UserDefined ] Visible ] B
; Scale factor 1.0000000
MicK-39 I v
................................... 3 i
igp Addtolist False easting 500000 m
False northing 0 m
[ Add l | Delete | [ Apply changes
Close |

Figure 167. Adding user defined coordinate system

To delete user defined coordinate system, select it in the list and click Delete.

To create new coordinate system based on any existing, select the coordinate system in the list, on the
right will be shown its parameters which can be edited. Click Apply changes to save the changes.

Add to list option allows adding created coordinate systems to the Favorites.

12.2. Selecting project coordinate system

Click Project properties » Coordinate system. Initially the list of coordinate systems in the project is
empty. To add the items to the list, use the folder Favorites. Folder Favorites could be empty too if you

run Justin for the first time.

To add the coordinate systems to the Favorites list, perform the following:

1. Click Options ¥ Application:

Options | Windows
?'_e\_ Application H

Projection

Help

i
i

Datum |

¥
A

L. Reference points

Antenna list

Figure 168. Options » Application
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2. In the Options window select Coordinate system tab. On the left there is coordinate systems tree.
Global node is for worldwide coordinate systems; otherwise it is Regional, User node contains the
customer’s coordinate systems; Favorites node is for transferring coordinate systems to a project).

The coordinate system icon shows coordinate system type:

. b Geocentric

® Geodetic

i Cartesian plane
#* Local

$ Height

9! Geoid

On the right there is an information related to selected coordinate system. Switch to orthometric in Height
field to apply a geoid. Join plane coordinate system with vertical datum from the list of systems.

r 1
 Options @
Commen | Import || Coordinate system  Geoid | Units | Report | Antennas |
[l-57] Coordinate Systems » | | Datum
=L | Global WES 84
. m-[] wess4 .
P ti
Com-[]wes T2 diloanit
[}..J WES TIBE LITM zone 37
@[ TRF Height
[}"_¢J PZ-50 Orthometric height -
i - $ mean sea level height | = -
. [-$ EGMI8 geoid g st siston
£ = t EGM2008 geoid
L] Regional Geoid
[ Ll | Antarctica EGM2008 Africa 3-30M 167W-150
T 2
Ly SUL,”h fneic Transformations
-, | Africa
-0y Asa |EcM2008 geoid { UTM zone & ~ |
[ L, | Europe
(- Ll | North America
:i LJ : Add to Favorites
(- [, | Oceania -
’ oK ] ’ Cancel ]

Figure 169. Coordinate system options

Click Add, and the coordinate system will be added to the Favorites. Repeat this with all systems you
would like to add to the Favorites, then click OK.
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Using right-click menu, the folders can be added or deleted from the Favorites. The coordinate systems
can be removed from the folder, imported to the Justin Coordinate Systems format (*,jcs) and exported to
* jes. Info data pane could be hidden to free room for Coordinate System name inspecting:

r B
«7 Options M
Common | Import || Coordinate system Geoid | Units | Report | Antennas |
Elazl Coordinate Systems Datum
EI‘_,_] Global WGS 84
"“-] st Praojection
[, wes 72 4
\_._] WGES 72BE LM zone 37N
L] ITRF Height
‘_é_] PZ-50 Orthometric heig
mean sea level height
Height Syste
4 EGMIs geoid S SV
-4 EGM2008 geoid EGM2008 geoid
D'"\_._] Regional Geoid
=i fmites EGM2008 Africa 3-3C
--au% WGS 84 [ UTM zone 37N z
] WGS 84 WGS 84 / UTM zone
FHWGS 84 | UTM zone 37N / EGM2008 geoid
Add to Favorites

Figure 170. Add to Favorites

When the Favorites list is complete, click v | or Project » Project properties. In the Project properties
window click Coordinate systems tab.

Select the coordinate system in the Favorites folder and drag it to the Project folder. Repeat this operation
to add more coordinate systems..

«F Project properties ﬁ
General | Scenario | Reference points | Coordinate systems Time
Satelites | Print | Report | Internet Data |
- || Favorites Datum

_J Project WGS 84

-~ wes a4

Projection

LM zone 37N
Height
Orthometric height

Height System

EGM2008 geoid

Geoid

EGM2008 Africa 3-30°N 16°W-1!
Transformations

WGES 84 [ UTM zone 37 f EGM

o [ o]

Figure 171. Selecting coordinate system
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To switch between project coordinate systems, right-click on the control with the list of available
coordinate systems and select the needed one. The coordinates in the left bottom program corner are
matching active coordinate system.

Latitude: N 52°3402,045015" Longitude: E 33°01'52.282145" | | @ _

f 1.+ WGS584
15 SK42 (1)(KRASS) / P-2
“55 WGS84 / UTM zone 37N / EGM2008 geoid

The detailed information about coordinate system can be shown using Show parameters option:

«F Info --- SK 42 (1)(KRASS) / P-2 [ =|-E &J

WES 84 @ 5K 42 [1)KRASS) / P-2

Position Wector 7-param. Transformation | Transverse Mercatar

¥-awiz translation, meters
26.3000

“r-awiz translation, meters
-132.6000

Z-awiz translation, meters
-76.3000

¥-awis 1okation
- 0°00°00.2200"

“r-awis 1okation
- 0°00°00.4000"

Z-awis 1otation
- 0°00°00.9000"

Scale difference
-1.2000000004786E-7

Semi-major axiz for source coordinate spstem
E375245

Flattening for source coordinate system
0.00335232986925913

Greenwich longitude of prime meridian for source coordinate syste
a

Semi-major axiz for target coordinate spstem
E378137

Flattening for target coordinate system
0.00335281066474748

Greenwich longitude of prime meridian for target coordinate syster
a

fanward
false

%

Figure 172. Detail coordinate system info
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13. Datum

If you need to use a datum that isn’t in the list of predefined datums, you can create a new one. To create
a new datum, do the following steps:

From the Options menu, click Datum, it opens the Datum properties dialog window.

3 Datum properties ﬁ
Datumhame | UserDefined | visble |« | MName Antigua Island Astro 1943
| Adindan O V 3
Afgooye - ~ ~ RotateX 0.000000 "
AGD 84 O V
— Rotate ¥ 0.000000 "
" |acoss 0 77 oate
_|ain el Abd 1370 O W Rotate Z 0.000000 "
_|American Samoa O V
_|Anna 1 Astro 1965 O ~ shift X - 270.0000 m
P2 r ~ :
T r = shift Y 13.0000 m
_|arc 1950 O 2 shift 2 62.0000 m
_|Ascension Island 1958 r 3
_|Astro B4 Sorol Atoll O 2 Scale adjust 0.000000 ppm
_|Astro BeaconE O V
_|Astro DOS 71/4 r ¥ Elipsoid | Clarke 1880 v) )
_|Astronomic Station 1952 O 3 = s
_|ATs77 Elipsoid r ¥ = Add new |

Figure 173. Datum properties

In the Name field, type a name for the new datum. Specify the rotation, shift, and scale adjust parameters
in the corresponding fields. Click the Add new button. The new datum appears in the DatumName column
as UserDefined. User defined datum can be deleted. Standard datums cannot be deleted from the list, the
Delete and Apply changes buttons are inactive.

To edit the datum, click Apply changes after changes were made. Enable/disable flag in the Visible
column to show/hide the datums in the Projection properties window.

All datum parameters are shown in the appropriate fields on the right after it is selected on the left.

To open the ellipsoid table, click ...| next to Ellipsoid field. In the Ellipsoid properties window the
selected ellipsoid parameters will be shown.
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The ellipsoids cannot be edited. To add an ellipsoid to the list, contact JAVAD GNSS support.
( D3 Ellipsoid properties &1

Ellipsoid ]Userdeﬁnedl » | Name Clarke 1880

z Clarke 1880
Clarke 1880 modified
" |penish
_|Everest
_|Everest (India 1956)
_ [Everest (Malaysia 1969)
Everest (Pakistan)
: Everest (Sabah Sarawak)
| Fischer 1960 (Mercury)
o Fischer 1968
GRS 67
GRS 80
_|Helmert 1906
Hough
IAG 75
_|indonesian National 1974
_|international

Spha 6378 249,145

SphF 293,465

m

OO0nOOoanooonoooo

Figure 174. Ellipsoid properties

14. Antennas

14.1. Antenna properties

To add a new antenna to the antenna database, click Options » Antenna list.

-
7 Antenna proprties
A
Model | Alias | User defined | Visible | Manufacturer + | Model JAV_TRIUMPH-1R. |
JPLD/M_RA_SOP NONE JPLD/M_RA_SOP [m] [cd Allen Osborne I : - -
— : Alias Triumph1 w radio
_|asH700829.3 Geodetic ITI (USCG) ] ~ Ashtech
_|ASH7O00936E  SNOW D/M(E) el. +Radome Il I~ Ashtech Comment Triumph 1 Internal with radio antenna
_| ASH700699.L1 MNOMNE ASH700699.L1 [l = Ashtech
_|asH7o0s3eF_c  none ASH700936F_C O vl Ashtech
_|asto194sc M pran ASH701945C_M w Pl O v Ashtech
_|ast701946.3  snow DM element,REV. 3 [m] M Ashtech
i 35-02-TSADM  NOME T5A-100 with Dorne [l = 3SMAVIGATION Masifaitiner JAVAD GNSS i
35 = il | ~ 3SNAVIGATION
AV TR Triumph1 w radio m > I~ JAVAD GNSS Reais. o P |
[ Siednt 7 ~ JAVAD GNSS El
_|3av_svranT GyrAnt O ~ JAVAD GNSS Absolute calibration
_|aav_TvRanT Tyrant O vl JAVAD GNSS B - b
~|raveismore GISMore O ¥ JAVAD GNSS o o
INSAVANT Avant O I NS Vertical corr (Ci) 38.25 43.05
_|smaranT L1 MarAntL1 O ~ NS e g SR
_|nsmaranT_L1_cone MarAnt L1+radome [m] ~ NS
_|nsmaranT_pLus MarAnt+ | ¥ ms Northing 0.58 -3.38
Easting 0.03 -0.69
Add Delete
’ Phase center variations ] ’ Diagram |~
[ Fur | P | i

Figure 175. Antenna properties table
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In the Antenna properties window the information about the antennas is presented. Select the antenna
from the list and its specification will be shown on the right.

To add new antenna to the list, enter the antenna name to the Model field. Then click Add and add
antenna properties. New added antenna is marked in the list as user defined.

To delete user defined antenna from the list, select the antenna and click Delete. To update antenna
parameters (except name), click Update. The check mark Visible makes antenna visible/invisible in the
antenna list in the Recordset property window. You can sort data in a table by right clicking field title.

Click Diagram, to see the antenna graph with description of the parameters, which should be entered for
new antenna:

Antenna Radius :
Phase « i
Center " =
0 i T
& ‘ D\SHMP |
|J——4 ! — /
) [ il
8 = J _
t = i $e- Al
— - 1 —
= | T ;
\". ‘ ."(
1 | {
|
NGS /'/'; &
ARP™ | &
% x
b= £2
=) ©
8 o
L 3
T 5
o &
T @
g 5
Lo
i J.
Jiaf ARP - Antenna reference Point
U+ e B4 SHMP - Slant Height Measurement Point
N e
2
/ot oo
/.0 £
Survey Point

Figure 176. Geometrical antenna parameters
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15. Surveying

The Survey tab includes the following object tree:

-
«F Justin - [1]

Project Map View Tools Application Help

) 9 v || ERES A G

Eln TRIUMPH-VS
E-g Map
=%, D:\GIS\Justin Link manual\2 Data_Files for Ju

B‘_)_] Work
g Site
EIW ReferencePoint
[H-5. 0 Layer

Net
& Layer
= Solution
|- Layer
EI‘&_ Vector

-4 3 Layer
m Dinamic Layers

@ Survey

a‘

) (1 | +

Adjustment | & ) Map | M Survey
i ] Source | {;} Process |

Figure 177. Survey tab
The main nodes are:

o I -Receiver
o 4. Work - Folder

The sub node is Map - M . It has the following sub nodes:
* Layers * with the following objects:
* point *,
* polyline m,
* parcel D,

Each item of the tree can be visible or hidden. To make the object visible or hide it, double click on the
appropriate icon.

If the icon is active (I:I e ), the layer is visible.
Otherwise icon is gray (=1 CRES ), the layer is hidden.
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All objects in the Survey tab have the same set of functions applicable to them (exception is Work, which
does not have item Properties). The object functions can be opened by right button clicking and selecting
from the list of items.

* Properties (unaccessible for = Work). Opens the Property window (see “Properties™).

o Style. Opens Layer style window (see “Vector Layer Style Settings” on page 36).

* Delete. Deletes selected object.

* Zoom. Shows all objects on the map.

* Google Speech. Recognition audio information with the Google Speech Recognition service (see
“Audio information recognition” on page 129).

* Associated. Denied update the field by Google Speech Recognition.

* Associate by. Indicates correspondence between items and Classifier (see “Classifier” on page
128).

» View table. Opens the TVS table (see “TVS Table” on page 134) for selected objects.
* Export. Opens Export window (see “Exporting data to exchange formats” on page 135).
* Base snap to. Snaps the base point coordinates to other coordinates (see “Properties™ ).

15.1. Properties

Depending on the object type the Property window’s view varies:

Receiver B - Dialog for metadata, Map - Dialog for operation in group with
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point snapping, offsets, antenna snapping, antenna properties, offsets

. — -
Oeopey . =
IRecmer Rover antenna
[Project Rover antena |
Receiver name  UDE_25753
Project name Map
Organization Unknawn
y
Operator Unknown
E=————

Snaped
Ce (o=

I Page  Rover antenna |

Page name  D:\GIS\Justin Link manual\2 Data_Files for Jusi

snaped
[@ easesnapo...| [ @swpt..

Tme | BOSW2 B 1m207

[ .

Layer . Group operation with a layer Object " or [} - Single operation with
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selected object

rﬂl‘rﬂpﬂh’ “1 rnw-mm-wu. “1
Layer FRover antenna |limud 'unu" Forent Brternd
Layer name  Ageishs, bt Pegarit nugemes L¥
(=] Pl
[ Arriutes
| LEEFLY)
Tt ITALIET e L b
(£ Base Snap to... £ Snap to...
£ kL |
o W |
[ oK [ Cancel ] L) [pcen {
B T —

In the edit fields of the Properties window you can change the data, click OK to accept and save the
changes, or Cancel to cancel editing

For points * there are additional tabs in the Property window: Master and Rover.

In the Master tab are displayed the coordinates of base point, according which Rover coordinates were
calculated.

The Rover tab displays the coordinates of the object. In both boxes next to the active window there are
strings with information about the item to which the object is snapped (otherwise [None] will be shown).

r &l i 1
B3 Pioperty - Donuarmiag Liyers - LiyedlZ - “ D Peoperty - Danamag Lirperd - Layer 12 “ O3 Propeerty - hnams: Layers - Layerll - ——
|G¢fmd Ao | Aover sl 'ﬁn—lel:.h: H.w-'r\-!lrnll hﬁmﬂ'i ﬂimm
Poctname L3 | w2z [mm oo | oo | il ramber
T ' Bt - y nglt ey sausmg Mesmred hcht B 20000
- | lenpaes WL wil® md| samwd : o -
: Sard (39F) il
g 10 seies Miabrid et ik e
- a.0500
At Td.i':-. Ve, m
: hor i, = 2. B30
BME, m o meiey i iz
Ty
Tea  IFALNL pEas el :
_II"_' a
[ ][ o o || oo J
e ! oy iy

The coordinates can be shown in geocentric, ellipsoidal, grid or local systems. To select a particular
system, select the appropriate tab. A check mark Associate indicates that this object will be used to re-call
the function Google Speech and Associate.

www.javad.com
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For the windows above, there is another category of tabs. Snap base to... and Snap to... Clicking on them
opens the window [None]:

O - [MNone) | o=h S | (o g [E=giey x|
PR orns conit coordrates 2 B, Set PostProcess Positon

L TS Base (326,13 m)
A VS Base (R25.61 m)
&, TVS Base (R2%.42 m)
4. TVS Base (8256 m)
TS Base (14636, 14m)
TS Base: (14 638,

TVS Base (1 723 173.85m)
m|fan o | e | oz |[an e | tocal
lasade  © ; s’ vz mesmosg| Lastude & wal' w2 swnengl
longide ®E 372" 313" aamessiz|’ Longiude ws]" 123" mosswzal”
W 5 3 -
Mot 75,7483 meters Heght 602951 meters
7 param - 7 param
Fres Snap to.., | cConen | Free Snap to.. Cancel

So there are some opportunities to set point position - get from receiver, snap to some objects, manual
input and postprocessing. You can modify alone point position with Snap fo. Base snap to.. Option affects
to all points referred to the base. Every survey point position are calculated in RTK or static
postprocessing relative some base coordinates.

To implement the inverse operation, click Free, base coordinate point or object will have the value that
they had before snapping. To cancel all changes and close the [None] window, click Cancel.

15.2. Classifier

Classifier is a customer structured table of predefined object styles. Object attributes are: scale, number,
code, description, symbol. To activate the classifiers table, click Classifier icon |— i

Classifier manager appears:

Classifier @

=-u * X
i

- _J Default

Figure 178. Classifier
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To add the row and new classifier, click g | to delete selected row, click u .
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Focus on one of the table fields and add appropriate information (scale, code, description). To input a
symbol double click to the appropriate field, select the picture file and click Open. The classifiers table

will be completed:

Figure 179. Classifiers table

-
1 Cpen @
Look in: J pngcollection - G b ] [ (4040
5
Recent Places
Destiop Barrel column conifer deciduous tree
u=a}!
Libraries
Computer
I ¥ t T
m metal pole shrub well wooden pole
MNetwork
File name: deciduous tree A
Files of type: P NG images {*png) v] I Cancel I
Classifier
=L Al ’
|| Default - %
2500 dedduous tree , -

u 2500 wooden pole T
N 2500 AppleTree ‘3";-
| 2500 metal pole I
| 2500 wel t

To recall the classifier click — i and Classifier window appears with all inserted information.

15.3. Audio information recognition

After having imported objects with audio data, this information could be recognizing using Google

Speech option.
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To put on the map an attributes data from Classifier, select the layer and call right button menu, then
select Style menu item:

=¥ UDE_25758 ~
- Aginsk |"|
""" L v Property

""" v sy |
""" .4 % Delete Del

..... e 3630 |~ Zoom
----- * 876 | # GoogleSpeech

----- « 9137 .
3
E—]--‘&, Boikov? Associated
£ 3 Layer 0 Associate by 4
""" L View Table
..... « 10 R
..... . 100 Export
----- s 101
Figure 180. Style

Focus on the values you wish to be shown on the map, e.g. Recognized audio, and click # . The
Recognized audio item appears on the right, and the special symbols on the map will have appropriate
label.

rl:l Layer style M“
Objects || Labels
sty |[Valoes Port

Available On map

Name Recognized audio
Height
X

Y

z

Time
Comment
Attributes

Solution

€1

Separator !

s [ ez

Figure 181. Layer style
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To recognize audio click with right button on the layer name and select Google Speech menu item. The
progress bar will show the status of recognition:

T

=0 UDE_25758 - |
B Agi I
EES =
..... Prope
_____ smp o 75%
e
..... Delete Del Recognition completed —
- Zoom
..... Google Speech Cance
""" Associated L
=g Bokov2
k_ Layer 0 Associate by L4
..... . 1 View Table
""" * 10 Export L4
----- s« 100 —
----- . 101

Figure 182. Google Speech

Classifier symbol will remove on the map last ones:

e

cgrofld SN | ws@Y "= -

e
Yeflow ﬁlw“hlml.sﬁg

Oom 1

fatitude: N 5574754, 4148 147 Longitude: E 37731'14.999 144" VGS B4 Actrve laver Al

Figure 183. Classifier symbols
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16. View

The list of View menu includes two permanent active items and some additional ones. Permanent items
are Project and Map. They hide/make visible main left/right program pane.

«F Justin - [1]
Project Map |View |[Tools Applicat
| -.| v Project

- Map
E|I:I :I'RIUMPH- Events
e Map

Edges
Receiver list
RTK++
Media
Vectors

Solutions

...... = VS
MNMEA
Figure 184. View
* Receiver list — opens the Receivers tab with the list of the receivers.

| Receiver | Murnber | Serial | Firmware wversion |Ru:uver|
BTR_VS 03VHZHKTAS5AV 2FE 25758 3.3.1b4 May, 06,2011 ¥

TRILUMPH1 WVVIWHQY SPK353V 3.2.5 Jan, 26,2011 -
M Receivers |

Figure 185. Receivers

The Receiver table shows type, serial number and firmware version of receivers. Here receiver
could be marked as a rover, to prevent Vector generation between rovers.

* Media — opens the Media tab, for the purpose of playing of audio information.

g

PHBKMMNAGAD

W Media

Figure 186. Media
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* Vectors — opens the tab with the vector information. The check mark Enable allows making the
selected vector visible or invisible on the map.

Kurking, | 259.501

Eiel || TmZR
4 Okiometer 2 4 3 g 10 12
| ]
Latitude: M 55°55'10.316300" Longitude: E 37%43'58.8993707 WGES 84 Active layer All
Enable Begin point End point Begin time Time span  |Epochs Length -
v Point_3 0
= Base Yellow Stone 90 16,02,2011 09:39:48,000 16.02,2011 10:21:42.000 / 00:41:54.0( 2515 56,468
W Base Point_1 16.02,2011 0%:43:47.000 16,02, 2011 10:22:13.000 f 00: 38: 32,00 2313 §3.505 £
W Kurkino Base 16.02.2011 09:13:00.000 16.02.2011 10:24:05.000 f 01:11:05.0( 4266 14644. 145
|7 Kurkino Point_3 16.02.2011 09:46: 16,000 16.02.2011 10:22:16.000/ 00: 36:00.0C 2161 14604.305
I Kurkino Yellow Stone 90 16.02.2011 09:39:48.000 16.02.2011 10:21:42,000 / 00:41:54.0C 2515 14590. 148
= Kurkino Point_1 16.02.2011 09:43:47,000 16.02,2011 10:22:19.000 / 00:38:32.0( 2313 14559,259
W Point_1 Point_3 16.02,2011 0%:46: 16,000 16,02, 2011 10:22:16.000 / 00: 36:00.00 21561 35.052 -
Fl 11 3
! »N Vectors '
Figure 187. Vectors

* TVS — opens TVS tab with the information about Survey tab’s objects (see detailed description in
“TVS Table” on page 134).

* NMEA — opens the NMEA tab, where can be displayed the graph for the data of the appropriate
dynamic layer. For the other layer type such graph are not available.

[Ellad

SGPGGA,073142.00,5547.9207795,N,03731. 2399721,E,
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*55
*5A
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Time
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Figure 188. NMEA

133



General Description
View

16.1. TVS Table

The TVS table contains the information about the Survey tab’s objects.

Map |Type |Object |Object data time |P0int name |P0int data time |Layer |Associahed |Recognized audio |C0mment|
TestMap 2 L T8 13.01,2012 14:29:57.000  Selection I
TestMap 2 L P2 13.01,2012 14:29:56.999  Selection I
R NS SSEESMRNN R YN 1 Ty e R T Y R, AN
TestMap 2 L P3 13.01,2012 14:29:57.999  Selection I
TestMap 2 L P4 13.01,2012 14:29:58.001  Selection I
TestMap 2 C-\' Parc4 .01.2012 14:29:59.9 13 13.01,2012 14:29:59.001  Selection I
: TestMap 2 OO Pppp2 .01.2012 14:29:59.0 7 13.01.2012 14:29:55.000 | Selection -
_| TestMap 2 C-" Pppp2 01,2012 14:29:59.0 Retegl 13.01,2012 14:29:59.000  Selection -
_| TestMap 2 C-\' Pppp2 01,2012 14:29:53.0 [ 13.01,2012 14:29:59.001  Selection I
_| TestMap 2 C-\' Parc4 .01.2012 14:29:59.9 15 13.01,2012 14:30:00.000  Selection I
_| TestMap 2 C-\' Parc4  .01.2012 14:29:59.9 15 13.01,2012 14:29:59.999  Selection I
_| TestMap 2 C-" Pppp3 01,2012 14:30:02.0 8 13.01,2012 14:30:00.000  Selection I
| 4
| % TS |
Attributes |50Iuﬁ0n |Sty|e |C00rdinahe system |JPS |Med|Picb.|res |snaped to |Laﬁb.|de,° Longitude,®  |Height, meters |Base Snaped to |Laﬁb_|de,°
_| Ismeretlen - 55.791699437 | 37.526455297 173.2286
| Ismeretlen i 55.791929146 37.526864663 172.8866
I en SR I S | R ST FE—— E—
| _| Ismeretlen » 55.791913629 | 37.526993964 172.9844
_| Ismeretlen - 55.791897964 | 37.527124984 173.1521
_| Ismeretlen * 55.791792017 | 37.526931674 174.6214
_| Ismeretlen * 55.791786140 | 37.526973393 173.9694
M Ismeretien - 55.791822652 |37.526942052 173.8159
_| Ismeretlen * 55.791791843 37.526927901 173.8973
_| Ismeretlen * 55.791819618 | 37.526998044 173.8791
_| Ismeretlen * 55.791824432 | 37.526945327 174.3863
_| Ismeretlen * 55.791781879 | 37.527008373 172.8300
4 J
Latitude,* |L0ngib.|de,° Height, meters |Base Snaped to |Laﬁb.|de,° |L0ngib.u:|e,D |Height, meters |Agency |Pr0ject |Creah0r |Receiver Receiver ID
_| 55.791699487 | 37.526455297 173.2286 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
55.791929146 | 37.526864663 172.8866 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
P 55791943226 [37.526740733 e B T AT T 5
_| 55.791913629 | 37.526993954 172.9844 Unknown Unknown Unknown | UDE_25758 HKTASSAV2FSLAZIW
_| 55.791897964 | 37.527124984 173.1521 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
55.791792017 | 37.526931674 174.6214 Unknown Unknown Unknown | UDE_25758 -HKTAS5AV2FSLAZIW
: 55.791786140 | 37.526978893 173.9694 Unknown Unknown Unknown | UDE_25758 HKTASSAVZFELAZOW
_| 55.791822652 | 37.526942052 173.8159 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
_| 55.791791843 | 37.526927901 173.8973 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
_| 55.791819618 | 37.526993044 173.8791 Unknown Unknown Unknown | UDE_25758 HKTASSAV2FSLAZIW
_| 55.791824482 | 37.526945327 174.3863 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2ZFSLAZIW
_| 55.791781879 | 37.527008373 172.8300 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
+

Figure 189. TVS

Double click on table item performs the following functions:

* Map — opens the window with map properties.

* Object and Object data time — opens the object properties window.

* Point name, Point data time, Comments, Attributes — opens the window

point.

* Layer — opens the layer properties.
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Associated — enables/disables Google Speech and Associated with functions.
* Recognized audio — starts Google Speech.

Style- opens layer style window.
* Sounds — opens the window with audio information.

Images — shows the images.
» Company, Project, Receiver, Receiver ID — opens project properties.
* Type — Opens the Info window, with the text information about object.

When you right-click on the cells JPS, Sounds and Images the standard Windows menu for the files will
appear.

To sort the table, click the right mouse button on the column header. To align the column width press and
hold Alt key and left-click on any location within the column. Use the Shift and Ctrl keys, to select
multiple rows in the table. The following menu will appear:

M Table view properties |

Filter L
Clear recognized text
Select by Base

Figure 190. Menu

Table view properties - opens the properties window.

Filter - enables filter to display/hide the following parameters:

* Receiver - hides all objects of receivers that do not belong to the receivers of selected objects.
* Map — hides all objects of maps that do not belong to the maps of selected objects.

* Layer — hides all objects of layers that do not belong to the layers of selected objects.

* Point — hides all objects that do not belong to the selected objects.

* Clear — clears the filter to display all objects of the Survey tab.

Clear recognized text - removes the recognized text for selected object(s).

Select by Base - selects all points belonging to the same base station.

17. Exporting data to exchange formats

Justin allows exporting project to many popular cartographic data to the exchange formats:

* ESRI Shape — ArcGIS

Maplnfo Tab — Maplnfo

MIF/MID — Maplnfo

DXF — AutoCad

Kml — Google Earth

PNEZD — text file, Point Number, North, East, Elevation, Description.
O-file — Ashtech O-file;
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» TVSfile- exchange format between devices and Justin;

* Tracy - Tracy format;

e TXT - text file configured according a template.

17.1. Export of standard

layers

Click Project » Export to..., and select the needed format:

«F Justin - [1]

Project | Map View Tools Application  Windows

|  Open

Close
Properties

Import files
Import folder

Import from project

T Import log
Export to... ESRI Shape
G Google Earth MapInfo TAB
Load 5P3 from net MIF/MID
B Edt Alt+X DAL
Krnl
L] DAGISWustin manualil.jpr PNEZD
do  DAGAGL-Ljpr O-file
Wi DAGAGLjpr T
Lo DNGA168_2014.04.13 a-ka jpr
Clear history

Help

Figure 191. Export of the standard layers
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17.2. Export of dynamic layers

To export a dynamic layer, select the layer in the Map tab, right-click and select Export menu item, and a
format the layer will be exported to:

[

«F Justin - [1]

Project Map View Tools Application Windows Help

----- ¥ Position .
..... |7 Site ]
..... |7 Stop

----- ¥ Reference
----- ¥ Recordset
..... |7 Geoid

----- ¥ Error ellipse 2 .
..... |7 Edge 15 13
----- ¥ Trajectory
----- V¥ Solution
..... |7 Vector

..... @ Addedt] & Sl
» Drop layer Del 3

~ Show entire layer 11

Hide all layers except...

Rename
Export Export to TVS file
Volume Export to Tracy
Move ESRI Shape
MapInfo TAB
MIF/MID
DXF
Kl
PMEZD
TXT

Figure 192. Export of dynamic layers
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17.3. Export of survey objects

To export survey points, switch to the Survey tab and rieht-click on the Device icon (EX), Map (k&),
Layer (), or Object (point-* , polyline - T, polygon - D), then click Export menu item and select the

format the points will be exported to:

o Justin - [1]

Project Map View Tools Application Windows Help

B W BER| At BR%

E-il,] Work
-4 Osechenki.kml
B4 2 Layer
e fiHod Dot
v|  Property
M style
N Delete Del
‘y Zoom
& Google Speech
Associated 4
Associate by 4 /
View Table
Export ESRI Shape
A Maplnfo TAB
MIF/MID
DXF
Krnl
PMNEZD
TXT
TVS file

Figure 193. Export of survey objects
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17.4. Export of map objects

tool (Select in region ‘a:% ), right-click to call menu, then click Export menu item and select the format
the points will be exportea to:

1 '] 3
15 13 .
Me Projects (8) ¥: Addto 4
3 TR % Delete
s Zoom
b, Y. Style
Property

& Google Speech
Associated L4

Associate by L4

View Table |
Export ESRI Shape
Make reference MapInfo TAB
MIF/MID
DXF
Krnl
PMNEZD
TXT
TVS file

Figure 194. Export of map objects

18. Background layers

Using background layers brings geography information to map window. We deal some vector maps:
world map (Countries), SPCS zone NAD 27/83 for USA, US Counties (County) and a map of Russian
Federation regions.
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=11 | Project - [ Vector
----- ¥ Pasition - [ —
..... ¥ Sie »N FRemove all Del
..... ¥ stop T Add layer
----- ¥ Reference
..... ¥ Recordset G/ Add Google layer
----- ¥ =eaid #. GNSS Stations g
----- [# Error ellipse - i
_____ W Edge Boundaries Countries
..... ¥ Trajectory *‘:‘_ Reference points Zoned7 (US)
----- ¥ Salukion Zonel3 (US)
----- v Weckor
_____ g et County (US)
..... Cnofn Regicns (RU)
_____ i 'm m

» Remowve all Drel

T Add layer

) Add Gaogle layer

T GMEE Stations 4

Boundaries r

-

Reference points

Figure 195. Added layers menu

To involve information window press and hold A/f button, activate t\,\<\, button then click on Map.

i LEANL

(& YORK

Countries
s
United States
Country: United States
Capital: washington DC
Population; 268224254

Continent: Morth America

Figure 196. Information window

Temporary layers are available during the work session. Its will disappeared automatically when project
is closed. Temporary layers are cartographic layers with the information imported from the following file
formats:
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* Tab files — *.tab.

GeoTIFF files — *.tif.
Shape files — *.shp.

Ozi files — *.map.
Maplinfo MIF files — *.mif.
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Note: File types *.bmp 32-bit and *.tiff with compression are not supported.

To add temporary layer to the project, click the button ".\h , or click Map » Add layer. Alternatively this
menu item can be right-click called in the Map tab. Take in account that all third party vector/raster maps
use independent datum lists which could differ from JAVAD company Geo database, so maps might be
shifted, scaled or rotated related to survey data.

«F Justin - [1] 2
«F Justin - [1]
Project | Ma View Tools Application
L E - L Project Map View Tools Applicatior
| e Zoomin - =
¢= Zoomout E ] -I \(_I | ii + QI 11 /}\
= _ =i S W
éjﬁ _ |:|---LJ Project
a &' Showentirenetwork | || i . ¥ Position
Set map position /size | || ¢ v site
& ST L TR | | I |7 Stop
& Distance | | [ Reference
Tbadiverl o ¥ Recordset
|\T3 iay ..... |7 Geoid
Default layersstyle | || | [¥ Error ellipse
| ¥ Edage
----- ¥ Trajectory
----- V¥ Solution
..... W Vector
..... ] di -
'3 Removeall Del
[©_ Addinge
G Add Google layer
¥ GNSS Stations L4
L. Reference points
Figure 197. Add layer
Select the type and file. Click OK.
r |
7 Open ﬁ
Look in: . Raster Map - G ? -} '

=
el
Recent Places

Desktop
Libraries

1Ay
5|

Computer

@

MNetwork

Tilebet_2_7.qgif Tilebet_2_8.qgif Tilebet_3_1.qgif Tilebet_3_2.qgif

File name: - Qpen

Files of type: [GIF images (*.gif) v] [ Cancel ]
Bitmap images (*bmp)
JPEG images (" jpg. "jpeg)
PNG images (*png)

TIFF images (i

W Georeferencing

Figure 198. Open file
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In the Map tab will appear an identifier of new layer in the Added layers part. A new layer will be added
to the cartographic window. To display the full layer right click and select Show entire layer.

r

F Justin - [1]

Project  Map

View Tools Application

DM EBE@ ActOB| RN

(-] Project

..... W site

.

----- ¥ Paosition

..... |7 Stop

----- ¥ Reference
----- ¥ Recordset
..... |7 Geoid

----- ¥ Error ellipse
..... |7 Edge

----- ¥ Trajectory
----- ¥ Solution

..... |7 Vector
243 Added Layers

== o

N Drop layer

Windows  Help

Del

~ Show entire layer

Hide all layers except...

Georeferencing

i ] Source

Adjustment ) Map | W Survey

o
I iz# Process

A A Is

Latitude: M 40°48'55.111432"

Figure 199. Show entire layer

Menu items for the added layers:

* Style - opens raster style window:

7 Raster style

’5 2= O |

Transparency 0 %

4 | 3

|:| Use transparent color

(@) None
Red
Green
Blue

b,

. 0m 20 40 6O 80 1001207140160
[ e e e e P |

* Show entire image.
* Change scale.
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Figure 200. Raster style

On the main panel of Raster style window there are the following tools:
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* Move the map.

Using Use transparent color the transparency of the image can be set. For monochrome images
background color intention can be changed (red, green blue).

* Delete layer - deletes the layer from the project.

* Show entire layer - the entire layer will be shown.

* Hide all layers except... - Hides all layers in the Map tab excepting the selected.

* Georeferencing - allows showing and editing georeferencing coordinates and save all changes.

19. Raster georeferencing

Raster georeferencing is the process of scaling, rotating and positioning the image to match a particular
size and geodetic location.To register a raster image, perform the following steps:

1. Click Tools » Register raster image. The Open dialog window appears.

2. Select the format of raster image file in the Files of type drop-down list.

Note: Justin can open the following types of files: BMP, JPG, JPEG, PNG, GIF, TIFF, *.bmp 32-bit, and * tiff with

compression formats are not supported.

Select the desired file and click Open. Raster image immediately appears on the map window. By

default it will covers about 75% of map window. So you will make a registration process faster if a
map window have been centered on right position previously.

. F Justin - [1]

7 Open Iﬁ
Project Map View |[Tools | Application Windows —
\ . i |... Register raster image | Lookn: J Raster Map - 0 [Eihd
) [ || ER ,
Datumn calculator 2 5
Project g che
[V Pasition Localzation Recent Places
Bestiap TileSet 2.7.gif  TileSet 2 8.gif  TileSet 3_L.gif  TileSet_3_2.gif
Libraries
Computer
“w
MNetwork
Files of type: [GIFimages (".gif) v] [ Cancel ]
Bitmap images (*bmp)
JPEG images (" jpg. "jpeg)
PNG images (" png)
TIFF images (*tif
alF images (g
W Georeferencing |

Figure 201. Register raster image
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F Justin- [1]
Broject Map Yiew Iools Application Windows Help

Project
F Peston
 sie

F stoo

7 Refererce

| Hame |Lattude,* |Longtude, *

Jv| 2 A0B WNRRI[E,@® O

Labitude: N 40°4F'12. 1911647 Longitude: W 109°5554.293882° | WGS

T N o R i e & R~ s

¥, poes ¥, plcels Jeror

Om 200 400 600 E00 1000 120014001600 1800
e e e

84 Active layer e

o

Adpstment | ) Map | e Survey. 2,
L source £ Frocess N Georeferencrg

Figure 202. Raster image registration panel

3. Enter coordinates of the points in pixels or in geodetic coordinate system in a registration form.

4. Select the coordinate system available in the project.

The point coordinates can be entered in three ways.

First way

Zoom in the map area with the known position shape. Click El on the coordinate panel (on the left).
The cursor will transform to cross-hair. Point on the position and double click.

The pointed position will be marked, and in the table new row appears. Coordinates are in screen pixels
and in selected coordinate system. These coordinates could be corrected later.

Such way allows the user not inserting complete values, but editing only the last digits of the input. To

finish point coordinates entering, right-click or click on the

T

button.

To edit the table highlight the needed row. On the right will be the parameters displayed. Change them

using the following:

* Click Map pixels E, or Map Coord [E, select the button on the map and edit the coordinates.
 Alternatively, the coordinates can be changed manually in the corresponding fields. After editing,

click | J , to refresh the image.

The button »~ allows you to zoom the image corresponding to the selected position. In the Scale

window select the zoom.

To save the image to *.7ab or *.0zi files, click rj .
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& ; with the button ‘ J | the table can be

To delete the selected in the table point, use the button
updated to display the calculated errors:

Okilorneter 1 2 3 4 5 [
| x=947 ¥ =-510 [ ]
Latitude: 5 83°37'50.398297" Longitude: E 166°24'07,029017" | | WG5S 84 Active layer All
% M -0
Points Map pixels
Point Latitude Longitude Pixels X Pixels ¥ Error Py b s L 08| ¥ 369
i Point 1 55°08'00.000000 W 84°51'00.000000" 98 369| 8148 Map Coord
_Point 2 S 55%31'00.000000" W 144°29'00.000000 3948 412 4354 BLH Grid
_ Point 3 5 71%30'00.000000" W 46°57'00.000000" 357 2844 3154 E .
Point4 |5 71°22'00.000000" W 175°25'00.000000" 4135 2873 0 : Latitude = : 55 & ' 0.0000
— )
itude & E 84 ° 51’ o.0000
Longitude oW .
WGES 84 =
4 k

. Georeferencing

Figure 203. Table with the points’ coordinates

Second way (optimal in combination with vector maps)

Switch to snapping mode with . While a point on an active vector layer is in a snapping range of
cursor a distance between the point and cursor is shown like a red line.

Figure 204. Red line hetween cursor and point
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Point with a cursor to some place on the raster image. The object on the active layer and pointed place
will be connected with the blue line. New row with the cursor position coordinates in pixels appears in a
registration table.

Figure 205. Blue line hetween cursor and point

Repeat the steps above with all needed points. The map on the screen will be displayed with the light blue
lines, which fit on image to vector objects. The point coordinates can be edited if needed.

Figure 206. Snapping to vector map
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To define snap object ranges, select Options » Application, then in the Options window checkbox set

Snap objects range in pixels:

(] Opﬂons]

[S5)

‘Common Import| Coordinate sysh&m| Geoid | Units | Report| Anhennas|

Language |English (United States) -

[¥] Open last project
|| Apply last coordinate systems

|| Compact project database on exit

["|Dedmal degrees in coordinates forms

[¥]show scale bar

Longitude range @ -180/180 T 0/360
["|Button panel in ohject tree
‘E.Iligiescale plal .4
[]5nap objects range PIES pi,ﬂ
-
[ OK l | Cancel ‘

Compact S

Figure 207. Snap objects range

One can easily create new vector layer for georeferencing. If the layer with the points for snapping was
not created, it can be created manually:

Click the button

and select the needed points with the left click. Their coordinates will be added to

the Coordinates clipboard. Later these coordinates can be edited in the table:

Coordinates clipboard

fesl

xH

Height: 0.0000
Height: 0.0000
Height: 0.0000
Height: 0.0000
Height: 0.0000

1. Morthing: -10079347.9093 E asting: 535264.4610,
3 Morthing: -10043877.0188 E asting: 519365.2545,
5 Morthing: -10039529.8400 E asting: 519460.2582,
¥ Morthing: -10037565. 2889 E asting: 5176326470,
9 Morthing: -10038701.3950 E asting: 5188584.1210,

Figure 208. Coordinates cliphoard
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To save the points’ coordinates in a new layer, click - :

=l | Project
----- ¥ Paosition
..... |7 Site
..... |7 Stop
----- ¥ Reference
----- ¥ Recordset
..... |7 Genid
----- ¥ Errcr ellipse
..... |7 Edge
----- V¥ Trajectary
----- ¥ sSalution
----- V¥ Wector
----- e Layerd
..... CHDHD
..... )
N Remove all Cel
o Add layer
G Add Google layer
¥ GMSS Stations L4
Boundaries L4
L, Reference points
Figure 209. New Layer 0

As much layers can be added as needed. All layers elements can be visible, but in the calculations can be
used only the elements of one layer (Active) or all elements of all layers (Select all layers).

To hide the layer, double click on the layer name, to make it visible, double click again.

With the button h the window Coordinates clipboard can be cleared from the inserted coordinates,
and the points selected on the screen will be removed.

To save the coordinate input, click ﬂ , the coordinates will be saved in *.tab file. Enter the file name

and click Save:

[0 Save As

Save in:

<5

Recent Places

Desktop

Libraries

L ¥

Computer

@

Network

Map - @ % il i g
_ Type: TAB File e
100k--p50 Size: 338 bytes n51-06.TAB
| Date modified: 2012-01-18 11:43
File name: 100k-p50-109_110 -
Saveastype: | Tabfies tab) - [ cancel |

Figure 210. Save As window

The window Select a coordinate system appears. Select the coordinate system and click OK. If the Add
Coordinate System Info option is not active, the coordinates system information won’t added to the file
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and Justin Link will ask about coordinate system next time. If this option was activated, the information
about coordinate system will be added to the TAB file.

[ Select a coordinate system =y X

XYZ BLH W

WGS 84/ UTM zona 1M

add Coordinate System Info [ oK l [ Cancel ]

Figure 211. Select a coordinate system

Third way (fastest)

Zoom in the selected area of the map and point with the cursor the point with known coordinates,
checking them in the status bar on the bottom of the window:

04 027 o~ |

|.x=661

=y o e o [
<INmth 61987 East 73997 > | Sﬁ-ﬂsz_a_lTISS_:KI_'I_..IQ_E_I_'_ZE_)I'

Figure 212. Selecting the point

When the cursor coordinates is close to known values (refer to status bar), right-click and move the cursor
to the corresponding place on the image (blue line between points appears), right-click again. New row

appears in the table. Edit this row if needed. Add more control points. The snapping will be shown by
light blue lines.
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20. Continuously Operating GNSS Stations

The National Geodetic Survey (NGS), an office of NOAA's National Ocean Service, manages a network
of Continuously Operating Reference Stations (CORS) that provide Global Navigation Satellite System
(GNSS) data consisting of carrier phase and code range measurements in support of three dimensional
positioning, meteorology, space weather, and geophysical applications thru out the United States, its
territories, and a few foreign countries. GNSS station option automatically updates and displays on the

map the list of available CORS and SOPAC stations.

Information about stations is available on the Map tab » Added layers » GNSS Stations.

«F Justin - [1]

Project  Map

View Tools Application

Windows  Help

v BRERASCR

=1y | Project
----- ¥ Position

b 3

.

G

Remove all

Add layer

Add Google layer

Del

|\-|-.

GINSS Stations

& CORS

e

Reference points

® SOPAC :

Figure 213. GNSS Stations
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CORS and SOPAC layers can be displayed in the cartographic window at the same time.

F bl
7 Justin - [1] [E=NEEES
Project Map View Tools Application Windows Help

Y ) o, A\ - e 5 :
| 9 @ || B vz @F G LIRS N R|| 2 2= ¢ sz
(-] Project
----- [+ Position & P0G
----- ¥ site & onrve;
..... V¥ Stop s ’ PO95
..... ¥ Reference O cHOT; & p14g & 521;15\_
..... Il; EEC.DJdSEt & P14 E—Ngli]ms‘g‘ﬂxﬁ » COFL
..... &0 e
----- ¥ Error ellipse & p127 e
..... ¥ Edge <> P146; <> LOLE 7
----- ¥ Trajectory 3
----- ¥ Solution (& p150; SUD,
..... |7 Vector
243 Added Layers
[/ GNSS Stations(CORS) & DOTL
W GMNSS Stations(SOPAC) & p141 & p1a2
(> LNE2:
& p14g
& SACR: & p310
""" P276 i ;
& p276 & p143 & 136
T3
& 274 & 215
& 273
o3 0 kilormeter 20 40 1] 80
Adjustment | () Map | ke Survey i) I ;
i 1 Source | £ Process Latitude: N 38°35'51.721905" Longitude: W 118°39'13.271921" | | WGS 84 Active layer Al

Figure 214. CORS and SOPAC layers

The same station of the CORS or SOPAC network can have multiple identifiers belonging to different
realizations of the network. To access the data, select the desired ID on the map and click the right mouse
button to call a drop-down menu:

* Load - load RINEX files. Specify the needed date.

o & MOMX: > mucD,
& rETm M MOID: > T
& KaNl v |(> MOBP A mora” MOCO .
[ ka2 [ Lead [ ByDate [  Customdate.. |t-‘_?<—
& Kani  » Information 4 & MOIC ' 4 qq-_‘—;p
& Kanz » Make reference point ~ * ke & M‘QD% MOSC &m
e ELL [
e & moBT ® Moww & move & Mo

Figure 215. File load

When the download is complete, a new reference point with coordinates in the ITRF2008 and the
date corresponding to the epoch specified for the current project in the Internet tab is completed.
If the epoch of the project is not selected, the coordinates of the reference point are calculated at
the date of measurement.
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To download to the project the data from several stations, use Select a rectangular area item on

the toolbar:
O MOUR] W msus o emes (b MUSH) 0 munL v o
& LTHM
& NE o & MoBG
LMORM| & MoMX: {» MOEB,
& LR MOD - M BADED, .
[ coRs stations(18) [ Lload [ ByDate [ cCustom date.. ||
@ SOPAC stations(3)  *| Make fiducial points ~ » MOMK L d ?g%%mfi: wnsSTg
L g Ll > MODR} pete SOCB,
TP MOsC ;
& MuEL & MOEL 0 M%FE_\& MW
b SG15; & QOuET LMOWW, & MOVE MOFE
» e & mocn, {» MOST {» MOSG;
B E F N TF Yo

Figure 216. Request parameters

* Information - information about the point.

i . A MOID fE S
(> KANL ¥ | MOBP Amopg” M2CO
bt _MOS
& Kanz Load y & MOWRd MOSR o)
i ity
& Kanl 4 | Information Coordinates 00 (relative calibration)
& Kan2 L4 Make reference point L4 Coordinates 08 (absolute calibration)
sk & MOBT <'>' MOV, Data Sheet (ARP only)
S N Data Sheets
%Mh?glc;l Site Log
3 MOLN
{> MONE Photographs
GMOBY  paty pvailability
[ k ]
d - 1 Tirne Series (60-day)
DSk & mock & M¢ . .
HDS1 { MOSE Time Series (longterm)
& moca. & Google Map
itude: N 39°07'29.479116" Lonaitude: W 95°24'25, 5 Iowsr T AT

Figure 217. Information

* Make reference point - create a reference point with coordinates in ITRF2008 system:

& x| Omose 0 Mosc

& KAN2 KELygcp & mows

& KANL v {» MOSD,

& KAN2 | Load 4

I Information 4 &1
| Make reference point | 1GS08 ||

Figure 218. Make reference point

152



General Description
Continuously Operating GNSS Stations

Date associated with reference point coordinates, can be seen in the Reference Properties window. If the
epoch of the project is not specified and there are no any recordset in the project, the coordinates shown in
the Reference field will correspond to catalog epoch, and in the Calculation tield will be zero.

«F Reference properties &J
Point name m

wz [ Grid | Lol |

Latitude N 39°07'33.134608"

Longitude W 95°24'05,385999"

Height 291,9570 meters
[WGS 34 (Reference) -
Speed Epoch
Northing -0.0015 mjyear Reference
2005.0000
Easting 0.0131  mjyear
Calculation
Height  -0.0023 mjyear 2014.3301
Parameters  Properties
’ oK ] ’ Cancel ]

Figure 219. Reference properties
Load Internet data using the menu option Load Internet data. The GNSS station layers should be opened.

-
o Justin - [1]

Project Map View Tools Application Windows Help

bo[B 23| Ae o8ISR

El- {14 Project
----- [+ Position A
..... ¥ site \ Properties
..... V¥ Stop
R
----- ¥ Reference £aame
B "~ D
..... ¥ Error ellipse -+ Zoomto..
..... ¥ Edge L Make reference
----- [V Trajectory
..... ¥ Solution % Report L
..... V¥ Vector - ; -
..... ) Added Layers A Point_3 % Properties
| % Delete
Export to JPS
Export to RINEX
~ Zoomto..
Lo Table view
T Showtrack
Sort By L4
-f;;’; Calculate coordinates
Process recordset
Raw Data Chart
. Sky plot
3D view
T Report L4
| Load internet data

Figure 220. Load INTERNET data
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In this case, the optimal accordingly geometry factor, set of three CORS points. For geodetic networks
which use CORS as reference points, a special report close similar to the standard Internet post-

processing service OPUS (NGS, USA) is designed.

-

«F Justin - [1]

Project Map View Tools Application  Windows Help

21. Report

@ | BEE) AetcB|NRS

-] Network

=i Sites
R b it
{9 Reference \ Properties
a Edges Rename

-4 Blunder

..... [ ] Positions T Report Standard
—“"_ NGS OPUS
Figure 221. Report

There are two types of format for reports in Justin. Click Options » Application » Report and select the

format. It can be *.txt or * html.

To generate a report, click =  button on the tool bar and the Report window appears:

' N
7 Report [E=NEER

Source  Coordinate system | Time

Navigaﬁon| Network| Static Hnemaﬁc| Stops | Adjusted kinemah'c| Posih’ons| Gis |

E_,_] Available al | e L] Report
= 16.02.2011 i

-4 Base [ Site: Base

Bl # Paint_1 / Site: Point_1

A Solution 1

# Point_3 / Site: Point_3

A Solution 1

- Yellow Stone 90 / Site: Yellow 5t =
L A Solution 1

-4 Point_1 / Site: Point_1

- Point_3 / Site: Point_3

A Solution 1

Yellow Stone 90 / Site: Yellow St

i Solution 1 |

-4 Yellow Stone 90 / Site: Yellow Stone
(- Paint_3 / Site: Point_3 -

1 [ | +

4%

Titl
Aldt: Image Map ’ Go ] [ Close l

Figure 222. Report window

* Source tab: On the left there is the tree with items of the project. On the right there is the Report

folder and mix set of the selected items.
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At the beginning, the Report window is empty. Select an object on the right and click | ap . This
item will appear on the right. '

To delete the items from the report pane, select them and click 4 .

To set the table parameters click | % ‘ and the Table parameters window appears.

* In the Coordinate system tab the coordinate system for report is defined:

r B
7 Report [E=NEER

Source || Coordinate system  Time
wz [ Grid | Local |

SK 42 ﬁASSi

Title ’
Add Image Map

Figure 223. Coordinate system tah

* In the 7ime tab the time system can be set.

[ ™y
7 Report [E=NEER
Source | Coordinate system | Time

() GPS time (datetime)
() GPS time

() GPS time (sec)

(@) UTC time

() Local time

Title ’
Add Image Map

Figure 224. Time tah

In the lower left corner of the Report window there is 7itle check mark. This means that the log file will
have a JAVAD logo and title with the general information. If enabled, the file will be created without title.
If the *.html format mode is active, the Add map image flag will be available and the map image will be
added to the report.
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When report design is completed, click Go button and the report will be generated in hfml/ or txt format:

Project: 1

Program: Justin Coordinate system: SK-42 / Gauss-Kruger zone 7 - 36-42° E
Version:  Internal Units: meters

J Creator: - Height type: Ellipsoidal
Agency: - Time UTC time

JAVA“ Project: 2]

Processed: 16.05.2014 14:55:16

Network
Adjustment method: Least squares method
Blunders: Automatic rejection
Constraints: Fixed constraint
Mode: XYZ
Chi2: 95%
Confidence level for blunders: 95%
Sites
: : : RMSN, [ RMSE, | RMS U, | Cor. || Cor. || Cor.

Site Northing, m Easting, m || Height, m - . 3 EN EU MU Comment Status

Base (61864617524 7407682 0344 | 1614837 |0.00000(0 00000 000000|| - e b o | cicrence (Bl
and Height)

Kurkino | 6198784 5754 || 7399767 6542 || 245.5930 | 0.00358 | 0.00120 || 0.00485 | -51.69| 35.35 | -46.37 - Adjustment
Point_1(6186506.2947 || 74076104947 || 159.0209 | 0.00108 | 0.00037 || 0.00165 | -57 .68 | 39.28 | -53.30 - Adjustment
Point_3 |6186476.1859 || 7407629 5865 || 159.1670 || 0.00110 | 0.00036 || 0.00164 | -58.25| 39.45 | -52.20 # Adjustment
Yellow

Stone |6186499.0798 || 7407639.1153(1159.4219 | 0.00107 | 0.00038 || 0.00166 | -51.58 | 41.83 | -54.44 % Adjustment
90

Figure 225. Report in html format
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File Edit Format View Help
Program: Justin
version: Internal
Creator:
Agency:
Project: 1
Processed: 16.05.2014 14:57:44
Coordinate system: SK-42 / Gauss-Kruger zone 7 - 36-42° E
units: meters
Height type: ETllipsoidal
Time UTC time
Adjustment method: Least sguares method
Blunders: Automatic rejection
Constraints: Fixed constraint
Mode: XYZ
chi2: 95%
confidence level for blunders: 95%
Sites
site | MNorthing, m | Easting, m | Height, m | RM5 N, m |
Base | 6186461.7524 | 7407682.0344 | 161.4837 | 0.00000 |
Kurkino | 6198784.5754 | 7399767.6542 | 245.5930 | 0.00358 |
Point_1 | 6186506.2947 | 7407610.4947 | 159.0209 | 0.00109 |
Point_3 | 6186476.1859 | 7407629.5865 | 159.1670 | 0.00110 |
yellow Stone 90 | 6186499.0798 | 7407639.1153 | 159.4219 | 0.00107 |
4 T

Figure 226. Report in ixt format

22. Mission planning

Mission planning is intended to determine visibility for GPS, GLONASS, BeiDou, Galileo, QZSS
satellite constellation and to define better conditions for observations.

Mission planning integrates with Justin, that allows you to access Mission planning from the Justin main

menu, the Tools option, if a project is open.

22.1. Starting Mission planning

To start, click Tools » Mission planning:

«F Justin - [1]

Project  Map

=] 16.02,2011

4y Base
- Kurkino
-4 Point_1

W |

View |[Tools | Application

Help

Register raster image

P

Datumn calculator

Localization

Data analyzer

-4 Point_3
g Yellow Stor

Mission planning

Figure 227. Tools » Mission planning

157



General Description
Mission planning

22.2. Toolhar

The toolbar provides access to Mission planning options:

. E'i | -Input file with almanacs — Opens the Almanac input dialog window to select an almanac
and load it

. @ - Opens the Point list dialog window to add a point to the point list;

=

. - Opens the graphic window and allows inserting obstructions;

. é - Opens/Closes the sky plot to display satellites’ paths tracks;

M, g

7 Mission planning

(L e T|@ & m u

Pont [log0920e -

Begin tme [i.03.2011 = 00:00:00  [2

Endtme  31.08.2011 2 00:00:00 1

0 2 4 & 8 10 D 14 16 18 20 2 A

Cutoff angle 1512 J Refresh

Age (days)
es [
GPS

192 @3 @4 @5 @5 @7 @l
Wi W @l lZgideidgal
WIS 6@ 174 10 194 0@ 2!

W22 3@ig it 272 — d .-. l.lf ““. ) ‘\

L T IR I T

6w \i.

B
GLOMASS ‘Ei ““ N

did \
N ', | “\
$2220200: tay g RSy
[ | ["o0:00:00 f

DG0RAERARRGRAIRARRA0EEE

g

Azimuth: 118°  Elevation: -12°

Figure 228. Orbits
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- Displays/Hides the almanac for the selected satellite.;

Almanac

GPS GLOMASS
SVPRN
| Date/Time |
Reference week 1 599

|Health summary

Reference time of week | 503808

Satelite health i 0

| Satellite configuration 9
Clock data

afl 0.000E+0

afd 3.204E-4

2
18.02.2011

Keplerian orbital parameters

rootA‘ 5.154E+3
ece [ 1.001E-2
'm0 [ 4,859E-1
| omegal 2.765E-1
argPer | -3,801E-1

Corrections to orbital parameters
deli -1.009E-3
| -2.568E-9

Figure 229. Almanac

Number of satelites in view {Cut off angl =15)

-+ GPS
—+ GLOMASS
-+ Al

T T T T T T T
00:00 02:00 0400 06:00 08:00 10:00 12:00

T T T T T T
1400 16:00 18:00 20:00 22:00 00:00

UTC time
Elevation
0T . GP52
80 + GPS3
+ GPS 4
A GPS §
&0 + GPS 6
GPS 7
50 . GPS 8B
40 4 + GPS9
} .+ GPS 10
30 ¢ + GP5 11
+ GP5 12
o GPS 13
o0+ + GPS 14
: : : : + GPS 15
0% T " " T f $ + T T " T f
00:00 02:00 0400 06:00 08:00 10:00 12:00 14:00 16:00 18:00 20:00 22:00 00:00
UTC time
() Azimuth @) Elevation () DoP

- Prints satellites visibility, azimuth,

Figure 230. Satellites in view graph

elevation and DOPs graphs;

General Description
Mission planning

ﬂy_,\ | - Displays/Hides satellites visibility, azimuth, elevation and DOPs graphs:
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« LB saves the graphs as images.

i 7 Mission planning
eF@ & | mpull

Point Hase - |

Begin time  09.06.2014 5 00:00:00 i~

End time  10.06.2014 = 00:00:00 -

0 2 4 6 8 10 12 14 16 18 20 22 M

Cut off angle 155 \J Refresh
Age (days)

s I

clonass NN

GPS -
1 @2 @3 9! @5 @t @’ @il

W WY w1l l2gidgiigal

WS It 174 154194 204 21 =

W22 W24 5w 6 2T 28 1

W20 33233 34 135 ‘

k7

GLOMASS

v @ 3 4 @5 @5 @7 @l

(Rl R AT RRE Rl R ARY A =

Figure 231. Mission planning

22.3. Loading an Almanac

Click £& on the toolbar, it opens the Almanac input dialog window:
f «F Almanac input u

@ IPS file (GPS+GLONASS)

() Yuma (GPS)
() Sem (GPS)

() Almanac_GLO (GLOMNASS)

o ][ e ]

e

Figure 232. Selecting file type
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Click one of the radio buttons, to open the Select file with almanac dialog window and select file
containing the almanac. Click OK:

' Bl
< Select file with almanacs [
Lookin: || Net-1 - &1 mE
I= Narme : Date modified Type
el (& Basejps 16.02.2011 13:54 JAVAD da
Recent Places @ ¢\ kino jps 160220111354 JAVAD da
! & Point_1_jps 16.02.2011 13:55 JAVAD da
& Point_2.,jps 16.02.2011 13:53 JAVAD da
Desktop & Paint_3_jps 16.02.2011 13:51 JAVAD da
=
Libraries
[
LY
Computer
“
L 4| 1 3
MNetwork
Flesoftype:  [JPSfiles (s) ] [ Conedt |
Figure 233. Select file
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22.4. Point selection

To select a point, click | & . The Point List window will appear.

If the mission planning was started and a project was opened you can select any point of the project.

" Point List

EEQ Points -] Points Pointname  istra
=-f5 Reference paints e istra
K I BLH Grid |

Height 2023512

Latitude N 56°0723.842739"
longitude  E 36°49'37.332882°

meters

[Russia Pz90(Pz30)

i Latitude: 5 24°30'07.855102" | Longitude: W 153°20'00. 151354

Figure 234. Point List

Select the point from the left pane of Point List window and click | ¥

. Point name appears on the right

pane and its coordinates will be available for the selection in the Point list. Alternatively the point name
can be entered manually. Click OK, to save entered points and close the dialog window
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22.5. Inserting obstructions

You can draw, edit, and delete obstructions for the selected point. Locate the mouse pointer over the
beginning point of the obstruction and click the left mouse button, it starts the obstruction and enables the
buttons on the right of the plot:

Complete obstruction

Delete last line

Delete last obstruction

Figure 235. Obstructions

22.6. Settings

To select the point, use the drop-down list box:

Begin time  Kurkino - |—

Figure 236. Point selection

The planning time interval can be set using the time scale.

Begin time 09.06,2014 = 00:00:00

L
=1
Endtme  10.06.2014 /5] 00:00:00 |3

0 2 4 6 8 10 12 14 16 18 20 22 M

Figure 237. Time scale
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The satellites can be selected using a menu.

Cut off angle 15 \ Refresh
Age (days)

GPS =

GLOMASS 3

GPS -

W 9.9 @@ @t e’ @l

Wt @9 @IlgilglZgilglig:al

W15 1t 7@ 10 19¢e 204w 21

L el ™ el ™ it e ¢ el el ]

W29 303233 340 135
36(_)37

GLOMNASS

W 99w es @t @’ @l

W WY Wil iei2eiseiigal

m

Figure 238. Satellites selection

The almanac age is displayed in the Age (days) field. Almanac becomes obsolete within 30 days from the
date of issue. If almanac is old, these fields have a red background.

22.7. Animation

To animate satellites movements on the Sky plot, use the buttons of the Playback group and the Current
time track bar.

Figure 239. Animation
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